

    
      
          
            
  
Particl Academy

Documentation for Particl Marketplace.

Particl Academy is the ultimate user guide to become a Particl expert. Particl is a user-friendly and developer-friendly ecosystem of privacy-first decentralized applications building against the centralization of power and services on the web.

By learning how to use its apps and components with the Particl Academy, you can finally cut off the middleman from your life and enjoy complete digital sovereignty.




Introduction

Learn more about Particl and its ecosystem of privacy-first decentralized applications.





	What is Particl








Particl Blockchain

Learn more about Particl Blockchain and its native cryptocurrency and privacy coin PART.





	Blockchain Overview (PART)


	Staking Explained


	Privacy Specifications


	Community Governance


	DAO Treasury








PART Guides

Follow step-by-step user guides on how to use Particl Blockchain and its privacy coin PART.





	Particl Desktop


	Send, Receive, and Convert


	Staking Guide


	Voting Guide


	Buy and Sell PART








Marketplace dApp

Learn more about Particl Marketplace, the privacy-first online marketplace without middlemen, restrictions, or fees.





	The Marketplace Explained


	Two-Party Escrow


	Content Moderation


	Markets and Storefronts


	Privacy Specifications








Marketplace Guides

Follow step-by-step user guides on how to use Particl Marketplace and become an expert in disintermediated and confidential e-commerce.





	Get Started


	How to Sell


	How to Buy


	Create and Join Markets








BasicSwap DEX

Learn more about BasicSwap DEX, the privacy-first and decentralized trading exchange (DEX) that’s all about freedom.





	BasicSwap Explained


	Under the Hood


	DEX Comparison








BasicSwap Guides

Follow step-by-step user guides on how to use BasicSwap DEX and become an expert in disintermediated and anonymous digital asset trading.





	Get Started


	Get Started


	Add or Remove Coins


	Add or Remove Coins


	Connect to Tor


	How to Trade


	How to Trade


	Automated Market Making Script


	Apply for Listing








Help and Assistance

Are you having an issue not covered in this section? Your invaluable insights will make the Particl Academy more complete.





	Frequently Asked Questions


	Common Issues


	Get Support


	Glossary








Technical Documentation

More technical documentation can be found at these locations.


	Particl’s Whitepaper [https://soontm.io]


	Particl’s Wiki [https://particl.wiki/]


	Particl’s GitHub [https://github.com/particl]








Resources and Links


	Download Particl Software [https://particl.io/downloads]


	Website [https://particl.io]


	News Blog [https://particl.news]


	Complete list of useful links





Note

This documentation is up-to-date with Particl’s latest version, Particl Desktop 3.3.1. Please keep in mind this software is still in BETA, and as such, lots of features and improvements are regularly added.







            

          

      

      

    

 


  

    
      
          
            
  
What is Particl?

Particl is a user-friendly and developer-friendly ecosystem of privacy-first decentralized applications building against the centralization of power and services on the web.

United under the mission of shifting the balance of power from corporate monopolies back to the people, Particl contributors built a privacy-first and modular ecosystem of decentralized applications complemented by a native privacy coin to send and receive untraceable currency payments within smart contracts.

These dApps — alternative versions of some of the online services and products we use every day — are designed to operate in complete and total privacy and without intermediaries or restrictions.

Particl Academy provides documentation on some of the Particl ecosystem’s key components, its privacy-centric cryptocurrency PART, and the various dApps currently in development or production.




See also


	Particl Explained - Blockchain and PART Explained


	Marketplace Explained - Particl Marketplace Explained


	BasicSwap Explained - BasicSwap DEX Explained









            

          

      

      

    

 


  

    
      
          
            
  
Blockchain Overview (PART)

PART is the native privacy coin of the Particl ecosystem. It runs on the proof-of-stake Particl Blockchain and enables anonymous payments anywhere in the world without financial borders.




Table of Contents


	What is PART?


	Blockchain Specifications


	Particl’s Bitcoin Origins








What is PART?

PART is a Proof-of-Stake privacy coin based on the most recent Bitcoin code (currently Bitcoin 25.0) and enhanced with several privacy-preserving protocols. It enables users to make fast, secure, borderless, and private payments without requiring any third-party like banks or payment processors.

Unlike most privacy coins, it provides solid privacy without compromising on flexibility. Indeed, because of its use of the Bitcoin codebase, it can interact with smart contract DEX), granting them more privacy at the same time.



Blockchain Specifications

Launched in 2017, PART is a modern-day privacy coin that provides a high level of anonymity and flexibility.



	Native Blockchain

	Particl



	Blockchain Codebase

	Particl Core 25.0.1.0



	Codebase Origin

	Bitcoin 25.0



	Block Time

	120 seconds (5x faster than Bitcoin)



	Block Size

	2 MB (2x more capacity than Bitcoin)



	Consensus Mechanism

	Particl Proof-of-Stake (PPoS)



	Circulating Supply

	~13.26M (100%)



	Inflation Rate

	7% per year (3.5% to stakers, 3.5% to treasury)



	Segwit

	Enabled



	Lightning Network

	Enabled



	Atomic Swaps

	Enabled



	Taproot

	Enabled








Particl’s Bitcoin Origins

PART is based on the latest version of the Bitcoin code (currently Bitcoin 25.0) on top of which several improvements and adjustments have been made. This makes it a faster, more private, and more flexible version of Bitcoin.

One of the major benefits of being built on the Bitcoin codebase is the ability for Particl contributors to leverage the large Bitcoin developer pool and tap into their body of work. This allows for useful products (Particl Copay, Particl Electrum), protocols (Taproot, Lightning Network), and other improvements and updates to be easily adapted to work with Particl without having to build everything from scratch.

Another significant benefit relates to the security of users. Bitcoin being the most battle-tested blockchain out there, it has passed the test of time and countless stress testing, succeeding at protecting user funds over time. Leveraging the Bitcoin codebase and the ever-ongoing work of its developer community transposes its security benefits to Particl users.




See also


	Github - Particl Core [https://github.com/particl/particl-core]


	Github - Particl RPC Documentation [https://particl.github.io/rpc-docs/]


	Block Explorer - Insight [https://explorer.particl.io]


	Particl Explained - Privacy Specifications


	Particl Explained - Proof-of-Stake (Staking)


	PART Guides - Particl Desktop Wallet


	PART Guides - How to Stake


	PART Guides - How to Vote


	PART Guides - Send, Receive, and Convert PART


	PART Guides - Buy and Sell PART










            

          

      

      

    

 


  

    
      
          
            
  
Staking Explained

“Staking” refers to the act of supporting the blockchain by validating transactions on your computer (referred to as a “staking node”). In exchange for this work, the network rewards you with its cryptocurrency coins.

Specifically, Particl’s PPoS staking protocol allows users to securely and transparently vote on various issues and proposals using the power of blockchain technology. This process is called on-chain governance and is used to govern the Particl DAO.




Table of Contents


	Blockchain Consensus Mechanisms


	What’s a consensus mechanism?


	Staking vs. mining


	Advantages of staking compared to mining






	Particl Proof-of-Stake (PPoS)


	Earn Passive Income


	What’s a staking reward?


	How much can I earn?






	Staking Options


	Regular staking


	Cold staking


	Staking pools


	Hardware Staking


	Mobile staking






	Staking Privacy


	Voting








Blockchain Consensus Mechanisms


What’s a consensus mechanism?

To guarantee the integrity of the blockchain, staking nodes connected to the network process all of the transactions happening on Particl. They then compare the processed data with each other and only validate transactions when the information is identical across a majority of the other nodes. This prevents fraud and ensures that all blockchain nodes host the same copy of the ledger.

If enough staking nodes cannot confirm the data of a transaction on the network, the transaction is collectively rejected. This mechanism is what is generally referred to as a consensus mechanism.



Staking vs. mining

Just like Bitcoin mining (proof-of-work), staking (proof-of-stake) is a consensus mechanism. They are both protocols that ensure the integrity of blockchains by validating transactions and paying out block rewards to those doing the work.

Unlike mining, staking doesn’t require any special hardware (i.e., GPU) to verify transactions. Instead of providing electricity-intensive work, stakers are required to deposit a number of coins (as collateral for being good actors) on the network on which they’ll earn interest in dividend-like payments.



Advantages of staking compared to mining


	Rewards stakers with auto-compounding passive income


	No expensive hardware required


	Carbon neutral and eco-friendly protocol


	Very little technical knowledge required


	Better accessibility and a much easier setup process


	Makes community governance accessible to any user of a network









Particl Proof-of-Stake (PPoS)



PPoS Quick Facts (Click Here)




	The current yearly staking interest rate for stakers is 7%


	The current emission rate of PART is ~1.72 PART per block.


	Staking interest is paid in regular dividend-like payments.


	All fees generated by the Particl applications are redistributed to stakers as part of the usual block rewards.


	Industry-leading staking security.


	Adjustable level of privacy when receiving rewards is available.


	No minimum number of PART coins is required to start receiving staking rewards.


	Cold staking “pools” allow you to team up with other stakers to receive more frequent rewards.


	Particl’s community governance is powered by PPoS (on-chain voting).






To support its network and verify transactions, Particl uses Particl Proof-of-Stake (PPoS), a unique Proof-of-Stake consensus mechanism designed by the Particl team. Unlike Bitcoin’s consensus mechanism, called Proof-of-Work, PPoS makes the entire process of verifying transactions digital. It also eliminates the need to purchase and maintain expensive and energy-hungry hardware.

When a staker’s node finds a block and validates the transactions it contains, it receives a staking reward. The current yearly staking interest rate on Particl ranges from a minimum of 3.5% to approximately 7%. This staking interest rate is calculated based on the percentage of the total supply being staked by all the users.

While the Proof-of-Stake consensus mechanism isn’t particularly new, Particl has been pioneering the technology during the past few years by making it much more flexible, secure, and private. Indeed, PPoS is packed with several leading-edge features that let you get all the benefits of Proof-of-Stake, but without any of its typical security and convenience concessions.


Note

Did you know that Particl invented and deployed the first-ever “cold staking” protocol in 2017? Cold staking allows you to stake funds stored offline (cold storage) with an extreme level of security and flexibility.







Earn Passive Income

Just by keeping your Particl Desktop client connected to the internet, you automatically earn a yearly interest rate of 3.5% to 7% on the total number of PART coins you hold in your public balance. In other words, the more PART coins you own, the more PART coins you earn. Simple enough, right?


What’s a staking reward?

A staking reward is defined as any number of PART coins received from the Particl blockchain in exchange for securing the network. These rewards are proportionally paid to stakers in exchange for their contribution. This process is entirely automatic and happens in the background without you requiring to do any manual task.



How much can I earn?

On Particl, a staking reward is funded by two sources; the base reward (the number of PART generated by the blockchain at every block) and the fees paid by Particl users when interacting with the platform and its privacy-first dApps.


Base reward

As a general rule of thumb, you can earn 3.5% to 7% of the PART coins you hold in your public balance after a full year of staking without pause. However, it is impossible to know exactly how much you’d make in a year, given that the actual interest you receive depends on a few variable factors.

If you’re staking 24/7, you are guaranteed to earn at least 3.5% more coins than you hold in your public balance per year. But that’s only true if the entirety of the PART supply is actively staking. As you can imagine, this simply cannot happen.

Historically, only 35% to 60% of the PART coins in circulation are ever staked at any given time, which means staking rewards get redistributed among a smaller pool of stakers.

This smaller pool of stakers receives staking rewards more often because they will find blocks more often than if every single Particl user was staking. This makes the actual yearly staking interest rate more profitable than the guaranteed minimum of 3.5%.



Platform fees

More people using the Particl ecosystem means more profitable staking rewards. That’s because staking rewards also contain fees paid by users interacting with the Particl ecosystem. These fees come from a few different sources.

Marketplace-related fees: The Particl Marketplace requires a small listing fee to be paid by vendors when they list items or services for sale. That’s how the marketplace, which has no central authority, prevents spam. Other features, such as promoting one’s market into the public Market Browser, also incur fees paid to the network and redirected to stakers.

PART transaction fees: When sending PART coins to someone else or into a smart contract, a small transaction fee needs to be paid to the network. This fee is usually just a few cents, or even less, but it’s counter-productive enough to fight off spam on the blockchain. This is the same type of fee charged by Bitcoin or Ethereum for making any transaction.







Staking Options

PPoS is a modern and flexible Proof-of-Stake consensus mechanism. Its most unique and groundbreaking feature is the ability to delegate your coin’s staking power to a separate staking node that contains no coin. That’s what’s called “cold staking”.

Not only does cold staking provide you with the most secure staking solution available anywhere, but it also unlocks a ton of ways you can stake your PART coins, each with its own benefits and considerations.




Regular staking



Pros




	Can be activated effortlessly.


	Activated by default on clients not protected by a password.


	Allows you to participate in Particl’s community governance by voting on proposals.








Cons




	Your Particl Desktop password is stored in your computer’s memory.


	You need to keep your computer online 24/7.






Arguably the easiest way to start staking is to keep your Particl Desktop client open. This requires you to unlock your wallet for staking only, which means your Particl Desktop client will act as a staking node and be able to verify transactions. This simple way of staking doesn’t use Particl’s novel ability to delegate your coin’s staking power to another node, and for this reason, is more limited than its cold staking counterpart.

Regular staking requires a constant and active network connection, which means you need to keep your computer online and your Particl Desktop client open at all times. It also cannot be effectively implemented on external devices due to the constant network requirement, potential battery drainage, and security vulnerabilities.





Cold staking



Pros




	Very secure staking option.


	The wallet that holds your coins doesn’t need to be online at any time.


	Extremely flexible, it allows many other staking options.








Cons




	You need to set up and maintain an external staking node and keep it online 24/7. This is one reason many people instead opt to use a VM hosted externally for this purpose.


	The setup process is more technically advanced.






Cold staking is the better, more modern way to stake. This proof-of-stake improvement was released by Particl contributors in 2017 and is still, to this day, the most secure way to stake coins.
Cold staking lets you delegate your coin’s staking power to an external staking node without having to keep the Particl wallet that holds your coins online.

That means you can store your coins in a cold wallet, a hardware device (i.e., a Ledger Nano device), your phone, or even a just simple piece of paper with the mnemonic written on it. You’ll still be able to earn staking rewards on those coins even though they are entirely offline. Indeed, cold staking grants you the maximum amount of security and adds a ton of flexibility not possible without it.

To learn how to set up an external cold staking node, follow the instructions in the Staking Guide available here on the Particl Academy.





Staking pools



Pros




	Very easy to join. Takes less than a minute.


	Offers the same level of staking security as cold staking because it entirely relies on it.


	The wallet containing your coins doesn’t need to be online at any time.


	Pays more frequent staking rewards, but they are smaller in size. You earn the same number of coins (minus pool fees) as you would with any other staking option. The only difference is the size of the payouts and how often you receive them.


	Doesn’t require you to deploy and maintain an external staking node.








Cons




	You need to pay a staking pool fee (a percentage of your staking revenue).


	By delegating your staking power to a pool, you also delegate your voting power. A pool operator can vote on proposals using your coins, so make sure that you know the voting intentions of any pool you join.






You can team up with other stakers by joining a staking pool and combining your staking power to earn more frequent but smaller rewards. Whenever the pool validates a block with the full staking power of all its stakers, it receives a staking reward.

All of the staking rewards collected by the pool are then proportionally redistributed to its members according to their contribution to the pool’s staking power. In other words, if you stake in a staking pool and own 10% of all its staking power, then you will receive 10% of all its staking revenue minus the pool fee.

Staking pools are safe to use as the pool operator cannot run away with any of the funds it stakes. That’s because it entirely relies on cold staking. You delegate your staking power to a pool instead of an external node you control, but the security benefits are the same.

They are ideal if you hold a small number of PART coins or don’t want to manage an external staking node yourself.

For a complete list of available staking pools on the Particl network, visit Particl Academy’s Staking Guide.


Tip

Instead of an external staking node, you can also use a staking pool to enable mobile and hardware staking.







Hardware Staking



Pros




	A hardware device may provide an additional level of security for your funds


	The wallet containing your coins doesn’t need to be online at any time.








Cons




	You need to set up a staking node and keep it online 24/7 unless you use a staking pool instead.


	The setup process is the most complicated of all staking options on Particl.






For a potentially even more secure staking solution, you can stake PART coins stored on a hardware device such as the Ledger Nano S or the Trezor. These hardware devices are secure cryptocurrency wallets that require direct physical access to authorize any transaction. They protect you against viruses, infected computers, compromised internet connections, and more.

Since PPoS is a highly flexible protocol, it doesn’t penalize you for going “security first”. By leveraging cold staking, it lets you enable staking and earn interest in dividend-like payments on PART coins even when stored in hardware wallets.

To learn how to set up hardware staking, jump to the Staking Guide right away!





Mobile staking



Pros




	Very secure and convenient staking option.


	The mobile wallet containing your coins doesn’t need to maintain an active connection to the Particl network.


	Relatively simple setup process.








Cons




	You need to set up a staking node and keep it online 24/7 unless you use a staking pool instead.






As its name implies, mobile staking lets you earn a staking interest on the PART coins you hold on your phone (i.e., Particl Copay, Particl Electrum). This functionality uses cold staking to delegate your coin’s staking power to another node.

Because your phone isn’t doing the actual staking work (that’s the role of the external staking node), it doesn’t lead to battery drainage issues and doesn’t require you to keep your phone powered on. It also won’t bust your mobile data as it uses no extra network resources.

It is a convenient and user-friendly staking solution that lets you carry your coins wherever you go and still earn staking interest on them.






Staking Privacy

By default, Particl Proof-of-Stake distributes its staking rewards using public transactions. This process is completely transparent and auditable. This is a huge boost in trust and security for the network as any potential malfunction or coin-generating exploit could be instantly detected right at the source.

However, it also means anyone can trace staking rewards and look right into your wallet. Not something you would want to happen with your bank account, that’s for sure.

That’s why Particl allows you to control your level of staking privacy using Partyman; Particl’s cold staking application. To do so, you need to indicate to the network that you’d like to receive your staking rewards in another type of balance other than your public balance. Check out the Staking Guide to see how to do it.



Voting

PPoS is at the core of Particl’s decentralized governance. You can vote on various community proposals using your staking power as voting power. When you register your voting preferences during a voting round, you cast a vote every time you stake a block.

To learn more about Particl’s community governance model, head over to the Community Governance in-depth guide.




See also


	PART Guides - How to Stake


	PART Guides - How to Vote


	PART Guides - Send, Receive, and Convert PART


	Particl Explained - Community Governance







	PART Guides - Buy and Sell PART








            

          

      

      

    

 


  

    
      
          
            
  
Privacy Specifications

PART is a solid privacy coin with a high level of flexibility and smart contract interactivity. It doesn’t just allow you to transact person-to-person with anyone else; it also lets you do it completely anonymously, preserving the privacy of your financial data from the rest of the world.
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	Public transactions


	Use Cases






	Blind transactions


	Confidential Transactions


	Rangeproofs


	Bulletproofs


	Use Cases






	Anon transactions


	Ring Signatures (MLSAG)


	Use Cases






	Stealth Addresses






	Privacy-first Smart Contracts








Transactional Privacy

PART has an adjustable level of privacy and lets you choose between three different types of transactions (public, blind, and anon), each with its own purpose, cost, and level of anonymity.



	Adjustable Level of Privacy

	Yes, 3 levels



	Privacy Protocols

	Confidential Transactions (CT) and RingCT



	Bulletproofs

	Enabled



	Stealth Addresses

	Yes



	Ring Signatures

	Yes



	Taproot

	Yes






PART has three different types of transactions, each with its own use cases, cost, level of privacy, type of balance, and settings. All three types are available on Particl Desktop where you can easily convert your coins from one kind of balance to another.




Public transactions



	Cost

	Participants Information

	Amount Transacted

	Type of Balance



	Very low

	Public

	Public

	Public






Public transactions let you make Bitcoin-like pseudonymous blockchain transactions. These transactions are the most affordable ones to make and the simplest to integrate into other platforms. For this reason, they are the most widely supported type of transaction by exchanges and third-party services.

Additionally, public transactions can only be sent to public balances, which is also the only type of balance that can stake. Visit the Staking Guide for more information on this topic.


Use Cases


	Send and receive pseudonymous payments on a public blockchain;


	Earn PART coins in dividend-like payments via staking;


	Pay for listing fees on the marketplace;


	Promote user markets and storefronts on the Market Browser;


	Moderate the Particl Marketplace;


	Use smart contracts;


	Trade on BasicSwap DEX;


	Vote on community proposals (DAO).









Blind transactions



	Cost

	Participants Information

	Amount Transacted

	Type of Balance



	Low

	Public

	Hidden

	Blind (private address)







Confidential Transactions

Blind transactions offer a significant step-up in privacy. Based on the work of the open-source Elements Project [https://elementsproject.org/features/confidential-transactions/investigation], they let you make confidential transactions that keep the value of the payment private between only you and the other party you’re transacting with.

The identity of the participants (their PART address) is still publicly displayed on the blockchain, but no one else can determine how many coins were transacted.

The Confidential Transactions protocol is entirely trustless, meaning that it doesn’t require any trusted setup and doesn’t require the assistance of any intermediary to process transactions.

To prove and ensure that amounts being sent and received are correct and not fraudulent, the protocol uses rangeproof.



Rangeproofs

A rangeproof is a cryptographic protocol used to verify that a payment amount is positive or zero without actually revealing the amount transferred in the transaction.

Without rangeproofs, the amounts in a transaction could be set so large that it would be considered a negative number, thus allowing coins to be generated out of thin air. An attacker could add a negative amount output and another different output, generating extra coins. The negative output would make the commitments still sum to zero.

The downside with rangeproofs is that they are quite heavy on the blockchain. Their size scales linearly with the number of outputs in a transaction and the bits in the proof’s range. In fact, due to their heavy nature, rangeproofs take up the majority of a blinded transaction’s size.



Bulletproofs

Bulletproofs is a new generation of rangeproofs that scale logarithmically rather than linearly. In its whitepaper [https://eprint.iacr.org/2017/1066.pdf], they are referred to as non-interactive zero-knowledge short proofs.

More simply, they are a groundbreaking improvement over regular rangeproofs as they reduce their size by around ~70%. And, because rangeproofs make up for the majority of a blind transaction’s size, it, in turn, reduces transaction fees and the space they take on the blockchain by the same ratio.


See also


	Particl’s Bulletproofs audit - Report by Quarkslab [https://blog.quarkslab.com/resources/2019-07-05-audit-particl-bulletproof-mlsag/particl_audit_report.pdf]


	Confidential Transactions whitepaper - Confidential Transactions investigation [https://elementsproject.org/features/confidential-transactions/investigation]


	Bulletproofs whitepaper - Bulletproofs [https://eprint.iacr.org/2017/1066.pdf]








Use Cases


	Send and receive payments without disclosing the value transferred;


	Hide amounts sent to smart contracts;


	Trade on BasicSwap DEX.









Anon transactions



	Cost

	Participants Information

	Amount Transacted

	Type of Balance



	Moderate

	Hidden

	Hidden

	Anon (private address)






By adding “ring signatures” to blind transactions (RingCT), you obtain anon PART transactions. This is the most private type of transaction on Particl and makes transactions completely untraceable. All of the transaction data (values transferred and addresses of the participants) is anonymously written on the blockchain, making it impossible for anyone not involved with a transaction to see its details.

Anon transactions can be made more or less anonymous by manually adjusting the number of ring signatures included in transactions. The more private a transaction is, the more expensive it is to send.


Ring Signatures (MLSAG)

Multilayered Linkable Spontaneous Ad-Hoc Group Signatures (MLSAG), or ring signatures, is the Ring part of RingCT. It is a type of digital signature that is performed by many outputs at once within a given group of RingCT outputs (represented by Anon balances on Particl Desktop). It is then impossible for any outside observer to tell which of the participating outputs within that signature is the output actually sending out the transaction.

Wikipedia describes ring signatures as follows [https://en.wikipedia.org/wiki/Ring_signature]: “A ring signature is a type of digital signature that can be performed by any member of a group of users that each have keys. Therefore, a message signed with a ring signature is endorsed by someone in a particular group of people. One of the security properties of a ring signature is that it should be computationally infeasible to determine which of the group members’ keys was used to produce the signature.”.

In RingCT’s case, the digital signature used to execute a transaction could have originated from any member of the ring group. Users put some of their funds within an Anon balance. Funds held within an Anon balance are used to execute RingCT transactions. Before a transaction is executed, the protocol anonymously signs it by using other RingCT outputs as decoys and produces a signature that, when verified, looks like it could have been initiated by any of the owners of the RingCT outputs used by the ring group. It is not possible to know who really made the transaction because it could be anyone that has an output that’s being used by the ring group as a decoy.

This effectively anonymizes all values contained within a transaction. It also arms transacting parties with a very strong plausible deniability.


See also


	Particl’s MLSAG audit - Report by Quarkslab [https://blog.quarkslab.com/resources/2019-07-05-audit-particl-bulletproof-mlsag/particl_audit_report.pdf]


	RingCT whitepaper - Ring Confidential Transactions [https://eprint.iacr.org/2015/1098.pdf]








Use Cases


	Send and receive anonymous and untraceable payments;


	Pay for goods and services on Particl Marketlace;


	Pay for listing fees on Particl Marketplace;


	Promote user markets and storefronts on the Market Browser;


	Use smart contracts anonymously;


	Enter into two-party escrow agreements without sharing any information with any third-party;


	Receive staking rewards anonymously.




To learn more about the technology powering PART’s privacy capabilities, refer to the Particl Blockchain — Privacy section of the whitepaper.






Stealth Addresses

Particl allows anyone to use stealth addresses instead of regular, public addresses. Stealth addresses are one-time addresses that increase privacy because only the owner of a stealth address can tell if an output belongs to it or not. What is meant by “one-time address” is that a stealth address can receive payments many times, but each time, it generates a new ‘one-time address’ for that output/transaction.

Without knowing the private key of an address, an observer won’t be able to link and guess which outputs match which stealth address. This helps in protecting the identity of the receiver of a transaction.

On their own, stealth addresses probably aren’t enough to protect transaction information from any well-funded and motivated observer (i.e., a state actor), but when combined with stronger privacy protocols such as Confidential Transactions or RingCT, it provides yet another layer of privacy for the user.

As it currently stands, blind and anon transactions can only be sent to stealth addresses.






Privacy-first Smart Contracts

One of the reasons we rarely see privacy-preserving smart contracts is that they require coins to have programmable outputs. After all, a smart contract is very much akin to a distributed program. Unfortunately, outputs are not programmable in most privacy coins, such as Monero, Zcash, and others.

That is also the case with Particl’s anon transactions, which use RingCT. However, the uniqueness of the Particl ecosystem still allows for them to be used in smart contracts, granting them the same level of anonymity as when making anon transactions.

Because blind transactions (CT) have programmable outputs and can be used in smart contracts, RingCT transactions can be attached to their outputs.

In fact, a RingCT output is converted to a CT output, which forms the inputs of a given smart contract. When the smart contract is ready to release funds to a particular address, it is directly released into a RingCT output. In other words, incoming and outgoing smart contract payments can be made using anon transactions, but the coins are temporarily converted into blind outputs while the smart contract manages them.

This makes Particl smart contracts completely anonymous.




See also


	PART Guides - Send, Receive, and Convert PART


	PART Guides - Particl Desktop Wallet


	PART Guides - Buy and Sell PART










            

          

      

      

    

 


  

    
      
          
            
  
Community Governance

Particl has a decentralized community governance mechanism that gives you a voice in the ecosystem’s most critical decisions. The model uses the Particl Proof-of-Stake (PPoS) staking protocol to let you cast votes on community proposals.

Particl’s decentralized community governance model puts you in control and gives you the tools you need to make almost anything happen.
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Decentralized Governance

In the cryptocurrency industry, decentralized governance refers to the ability of a community to publish, debate, and vote on various proposals and issues using distributed tools. It seeks to balance control over a particular project from a small group of individuals to a broader community. Depending on the project being governed, the level of decentralization can vary, giving more or less power to its community and greater resilience against attacks.

Ideally, decentralized governance mechanisms strive to use properly distributed tools to run voting rounds in a provably fair manner. This eliminates third-party risks associated with voting manipulation and unfair influence over the outcome of a vote.


Particl’s model in a nutshell

The Particl project is all about decentralization, security, privacy, and personal freedom. That’s why its governance model follows a decentralized, fair, and transparent process.

Anyone from the Particl community can publish proposals on the CCS platform. Each proposal has to first go through a discussion phase, after which it gets moved to a voting phase. That’s when the rest of the community can vote to either approve or reject the proposal using their staking power.

To support community initiatives and provide the initial capital they require, Particl has a decentralized treasury fund that is automatically funded by the blockchain. Proposals can request funds from it to help bootstrap initiatives as long as they directly benefit the Particl ecosystem.




Community Proposals

When it comes to Particl’s decentralized governance model, proposals refer to any proposed initiative, project, protocol change, or request of funds from any individual or group.

For proposals to be considered “valid” within Particl’s model, they are required to benefit and bring value to the ecosystem directly. There is no other hard requirement other than to follow the general CCS rules and guidelines.


CCS Platform

Proposals are published on the Community Crowdfunding System (CCS) platform. Forked from Firo’s adaptation of Monero’s CCS system, this platform is hosted on GitHub and tracks the lifecycle of a proposal, from edits to comments and voting results. This guarantees the maximum level of transparency.

When published, a proposal initially goes through a discussion phase (Ideas) where others can add comments to what’s being proposed. During that phase, the proposal’s owner(s) can modify its proposition based on the feedback received. Any change made at this stage is transparent and clearly displayed on the proposal’s page.

Then, the proposal moves to the Funding Required phase to collect the capital it needs for the proposed initiative to get started. A proposal can either request donations from the community or request funds from the decentralized treasury.

Once a proposal is fully funded, it moves to the Work in Progress phase, where its owner(s) will get to work. Funds are disbursed to the appropriate party based on pre-defined milestones in the proposal. Milestone-based fund payouts ensure that funds are only used for their promised purpose.

Finally, a proposal is moved to the Completed Tasks phase after every milestone has been completed and the project delivered in full.



Decentralized Treasury

Proposal owners can request funds from Particl’s decentralized treasury fund to get the startup capital required to kickstart their initiatives. For a claim to be accepted and for funds to be attributed (on a milestone basis) to the owner, it needs to be approved by the community through a community vote.

Particl’s decentralized treasury fund is powered by Particl’s staking protocol and self-funded using a portion of the network’s block rewards. Every time a block is found and validated by a staker, 50% of the staking rewards it contains is automatically deposited into the treasury fund by the protocol.

No coin from the treasury fund can be used or transacted without the community’s consensus, which is determined by an on-chain vote.




On-Chain Voting

Voting rounds on Particl are conducted in a decentralized and provably fair manner. Only active stakers, referred to as “stakeholders” in the specific context of an on-chain vote, can cast votes on proposals. This ensures only individuals with a vested interest in the project can govern its most important decisions.

The process of voting and counting votes leverages the Particl Proof-of-Stake (PPoS) staking protocol, and every round’s results are publicly inscribed on the blockchain permanently. This provides the maximum level of transparency and security possible, making it impossible to modify past results or misreport voting outcomes.

To determine each individual’s voting power, the voting preference of a staker is only counted when they find a block. Then, at the end of a voting round, all the blocks within the voting round’s timeframe are scanned, and each block with a vote inscribed in it is counted towards the final tally. In other words, the more a single staker finds blocks, the more voting power they hold.

Voting rules and parameters depend on the type of proposals being voted on.


Non-Protocol Consensus-Changing Proposals



	Quorum

	20% of all the blocks during a voting period



	Approval Rate

	>= 60% in favor



	Duration

	5,040 blocks minimum






The first type of proposal, non-protocol consensus-changing proposals, does not require significant changes to the protocol. Typically, they would be proposals requesting funds from the treasury fund to kickstart a specific project, for example.

For a non-protocol consensus vote to be considered “valid”, its voting period must be a minimum of 5,040 blocks (roughly one week). Within that period, 20% of the blocks staked are required to have a vote inscribed in them. That means the quorum, or participation rate, has to be at least 20%.

Finally, to be considered “approved” by the community, it needs to reach an approval rate of at least 60%, meaning at least 60% of all the votes cast for the proposal approve the proposed idea.



Protocol Consensus Changing Proposals



	Quorum

	20% of all the blocks during a voting period



	Approval Rate

	>= 75% in favor



	Duration

	10,080 blocks minimum






The other type of proposals, protocol consensus-changing proposals, are typically more critical in scope and can significantly impact the ecosystem. Consensus-changing proposals are proposals that require a specific change in the protocol, such as, for example, modifying the inflation rate of the blockchain or introducing a new privacy technology.

Just like non-protocol consensus-changing proposals, their quorum requirement stands at 20%. But because of their increased level of importance and ramifications, they require a higher level of approval from the community. In fact, the required approval rate has to be at least 75%. Finally, the duration of any protocol consensus vote has to be a minimum of 10,080 blocks (roughly two weeks) to give ample time to anyone to be able to cast their vote.




See also


	Particl Explained - DAO and Network Treasury


	Particl Explained - Staking Guide


	PART Guide - Buy and Sell PART


	PART Guides - Staking Guide


	PART Guides - Send, Receive, and Convert PART


	PART Guides - Particl Desktop Wallet


	Particl Wiki - How to Vote on Proposals [https://particl.wiki/tutorial/staking/how-to-vote/]











            

          

      

      

    

 


  

    
      
          
            
  
DAO and Network Treasury

The Particl network is, at its core, a ‘decentralized autonomous organization’ (DAO). A DAO is an entity without a central authority that is autonomous, self-sufficient, and transparent by design. Because of this distributed nature, the network has no central point of failure and is highly resistant to outside interference, attacks, and other agenda-driven actions.
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Decentralized Treasury and Network Income


Note

Track the treasury’s income and payments by following this link [https://explorer.particl.io/address/RQYUDd3EJohpjq62So4ftcV5XZfxZxJPe9].



To stimulate the development of dApps, distributed services, and the overall growth of the network, Particl is supported by its own decentralized treasury fund, which automatically receives 50% of the staking rewards generated by the blockchain. This staking income is hard-coded directly into Particl Proof-of-Stake (PPoS) and is entirely decentralized.



	Circulating Supply

	~13.26M



	Yearly Coin Emission Rate

	1.72 PART



	Treasury Staking Share

	50%



	Average Monthly Treasury Income

	120 seconds (5x faster than Bitcoin)






Every month, Particl’s decentralized treasury receives network revenue that can be used by Particl community contributors to fund dApps, distributed service providers, or any other community-proposed initiative that promotes the growth and wellness of the ecosystem.



Treasury Fund Management

The funds deposited into the network’s treasury fund are held in a 3-of-5 multi-signature address managed by different members of the Particl team. The funds can only be allocated to individuals or teams (henceforth “proposers”) who publish clear proposals that get approved by the community through an on-chain voting process. Funds cannot be allocated without the clear and auditable approval of Particl stakeholders.

This multi-signature-based approach to managing treasury funds is intended as a temporary solution to provide a failsafe layer while the team incrementally works on a solution to decentralize the treasury in full, notably with the help of Taproot and its condition-based scripting language.



Community Governance (CCS Platform)

Proposals to be voted on are hosted on the CCS platform. The Community Crowdfunding System (CCS) is a platform on which anyone can freely publish proposals to be discussed and voted on by Particl’s community of stakeholders. It is completely open-source and fully transparent, and is hosted on the GitHub platform.


Publication Process

To prevent abuse of the system, the CCS platform is currently actively managed and moderated by the Particl team. While this introduces a certain degree of centralization into the governance system of the platform, it helps foster an open but pertinent space for the publication of ideas and for contributors to freely discuss their vision within the context of the wider Particl ecosystem’s interests.

This moderated approach aims to simultaneously promote free discussion and protect the network from ill-intended actors, spam, and proposals that may be harmful to the network. It also provides a last line of defense and a layer of protection against abuse of the system while the team incrementally works on a fully decentralized approach to the governance of the network.




See also


	Particl Explained - DAO and Network Treasury


	Particl Explained - Staking Guide


	PART Guides - Buy and Sell PART


	PART Guides - Staking Guide


	PART Guides - Send, Receive, and Convert PART


	PART Guides - Particl Desktop Wallet


	Particl Wiki - How to Vote on Proposals [https://particl.wiki/tutorial/staking/how-to-vote/]











            

          

      

      

    

 


  

    
      
          
            
  
Particl Desktop

Particl Desktop is Particl’s main desktop client, and the preferred access gateway into the Particl ecosystem. It enables access to some of the various privacy-first dApps, acts as the go-to PART wallet, and allows users to vote on and track DAO proposals.

While Particl contributors are working on alternative gateways to access and interact with the Particl ecosystem and its privacy-first dApps (i.e., web, mobile), Particl Desktop is the most secure, private, and decentralized access point available.
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Wallet


[image: Particl Marketplace]

Particl Desktop’s wallet overview page



Particl Desktop’s “wallet” section is where you can manage your funds and overview your financial activities. Particl Desktop also allows users to manage, create and import an infinite number of wallets within the same environment. All wallets are independently encrypted for maximum security.



Send/Convert and Receive




	Send and receive funds and convert coins between the different available balance types.


	Manage and organize UTXOs to optimize your transactions using the Coin Control feature.


	Adjust the desired level of transactional transparency.


	Split UTXOs into smaller chunks for better privacy.


	Convert balances between the three types of available balances (public, blind, and anon).


	Receive funds in public or private (stealth) addresses.








History




	Keep track of all your previous transactions.


	Outgoing transactions


	Incoming transactions


	Earned staking rewards


	Balance type conversions








Address Book (Contacts)



Because funds need to be sent to cryptographic addresses, it can be hard to remember who owns which address. Particl Desktop’s address book page is there specifically to let you label PART addresses to contacts.


	Save both public and private PART addresses and enter their contact information.


	Display a contact’s address and all of its details in a block explorer.


	Sign and verify messages using PART addresses.


	When sending funds to one of your contacts, you can quickly pick their address from the address book.








Market

The “Market” section of the Particl Desktop client is the main access gateway for the Particl marketplace dApp. It allows you to browse items available on the market, manage your own inventory of products and listings, join additional markets and storefronts, and review your buy orders and sell orders. It is the first dApp to be integrated fully within the Particl Desktop client.



Overview




	Access shortcuts that make your buyer or seller experience easier.


	Monitor your funds and balances.








Browse




	Browse online markets and storefronts.


	Discovert products and services and add them to your cart.


	Flag undesirable listings and see those others have flagged.


	Sort marketplace content by categories, regions, and keywords.


	Expand listing details and see more information about them.


	Communicate with sellers and leave questions on their listings.








Cart




	View your cart and the items you’ve added to it.


	View the items you’ve saved for later.


	Manage your shipping profiles.








Purchases




	View your marketplace purchasing history.


	Manage ongoing purchasing orders.


	Communicate with your orders’ sellers.








Sell




	View your marketplace sales history.


	Manage ongoing sales.


	Communicate with your customers.


	View and manage your marketplace listings.


	List new products or services.


	Import inventory from external source (i.e., WooCommerce).


	Bulk adjust prices and other listing details.


	Publish listings in one or more markets/storefronts at once.


	Clone listings.








Chat Messages




	View all your conversation history.


	Continue discussions with other users.


	Manage your contact list.








Manage Markets




	Create a new market or storefront.


	Join public markets using the Market Browser.


	Join private markets manually using their keys.


	Manage already-joined markets.


	Flag undesirable markets and see those others have flagged.








Govern


[image: Particl Marketplace]

Particl Desktop’s community governance section



The “Govern” section of the Particl Desktop client is where community governance proposals can be displayed and voted on, in an intuitive and user-friendly interface. It also includes additional documentation on the Particl DAO’s governance mechanisms.


See also


	Particl Explained - Blockchain Specifications


	Marketplace Explained - Particl Marketplace Explained


	PART Guides - Send, Receive, and Convert PART










            

          

      

      

    

 


  

    
      
          
            
  
Send, Receive, and Convert

Although sending and receiving PART is a straightforward process, Particl’s native privacy coin also offers a variety of different options from which you can choose from. This guide will teach you everything you need to know about them and walk you through all the steps.
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Send PART

You can send PART to anyone without restrictions using any of the available wallets. Depending on the context, you may want to send funds with a varying level of privacy, which PART easily allows you to do.


Public Transactions

You can send PART using public transactions. This makes the transaction entirely public by permanently inscribing the information of both participants, as well as the transacted amounts, on the blockchain. Public transactions are pseudonymous, akin to regular Bitcoin transactions.


Particl DesktopParticl QtParticl Electrum

	Open Particl Desktop and navigate to the Wallet section.


	Make sure that you have coins in your public balance.


	Click on the SEND / CONVERT button to open the Send page.


	Select your public balance and enter the information of the intended recipient of the payment.


	(Optional) Select the outputs you want to use for that transaction by clicking on the Coin control button.


	Enter the amount you wish to send, and click on the Make payment button.


	Verify the payment information in the confirmation pop-up window that appears, and click on the Confirm & Send button to send the payment.






	Open Particl Qt.


	Make sure that you have coins in your public balance.


	Click on the Send tab.


	Enter the information of the intended recipient of the payment as well as the amount you wish to send.


	Make sure that the two dropdown menus (just above where the fee estimate is displayed) are set as “PART” and “PART”.


	(Optional) Select the outputs you want to use for that transaction with Coin Control by clicking on the Inputs… button.


	Click on the Send button to prepare your transaction.


	Verify the payment information in the confirmation pop-up window that appears, and click on the Sign & Send button to send the payment.






	Open a wallet on Particl Electrum.


	Make sure that you have coins in your public balance


	Click on the Send tab.


	Enter the information of the intended recipient of the payment as well as the amount you wish to send.


	Verify the payment information in the confirmation pop-up window that appears, and click on the Send button to send the payment.











Blind Transactions


Particl DesktopParticl Qt

	Open Particl Desktop and navigate to the Wallet section.


	Make sure that you have coins in your blind balance.


	Click on the SEND / CONVERT button to open the Send page.


	Select your blind balance and enter the information of the intended recipient of the payment.


	(Optional) Select the outputs you want to use for that transaction by clicking on the Coin control button.


	Enter the amount you wish to send, and click on the Make payment button.


	Verify the payment information in the confirmation pop-up window that appears, and click on the Confirm & Send button to send the payment.






	Open Particl Qt.


	Make sure that you have coins in your blind balance.


	Click on the Send tab.


	Enter the information of the intended recipient of the payment as well as the amount you wish to send.


	Make sure that the first of the two dropdown menus just above where the fee estimate is displayed is set as “Blind”. This indicates that you wish to send coins from your blind balance.


	Select what type of balance you want to send your payment to by selecting it in the second dropdown menu. If, for example, you select Anon, your blind transaction will be sent to an anon balance.


	(Optional) Select the outputs you want to use for that transaction with Coin Control by clicking on the Inputs… button.


	Click on the Send button to prepare your transaction.


	Verify the payment information in the confirmation pop-up window. that appears, and click on the Sign & Send button to send the payment.











Anonymous Transactions


Particl DesktopParticl Qt

	Open Particl Desktop and navigate to the Wallet section.


	Make sure that you have coins in your anon balance.


	Click on the SEND / CONVERT button to open the Send page.


	Select your anon balance and enter the information of the intended recipient of the payment.


	(Optional) Select the outputs you want to use for that transaction by clicking on the Coin control button.


	(Optional) Select the desired level of transactional privacy by clicking on the Advanced options button. Move the slider according to your preferences.


	Enter the amount you wish to send, and click on the Make payment button.


	Verify the payment information in the confirmation pop-up window that appears, and click on the Confirm & Send button to send the payment.






	Open Particl Qt


	Make sure that you have coins in your anon balance.


	Click on the Send tab.


	Enter the information of the intended recipient of the payment as well as the amount you wish to send.


	Make sure that the first of the two dropdown menus (just above where the fee estimate is displayed) is set as “Anon”. This indicates that you wish to send coins from your anon balance.


	Select what type of balance you want to send your payment to by selecting it in the second dropdown menu. If, for example, you select Blind, your anon transaction will be sent to a blind balance.


	(Optional) Select the outputs you want to use for that transaction with Coin Control by clicking on the Inputs… button.


	(Optional) Select the desired level of transactional privacy by clicking on the Advanced options button.


	Click on the Send button to prepare your transaction.


	Verify the payment information in the confirmation pop-up window that appears, and click on the Sign & Send button to send the payment.












Receive Coins


Particl DesktopParticl QtParticl Electrum

	Open Particl Desktop and navigate to the Wallet section.


	Click on the RECEIVE button to open the Receive page.


	If you are receiving a blind or anon transaction, click on the Private address tab. If you are receiving a public transaction, click on the Public address tab.


	(Optional) Generate a new deposit address by clicking on the New public/private address button.


	Copy the displayed deposit address by clicking on the Copy address button.


	Send the copied address to the entity sending you the payment.






	Open Particl Qt.


	Click on the Receive tab.


	Select the type of deposit address you want to create. Choose Standard if receiving a public transaction or Stealth if receiving a blind or anon transaction.


	Generate the desired type of deposit address by clicking on the Create new receiving address button.


	Copy the displayed deposit address by clicking on the Copy Address button.


	Send the copied address to the entity sending you the payment.






	Open a wallet on Particl Electrum.


	Click on the Receive tab.


	Generate a deposit address by clicking on the New Address button.


	Copy the address in your clipboard and send it to the entity sending you the payment.











Convert Balances

You can also move your coins between the three different types of balance available. Refer to the Privacy Guide for more details on transaction types and balances.


Particl DesktopParticl Qt

	Open Particl Desktop and navigate to the Wallet section.


	Click on the SEND / CONVERT button to open the Send page.


	Click on the Convert Public / Private tab.


	Select the type of balance you’re sending your coins from on the left and the type of balance you’re sending them to on the right.


	(Optional) Select the outputs you wish to use by clicking on Coin control and the desired level of privacy (if sending from an anon balance) by clicking on Advanced options.


	Enter the amount you wish to send, and click on the Make payment button.


	Verify the balance transfer information in the confirmation pop-up window that appears, and click on the Confirm & Send button to send the payment.






	Open Particl Qt.


	Click on the Receive tab.


	Select the type of deposit address matching the balance you want to convert your coins into. Choose Standard if you want to send coins to your public balance or Stealth if you want to send it to either your blind or anon balance.


	Generate the desired type of deposit address by clicking on the Create new receiving address:guilabel: button.


	Copy the displayed deposit address by clicking on the Copy Address:guilabel: button.


	Click on the Send tab.


	Enter the number of coins you want to transfer into another balance and paste the address you’ve just copied in the Pay To text field.


	Make sure that the first of the two dropdown menus (just above where the fee estimate is displayed) is set as the balance type you want to send your coins from. Set the second dropdown menu to the type of balance you want to send your coins into. For example, if you want to send coins from your public balance into your blind balance, the first menu would be set as Part and the second as Blind.


	Click on the Send button to prepare your transaction.


	Verify the balance transfer information in the confirmation pop-up window that appears, and click on the Sign & Send button to send the payment.








Tip


	You must wait for twelve (12) confirmations (approximately 24 minutes) before funds transferred in and out of an anon balance can be moved again.


	You can track the status of transactions on the Overview page under Recent Transactions.









See also


	Particl Explained - Privacy Specifications


	PART Guides - Particl Desktop Wallet


	PART Guides - How to Stake


	PART Guides - Buy and Sell PART










            

          

      

      

    

 


  

    
      
          
            
  
Staking Guide

Simply by keeping an open connection to the Particl Blockchain, you automatically earn a yearly staking interest rate of at least 4% on the total number of PART coins you hold in your public balance.

Staking also grants you the ability to vote on various community proposals, using your staking power as voting power.
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Enabling staking is typically straightforward, though some staking solutions on Particl may necessitate additional setup effort. This guide aims to simplify the process of activating any of these solutions.


Note

Prerequisites


	A Particl Desktop wallet with at least 1 PART.


	PART coins in your Public balance.


	An uninterrupted internet connection.


	For cold staking, a secondary device to serve as a staking node.






Staking your PART coins can be achieved through various methods, each with its own set of advantages, disadvantages, and activation procedures.


Enable Staking


Regular staking

The quickest way to start staking is through the regular method. This simply involves opening the Particl Desktop client and enabling the “unlock your wallet for staking only” option. Note that regular staking necessitates your computer to remain open and online at all times.

Non-password protected client


	Open your Particl Desktop client and ensure that your Public balance contains PART coins.




That’s all! As long as your node remains connected to the internet, staking will stay active.

Password protected client


	Open your Particl Desktop client and ensure that your Public balance contains PART coins.


	Click the Padlock icon in the top right corner.


	Select the downward arrow next to Additional unlock options in the overlay.


	Select the Unlock for staking only option.


	Input your password and click Unlock wallet.




That’s all! As long as your node remains connected to the internet and unlocked, staking will stay active.



Cold staking

Cold staking, a more secure and flexible option, involves using a dedicated device that contains no coin, but can stake using delegated staking weight. This could be a hardware device, like a Raspberry Pi <https://www.raspberrypi.org/help/what-%20is-a-raspberry-pi/>, a VPS/cloud server <https://en.wikipedia.org/wiki/Virtual_private_server> (e.g., DigitalOcean, AWS, Google Cloud), or any sort of internet-connected device.

On your staking device…

Select a device for staking, such as a Raspberry Pi <https://www.raspberrypi.org/help/what-%20is-a-raspberry-pi/>, and install a Linux distribution (e.g., Raspbian <https://www.raspberrypi.org/downloads/>).


	Install Linux on your staking node.


	Install the required dependencies and download the Particl cold staking app (Partyman).




sudo apt-get install python git unzip pv jq dnsutils netcat-openbsd curl net-tools
cd ~ && git clone https://github.com/dasource/partyman






	Install or update Particl Core on your staking device.




partyman/partyman install
# Or, if updating,
partyman/partyman update






	Restart Partyman to apply changes.




partyman/partyman restart now






	Initialize a new Particl wallet on your staking node.




partyman/partyman stakingnode init






	Generate a new staking public key to link your PART coins to the staking node.




partyman/partyman stakingnode new





Copy this staking public key, it will be needed in subsequent steps.

On Particl Desktop…


	Ensure that your Public balance contains PART coins.


	Within Particl Desktop’s Wallet module, navigate to the Overview.


	Access the Cold staking widget and click the Set up cold staking button to input your staking public key, then enable cold staking.


	To immediately activate cold staking in full, use the Zap button to fast-track the progress to 100%.




Cold staking configurations

Adjust cold staking settings on your staking node with these commands.

# View staking statistics.
partyman/partyman stakingnode stats

# Redirect staking rewards to a PART address of your choosing.
partyman/partyman stakingnode rewardaddress

# Set marketplace fee preferences (more about this setting `here <https://particl.news/adjusting-listing-fees-4b676e230601>`_).
partyman/partyman stakingnode smsgfeeratetarget

# Implement firewall rules (required for port access).
partyman/partyman firewall







Connect to a staking pool

Another way to stake your PART coins is to combine your staking power with other stakers. This approach allows for more frequent, albeit smaller, staking rewards. To participate, link your Particl wallet to a staking pool.



	Pool Name

	URL/IP

	Pool Fees





	ColdStakingPool

	https://coldstakingpool.com/

	2.5%



	Crymel’s Pool

	https://particl.crymel.icu/

	2.50%



	Particl Page

	http://161.35.82.61:900/

	2.5%



	CoinRollin

	https://coinroll.in/

	1%







	Select a staking pool from the list above, visit its website, and copy the pool’s staking address (e.g., pcs1vzuadmp42slqapdm8eevm6g8ntm3hlvgptmyjy).


	Ensure that your Public balance contains PART coins.


	Within Particl Desktop’s Wallet module, navigate to the Overview.


	Access the Cold staking widget and click the Set up cold staking button to input the pool’s staking public key in the designated area, then enable cold staking.


	To immediately activate cold staking in full, use the Zap button to fast-track the progress to 100%.






Mobile staking

Staking PART coins through a mobile wallet, such as Particl Copay [https://particl.io/downloads/], is also feasible. Staking via your phone is secure and involves delegating your coins’ staking power to a staking node.


	Setup a Cold staking node and copy its public key or the public key of a staking pool into your clipboard.


	Download and install the Particl Copay [https://particl.io/downloads/] mobile app. Then, open it, create a new Particl wallet, and transfer PART coins to it.


	Once your coins are in the wallet, tap the Staking icon at the bottom right of the screen, and then tap the Setup Cold Staking green button.


	Input the staking public key in the provided field and assign a label to it.


	Tap the Enable Cold Staking green button, then tap the Zap button to complete the staking setup.







Adjust Staking Privacy

For those operating their own staking node, you can improve your staking privacy by leveraging PART’s various privacy protocols. By default, staking rewards are sent to your Public balance, making all staking rewards visible on the blockchain. Particl offers options to modify this for increased financial privacy.


	Public balance: Rewards are transparent and public on the blockchain.


	Blind balance: The amount of PART coins in each reward is confidential.


	Anon balance: Both the number of PART coins and your deposit address remain completely anonymous, offering the highest level of staking privacy available on the Particl network.





	Access your staking node and install the Private Staking script.


cd ~ && git clone https://github.com/GBen1/Private-Coldstaking.git










	
	Navigate to the script’s folder, launch it, and follow the setup instructions.
	cd ~/Private-Coldstaking && ./privatecoldstaking.sh











	Select your desired balance type for receiving staking rewards, and copy the new staking public key provided by the script.


	Confirm that the script is active and properly configured.


./update.sh










	In Particl Desktop, go to the Wallet module’s Overview page and input the public key in the cold staking widget. If cold staking is already enabled, you must disable it first.




To disable the script, use this command:


cd ~/Private-Colstaking && ./uninstall.sh











See also


	Particl Explained - Staking


	Particl Explained - Blockchain Overview


	Particl Explained - Privacy Specifications


	PART Guides - Particl Desktop Wallet


	PART Guides - How to Stake


	PART Guides - Buy and Sell PART










            

          

      

      

    

 


  

    
      
          
            
  
Voting Guide

With Particl Proof-of-Stake, you can vote on various community proposals using your staking power as voting power. When you register your voting preferences during a proposal’s voting period, you’ll cast a vote every time you find a block.

The more blocks you stake within a proposal’s voting period, the more voting power you have.


[image: Particl Marketplace]

Particl Desktop’s community governance section






Note

Prerequisites


	A Particl node actively staking.


	An active internet connection.







PartymanParticl DesktopParticl Qt
Partyman Staking App


	Access your Partyman staking node and enter Partyman’s folder.


cd ~/partyman










	Make sure Partyman is on the latest version.


git pull










	Make sure your Particl Core version is on latest version.


./partyman update










	Still in Partyman’s folder, find what proposal you want to vote for.


./partyman proposal list










	Vote on the proposal by typing the following command.


./partyman proposal vote










	Confirm that you want to vote for a proposal. This will clear all previous voting preferences if you’re already voting on a proposal.


	Enter the ID of the proposal you want to vote for and press Enter.


	Enter the voting option you want to cast your vote for and press Enter.





Particl Desktop


	Open your Particl Desktop client.


	Navigate to the Govern section.


	Check if there is an active proposal being voted on and click on its tile to expand its information.


	Review the detailed proposal by clicking on the VIEW ON CCS WEBSITE button.


	Select the option you want to vote for, and click on Vote.


	Confirm your voting preference in the pop-up window that appears.





Important

Your Particl Desktop wallet will need to remain open for the duration of the voting round. Every time it stakes a block, it will cast a vote in favor of your voting preference.




Particl Qt


	Open your Particl Qt client.


	Find what proposal you want to vote for by visiting the CCS platform [https://ccs.particl.io/]. Note the ID of the proposal and the block numbers.


	Click on the Window tab at the top of the client and then go to Console.


	In the console window, make sure that the wallet with your coins staking is selected in the dropdown menu. If you don’t select the wallet that is staking your coins, your vote will not register. Enter the following command to register your vote.


setvote proposal option height_start height_end





proposal is the ID of the proposal you want to vote for

option is the value of your voting preference (1= Approve, 2= Reject)

height_start is the block number when the voting period starts

height_end is the block number when the voting period ends









Important

Your Particl Desktop wallet will need to remain open for the duration of the voting round. Every time it stakes a block, it will cast a vote in favor of your voting preference.









See also


	Particl Explained - Community Governance


	Particl Explained - DAO and Network Treasury


	Particl Explained - Staking


	PART Guides - Particl Desktop Wallet


	PART Guides - How to Stake


	PART Guides - Buy and Sell PART









            

          

      

      

    

 


  

    
      
          
            
  
Buy and Sell PART

PART  can be bought or sold on a variety of cryptocurrency exchanges and online services.


Cryptocurrency Exchanges

While cryptocurrency exchanges are highly regulated and privately held companies out for a profit, they are the most common way to obtain coins. In some cases, owning Bitcoin or USDT is a prerequisite to purchasing PART.


	MEXC [https://www.mexc.com/exchange/PART_USDT]


	Probit [https://www.probit.com/app/exchange/PART-BTC]


	More… [https://coinmarketcap.com/currencies/particl/markets/]





	Register on the cryptocurrency exchange of choice. As a rule of thumb, always read the terms of service before using an exchange.


	(Optional) If you don’t already own Bitcoin or USDT, trade some for other currencies.


	Trade Bitcoin (BTC) or Tether (USDT) for Particl (PART).


	Withdraw PART to your local wallet’s Public address within the Particl Desktop client. Refer to the Receive Coins user guide for more details.






Non-Custodial Exchanges

Non-custodial exchanges or swap exchanges are online services that let you directly exchange one cryptocurrency for another without intermediary steps and double fees.


	BasicSwap DEX [https://www.basicswapdex.com]


	WizardSwap [https://www.wizardswap.io/?crypto_a=BTC&crypto_b=PART&amount=0.0025]





	Open the swap exchange website.


	Choose the source cryptocurrency to swap from.


	Choose PART as the target cryptocurrency.


	Review the quote offered by the exchange.


	Send your coins to the address provided and wait for the transaction to be completed. This can take several minutes, depending on the exchange and the currency you trade for.


	Receive PART to your local wallet’s Public address within the Particl Desktop client. Refer to the Receive Coins user guide for more details.







See also


	PART Guides - Particl Desktop Wallet


	Particl Academy - Blockchain Specifications


	Particl Academy - Privacy Specifications


	Particl Academy - Staking Guide










            

          

      

      

    

 


  

    
      
          
            
  
The Marketplace Explained

Particl Marketplace is a peer-to-peer online marketplace - like eBay, but without middlemen, restrictions, invasive data mining practices, or even operating fees. It connects you directly with buyers and sellers from all around the world and lets you trade freely, without transaction or subscription fees, and in total privacy. It is Particl’s first-ever privacy-first dApp and one of the only decentralized marketplace for physical goods and services in existence.

This Particl Academy page will explain, in detail, everything you need to know about it.
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What is it?


[image: Particl Marketplace]

Browse Particl Marketplace



Particl Marketplace’s primary advantage compared to all other online marketplaces is that, for the first time in history, two parties who don’t know each other can safely do e-commerce together without any middleman being involved and in complete and total privacy. Moreover, with it, you can bypass central parties such as payment processors, marketplace operators, banks, and legal institutions and only pay the bare minimum in terms of operating costs.


Benefits

Particl’s uniquely decentralized and peer-to-peer (P2P) architecture enables a wide variety of benefits and opportunities not possible on traditional online marketplaces such as eBay, Amazon, Alibaba, Etsy, and the likes.


	Near-zero fees — only pay the bare minimum for the network to run by itself and never pay middleman fees again.


	Total privacy — no data or personal information is ever generated or collected about you. You operate in complete anonymity.


	Secure — trustless encryption provides you with the highest level of digital security for your funds and sensitive information.


	Absolute freedom — censorship-proof e-commerce protocol with no predefined rules or policies and no item or category bans.


	Unstoppable — the network runs by itself across a global network of peers and requires no human intervention or maintenance.


	Borderless — enjoy the benefits and opportunities of an unrestricted, open global market with no financial borders.






Features

The Particl Marketplace offers most of the features you’d expect to see on a traditional online marketplace but does so without the use of third parties. This preserves your privacy and can substantially reduce the total costs involved with doing business online.



For Sellers




	Sell anything — Sell anything without restrictions.


	Open Market — Sell on a global marketplace.


	Markets and storefronts — Create your own personalized marketplace or shop to sell on.


	Inbox — Safely communicate with buyers and potential customers using an end-to-end encrypted messaging system.


	Online escrow — Give customers the confidence they need by securing trades with a two-party online escrow system.


	Private payments — Receive anonymous payments that cannot be reversed (chargebacks) or frozen.


	Product imports — Import your inventory from CSV files or from other platforms such as WooCommerce.








For Buyers




	Buy anything — Buy anything without restrictions.


	Open Market — Buy on a global marketplace.


	Markets and storefronts — Shop from a wide variety of markets or seller shops.


	Inbox — Safely communicate with sellers using an end-to-end encrypted messaging system.


	Online escrow — Trade in full confidence with sellers you don’t know, using a two-party online escrow system.


	Private payments — Send anonymous payments that preserve your financial privacy.






These benefits are only possible thanks to the uniquely decentralized nature of the Particl Marketplace.






Technicals in a Nutshell

This historical feat is made possible thanks to a novel combination of bleeding edge technologies. It allows you to do e-commerce without middlemen, restrictions, or fees. This historical breakthrough in global commerce

Particl Marketplace is a privacy-first decentralized application of the Particl ecosystem. It combines usage of the Particl Blockchain with the SecureMessaging P2P network (SMSG) to enable private payments, communications, security, and privacy capabilities that do not require human intervention or trust in a third-party.


Particl Blockchain

The Particl Blockchain is a decentralized, immutable, and censorship-proof ledger that is privacy-oriented. It is built around the latest version of Bitcoin, but its code has been thoroughly enhanced by Particl contributors to provide a more robust level of privacy and more flexibility for use in decentralized applications like Particl Marketplace.

The Particl Blockchain validates and processes all financial transactions using its native and untraceable digital currency, PART. This disintermediates all transactions on the Particl Marketplace — allowing for truly global and borderless payments — and makes them private by default.


The PART Coin

PART is the native cryptocurrency of the Particl blockchain. It is a privacy coin that, unlike other privacy-focused cryptocurrencies, retains a high level of flexibility and smart contract compatibility. This allows PART to be used in various dApps like Particl Marketplace and grants them advanced privacy capabilities not possible otherwise.

It uses several security, encryption, and privacy protocols that are open-source and can be freely reviewed by anyone. This ensures none of your personal information and data can be collected when transacting on the cryptocurrency. Learn why it matters here.



What does the blockchain do?

The Particl Blockchain and its native privacy coin, PART, process all the financial-related activities of the marketplace’s users.


	Private transactions — it processes transactions that are anonymous without involving any third-party (i.e., a payment processor).


	Online escrow — it enables two participants that do not know each other to protect their transactions using a two-party online escrow system.


	User identity — it provides users with identities that can be used to recognize users and build trust.


	Content moderation — it powers the marketplace’s moderation system by using coin balances as moderation power.




Every component of the Particl Marketplace is open-source, meaning that anyone can inspect the code and contribute to its development.




The SecureMessaging (SMSG protocol)

The SecureMessaging (SMSG) network is Particl’s own custom-built and unique P2P messaging network that stands at the very core of its ecosystem. Inspired by the BitMessage protocol, the SMSG network is a mixnet that acts as a decentralized storage network (DSN). It stores and transfers data across nodes in a privacy-preserving manner, encrypted from end to end (E2EE), and without requiring the use of any central server.

SMSG processes all the non-financial data related to the marketplace — such as listing, order, and marketplace content information — and securely broadcasts it to the rest of the network in a peer-to-peer fashion and using strong end-to-end encryption. This avoids bloating the blockchain with excessive data and leaving permanent records.


What does SMSG do?

SMSG is a key back-end component that makes Particl Marketplace and its groundbreaking benefits possible. It makes possible the following:


	Listing information — it stores and broadcasts listing information to the network.


	Order information — it processes orders and communicates trade data between two participants.


	User communication — it allows two participants to safely and privately communicate.


	Content moderation — it broadcasts the moderation preferences of each user to the rest of the network.










Access Gateways

Access gateways refer to any platform used by the end-user to access and use the Particl Marketplace. It is, in other words, the graphical interface of the application.

Because Particl Marketplace is, at its core, an open e-commerce protocol, it is possible to access and use it with a variety of access gateways.

Gateways, each with pros and cons, may display things differently or provide a different set of features. But because they each connect to the same protocol, all gateways are cross-compatible with each other, meaning users do not need to be using the same gateway to trade with one another.


Particl Desktop

Particl Desktop is Particl’s most popular desktop client. It lets you manage your Particl cryptocurrency wallets, as well as use the marketplace through an easy-to-use and intuitive interface. It is currently the only available access gateway, with others in development.

If you want to buy or sell an item, browse its listings and markets, leave a comment, or just about do anything on the Particl Marketplace, Particl Desktop is what you need.



Pros




	No compromise — Use the marketplace in a completely peer-to-peer manner.


	Desktop access — Access the marketplace locally from your computer.


	Maximum privacy — Trade in complete and total privacy.








Cons




	Slower setup — Particl Desktop’s setup process can take some time and tinkering.


	No web access — The marketplace has to be accessed from a local client and cannot be used from the convenience of a web browser.


	Limited interoperability — More difficult to connect third-party applications and services.










Mobile Application

Although not available currently, a mobile application that lets you access and use the marketplace on the go is in the works. With mobile e-commerce rising steadily, this will massively improve the accessibility of the marketplace and open it up to new markets.



Pros




	On-the-go access — Use the marketplace anywhere, anytime.


	Faster to set up — Get started in just a few seconds thanks to a much quicker setup process.


	New markets — Expands the marketplace’s audience by reaching mobile-dominant markets.








Cons




	Third-party nodes — Third-party nodes slightly reduce the level of decentralization but still preserve your privacy using end-to-end encryption.


	Less resilient — Mobile applications can be taken off app stores. iOS has no .apk alternative.










Web Gateway

Although not available presently, a web gateway that lets you access and use the marketplace from your favorite browser is in the works.

With web applications taking an ever-increasing part of our digital lives, and with the vast majority of e-commerce platforms being available from the web, it is poised to become one of the most appealing access gateways for Particl Marketplace.



Pros




	Universal access — Use the marketplace anywhere using your computer or mobile device.


	Faster to set up — Get started in just a few seconds thanks to a much quicker setup process.


	Easy to use — Using the marketplace from the web is the easiest and most user-friendly way to go about it.








Cons




	Third-party nodes — Third-party nodes slightly reduce the level of decentralization but still preserve your privacy using end-to-end encryption.


	Phishing — By nature, web applications tend to be more prone to successful phishing and social engineering attacks.










Third-Party Integrations

The Particl Marketplace can communicate with outside applications, enabling integrations in third-party products and services like cryptocurrency wallets, payment applications, web plugins (i.e., WooCommerce), etc.

But although this functionality is already available, a comprehensive developer SDK toolkit along with developer-friendly modules are in the works to make the process of integrating the marketplace into third-party applications easier and more straightforward.



Pros




	Use-case improvement — Add functionality and use-cases to your product by integrating the ready-made Particl Marketplace


	Varied access — Access and use the marketplace from other non-Particl applications that you may already use


	All the benefits of web access — Integrating the marketplace into a third-party application can enable all the benefits of web gateways








Cons




	Third-party nodes — Third-party nodes slightly reduce the level of decentralization


	Privacy risks — A third-party may not hold the same privacy ethos as the Particl project and work on collecting data or tracking its users


	Implementation risks — Requires that you trust the third-party and its implementation of the Particl Marketplace.









See also


	Marketplace Guides - Install and Get Started


	Marketplace Guides - Sell Stuff


	Marketplace Guides - Buy Stuff


	Particl Wiki - Open Market Protocol [https://particl.wiki/learn/marketplace/open-market-protocol/]


	Particl Wiki - SecureMessaging [https://particl.wiki/learn/marketplace/smsg/]


	Github - Particl Desktop [https://github.com/particl/particl-desktop]


	Github - Particl Core [https://github.com/particl/particl-core]


	Unofficial Gateway - Particl Store [https://particl.store/]


	Unofficial Gateway - Particl Marketplace Shop [http://particlmarketplace.shop/]


	Marketplace Explained - Two Party Escrow System


	Marketplace Explained - Privacy Specifications











            

          

      

      

    

 


  

    
      
          
            
  
Two-Party Escrow

When buying from or selling to strangers online, you need to be confident that the other party will keep their end of the agreement and not scam you. That’s why contract security and enforcement are essential when trading goods and services in any marketplace.

To guarantee your security in any given marketplace transaction, Particl Marketplace requires you to use its unique and no-cost two-party escrow system.




Table of Contents


	Typical Resolution Centers


	Particl’s Unique Solution


	Benefits


	Considerations






	How it Works


	Understanding the Game Theory Behind


	Blockchains and Game Theory


	Smart contracts and Automation












Typical Resolution Centers

When two parties (a buyer and a seller) transact in a marketplace, a third-party (the escrow agent) usually holds the payment and releases it when the transaction is completed (i.e., the purchased item is delivered). That role is generally assumed by the marketplace itself (i.e., Amazon), a payment processor (i.e., Paypal, Visa), or third-party escrow services (i.e., a bank or a financial institution).

This allows any potential dispute or issue to be settled in the simplest way, but it also has downsides both parties need to be aware of.



High Escrow Fees



No service is ever provided for free. Because there are massive underlying costs to running escrow services, they are provided at a sizable cost. That’s because escrow service providers need to hire staff, deploy secure systems, define and enforce policies, pay for never-ending legal fees, assume fraud risk, etc.

In some cases, marketplaces will clearly indicate the cost of securing a transaction with escrow or resolution services. In other cases, this cost is not independently displayed but instead included in the total transaction fee.





Skewed Resolutions



When an issue arises, it is usually settled following a very rigid set of policies rather than being dealt with on a case-by-case basis. This allows a greater number of issues to be resolved quickly and efficiently, but it also leads to skewed resolutions.

As a logical business standard, marketplaces and payment processors will typically side with buyers instead of sellers because it carries fewer risks of losing business that way.

Online merchants are well aware of this bias and must reduce their exposure to this risk through their prices.





Fraud, Scams, and Abuse



Knowing issue resolution policies tend to be rigid, online scammers have perfected the art of abusing them and tricking escrow systems and agents. Even on very popular platforms like Amazon or Paypal, escrow and return scams are rampant, leading to thousands of dollars being stolen from sellers every day, not counting the environmental impact associated with product return scams.

One of the best examples of an escrow scam is the infamous but prominent “return scam” on eBay. Let’s say you put up an item, typically used, worth $1,000 for sale online. The scammer will buy it from you, pay for the item, and wait to receive it. Once received, he will claim it isn’t as advertised, typically claiming the object is damaged, and request a refund. The refund request requires them to ship back the item in the same package, which is what they do. But instead of putting your item back into the box, they’ll substitute the purchased items with scraps weighing the same as the initial item. This is often enough to trick the automated process used by eBay, granting them the refund and leaving the seller at a loss.





Intrusive Data Requirements



To resolve a dispute, escrow services need to know as much as they can about you and the party you’re transacting with. Of course, all of this information is stored on one or more central databases for further reference and monetization.

This is an obvious case of storing too much data, leading to countless data breaches and leaks every year. The more data a company collects about its users, the bigger the target it becomes for hackers and abusers.





No Privacy at All



When using an escrow service, you and the other party you’re transacting with both need to trust the escrow agent in full. That’s because you are granting that party full access to a lot of sensitive information about you and the right to hold money on your behalf.

The amount of data provided to escrow agents gives them complete oversight of all the personal, professional, and financial data generated by your use of the platform.



Particl’s Open Marketplace solves this problem without the need for a third party.





Particl’s Unique Solution

Particl adopts a radically different escrow model that fixes all of these issues. Dubbed a “two-party escrow system”, it only involves two parties: the buyer and the seller.

Instead of requiring a third-party to hold the payment on behalf of two transacting parties, both participants are required to provide collateral by committing an equal security deposit into a smart contract. This security deposit is automatically refunded to both parties, in its entirety, once both parties mark the transaction as completed.

If any dispute or issue arises, both parties need to mutually agree on a satisfying resolution for both of them to mark the transaction as complete. Because the two parties have a security deposit locked into the escrow smart contract, they are naturally forced to collaborate and reach a reasonable resolution for both. Failure to reach an agreement will keep both security deposits locked until a resolution is agreed upon.


Benefits

Particl’s novel approach to securing online trades comes with many benefits not possible otherwise when using traditional e-commerce platforms and escrow models.



It’s Free (No Fees)



Particl’s two-party escrow system is entirely free to use. There is no additional cost or percentage taken off transactions other than the regular cryptocurrency transaction fee, which is usually just a few cents or sometimes even less than that.





Stay in Control



You and the other party you’re transacting with are in total control of the process. There is no third-party involved in the transaction who can force a resolution against the will of a participant.





Maximum Data Security



Particl’s two-party escrow system doesn’t generate any extra data. If no data is generated first, it can’t be collected by anyone else. The system works autonomously using the power of :term:`smart contract <smart contract>`s and privacy-first blockchain technology.





Complete and Total Privacy



Since two-party escrows don’t require the intervention of a third-party, personal information (i.e., shipping details) is only made available to the other person you’re transacting with. And because of the naturally encrypted nature of Particl’s online escrow system, nobody other than a transaction’s participants can know anything about it.





Considerations



	Each escrow transaction requires an equal security deposit as collateral from both the seller and the buyer


	Security deposits are equal to an agreed-upon percentage of the value of the transaction.


	The PART coin’s price can vary while a payment is locked in escrow. That means you may not end up with the exact same fiat (i.e., USD, EUR, etc.) value that you initially put as a security deposit based on trading activities during that time.












How it Works


[image: Particl Marketplace's phases of a deal]

Using Particl’s two-party escrow system is a step-by-step process that requires a few manual inputs from you. The complete flow of a single transaction, from the moment an order is placed to when the transaction is completed, is as follows.


	ORDER REQUEST: The buyer places an order request and waits for the seller to accept it.


	ACCEPTED: The seller accepts the bid and now waits for the buyer to send their payment and security deposit into the escrow smart contract.


	ESCROW: The buyer sends their payment and security deposit into the escrow smart contract and now waits for the seller to send their security deposit as well.


	PACKAGING: The seller has made their security deposit into the escrow smart contract and is now packaging the order to ship it.


	SHIPPING: The seller has shipped the item as shipped and is now waiting for the buyer to receive and confirm the delivery.


	COMPLETE: The item has been received by the buyer. The item has been inspected, and no issue was found. Therefore, the buyer has marked the transaction as complete. There are no more required actions in this transaction. Both participants have received their security deposits back, and the seller has received the full payment for the purchased item.








Understanding the Game Theory Behind

To understand why Particl’s two-party escrow system is effective, it’s essential to understand the mathematical principles on which it relies. The Particl Marketplace’s escrow system is loosely based on “game theory”.

By definition, game theory simply refers to the study of mathematical models of strategic interaction among rational decision-makers [https://en.wikipedia.org/wiki/Game_theory]. In other words, how can rational decision-making be rewarded and irrational/dishonest behavior be punished simultaneously?

To accomplish that, Particl leverages the Mutually Assured Destruction (MAD) game theory and gives it a financial twist. “MAD” is a military doctrine “based on the theory of deterrence, which stipulates that the threat of using strong weapons against the enemy prevents the enemy’s use of those same weapons. The strategy is a form of Nash equilibrium in which, once armed, neither side has any incentive to initiate a conflict or to disarm” (Wikipedia [https://en.wikipedia.org/wiki/Mutual_assured_destruction]).

Simply put, when two countries are armed with, for example, nuclear weapons, there is no incentive for any of them to attack each other as that would inevitably result in an equally destructive retaliation. This would, ultimately, leave both countries in rumbles and make no winner.


Blockchains and Game Theory

Particl takes that same military doctrine and substitutes weapons of war for financial collateral. When you buy or sell something on the Particl Marketplace, you and the other party you’re transacting with are required to lock an equal security deposit paid in PART coins in a smart contract.

Suppose one of the two parties tries to scam the other or doesn’t act in complete honesty. In that case, the “victim” can retaliate by not authorizing the bad actor’s security deposit release. This makes even just attempting to scam someone a risky business as you might lose your security deposit. In other words, a scammer cannot successfully attack another marketplace user without losing their own financial collateral.

And so, not unlike the military superpowers of this world, Particl uses the proven mathematical models behind MAD game theory to enforce honesty and accountability among its participants.



Smart contracts and Automation

A smart contract is a particular type of blockchain script. It can accomplish tasks and execute transactions autonomously following an immutable set of rules. That’s how Particl’s two-party escrow system is made autonomous and the reason no third-party is involved.

The two-party escrow smart contract is powered by a BIP-65 Bitcoin-style smart contract programmed with a set of rules pre-defined by the mathematical model of the MAD game theory. Whether a security deposit or payment is released depends on whether all the criteria for its release are met, which is that both parties mark the transaction as complete.




See also


	Marketplace Explained - Particl Marketplace Explained


	Marketplace Explained - Privacy Specifications


	PART Guides - Send, Receive and Convert PART


	Marketplace Guides - Install and Get Started











            

          

      

      

    

 


  

    
      
          
            
  
Content Moderation

Like any online marketplace or platform, there needs to be a way for its content to be moderated. As we’ve seen, Particl’s entirely distributed structure means it is unstoppable, uncensorable, and unable to ban users. However, leaving the platform without any sort of moderation mechanism would open up the possibility for an unspeakable number of problems to make their way through.

That’s why Particl contributors have designed a completely decentralized and adjustable moderation system that filters content without discriminating against specific products or users.
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Power and Control to the People

Because Particl is a distributed marketplace, there are no moderation staff, moderators, or accounts with special permissions to keep the marketplace clean from undesirable content. This means that the moderation of the marketplace’s content needs to be done differently than what we typically see on other e-commerce platforms.

Instead of giving moderating powers to a few groups of “trusted” individuals, Particl’s moderation system gives it back to every single user. This is an efficient way to reach a fair and globally agreeable consensus and take personal or geographical biases out of the equation.


Benefits



Provably Fair



Particl’s moderation system is powered by tamper-proof blockchain technology, which makes it provably fair. No party, including a marketplace operator itself, can unilaterally censor users or content. This system represents the closest form of direct democracy possible with today’s technology.





No Censorship nor Bans



Particl’s modular ecosystem is blank and requires direct input from users for products to be voted out. In other words, it cannot and does not enforce any restrictions on products or services being offered, unlocking the full potential of the global free market without interference.





Incurs no Cost



Typically, online marketplaces include the costs of moderating their platform into the sales commission paid by sellers as part of their service fees. That’s they require staff and legal teams. Particl’s moderation system is entirely non-custodial and autonomous, meaning that it runs at no cost to anyone.






How Does it Work?

In comparison, Particl’s moderation system is similar to Reddit’s well-known upvote and downvote system. On Reddit, each thread and post can be upvoted or downvoted by the community. Any Reddit user can cast a vote (an upvote or a downvote) that adds or subtracts a “point”. Once a post reaches a certain negative threshold of points, meaning that a much greater number of people have downvoted the post compared to the number of people who’ve upvoted it, it gets automatically hidden and placed at the bottom of the list.

On Particl, listings and markets are moderated in a similar fashion. A big difference is that instead of counting votes on a “one user equals one point basis”, it does it on a “one coin equals one point basis”. When a listing or market reaches a certain negative threshold of points, meaning that it is generally deemed undesirable, it is hidden from view and becomes inaccessible unless the removal threshold is modified locally by the user or turned off entirely.


Flagging

If you find a listing that you think shouldn’t be on the marketplace, you can flag it for removal. This immediately takes it off your local instance of the marketplace, casts an equal number of downvotes as the number of coins on your public PART balance, and moves it to the Reported Listings page where others can now upvote or downvote it. While you won’t see a listing you’ve flagged on your local copy of the marketplace, it will still show up on others as long as it does not cross the removal threshold.



Upvoting and downvoting

If you navigate to the Reported Listings page, you’ll find all the listings that other people have flagged. You’ll also find any listing you’ve previously flagged that has not yet received enough downvotes to be completely filtered off the marketplace by the moderation system.

It is also where you can cast upvotes and downvotes for listings that other people have flagged. When you cast a vote, it adds or subtracts a number of points equal to the number of PART coins you hold in your public balance.



Adjustable removal threshold

The removal threshold is the agreed-upon point requirement for a listing to remain on the marketplace. When a listing accumulates more downvotes than that threshold, it gets filtered off for everyone using the default values of the moderation system.

However, this threshold is user-adjustable at the local level and can be modified by editing a marketplace configuration file. While doing this doesn’t affect the removal threshold of other people, it allows you to see, on your local version of the marketplace, listings that have received more downvotes than the default removal threshold. In the same way, it also allows you to make your filtering parameters more sensitive and filter off listings even before they reach the default removal threshold.

In other words, it gives you full control over your e-commerce experience while avoiding outright censorship and still providing a decent level of moderation to keep the user experience viable for most people.

At this time, the delisting threshold is currently set at -9,000 PART, which means a listing has to get a moderation score (upvote/downvote ratio) of -9,000 PART to be taken off the Particl network.




Why use coins as voting tickets?

To understand why Particl uses coins to count votes and not the number of users that vote, you have to remember that the protocol never knows anything about any of its users in the first place.

To game the moderation system, it would be very easy to create an infinite number of Particl identities and cast multiple upvotes or downvotes to certain listings. No one would ever know about it, and there’d be no way for Particl to detect this dishonest and fraudulent behavior.

PART coins, on the other hand, are the perfect voting tickets. They can’t be faked, created out of thin air, or duplicated. There is a fixed number of them in circulation, and they grant everyone an equal opportunity to either increase or decrease their total voting power. The more PART coins you hold, the greater your voting power becomes.

This system also prevents outside influence from outside parties by ensuring that only those with real stakes in the network can have a say over its moderation policies.


Game-Theory

Using coins as voting tickets also involves a bit of game theory which solidifies the system. By definition, game theory simply refers to the study of mathematical models of strategic interaction among rational decision-makers [https://en.wikipedia.org/wiki/Game_theory]. In the case of a distributed and open moderation system, it is how people can be forced into behaving rationally.

To understand why that is, we have to keep in mind that a PART coin is a unit of digital currency with a value that fluctuates depending on many factors. This includes the amount of activity on the marketplace, but also its user growth, general appeal to other people, financial market speculation, reputation, etc.

Generally speaking, moderating the marketplace irrationally (i.e., sellers dishonestly flagging each other’s listings or leaving immoral listings on it) directly leads to fewer people using the marketplace. And when fewer people use the marketplace, the PART coin itself can reduce in value, just like the size of the dividend-like staking rewards it pays as well.

For this reason, Particl users are directly and financially incentivized to keep the platform as clean and fairly moderated as possible.




Considerations


	Because there is no way to enforce any predefined bans on a distributed network, you may encounter listings that you don’t like from time to time. It is important that you flag these products if you believe they shouldn’t be on the marketplace.


	For your coins to count as votes, they need to be held in your Public balance. Coins held in your Blind or Anon balance cannot count towards moderation votes.


	If you don’t like how the community moderates the marketplace, you can always tweak your removal threshold for more lenient or sensitive parameters.







See also


	Marketplace Explained - Particl Marketplace Explained


	PART Guides - Send, Receive and Convert PART


	Marketplace Guides - Install and Get Started










            

          

      

      

    

 


  

    
      
          
            
  
Markets and Storefronts

Particl’s marketplace dApp is more than just a single large marketplace; it is a vast network of markets and storefronts created by other users. Each market can be deployed privately or shared publicly with the rest of the network.

This guide will explain in great detail everything you need to know about joining and creating markets on the Particl network.
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What is a “Particl market”?


Note

To simplify the terminology, “markets” and “storefronts” may both be referred to as “markets”.



On Particl Marketplace, you can create your own markets and storefronts or join a wide variety of user-generated ones.

The only difference between a market and a storefront is user permissions. On a market, anyone with access to it can buy or sell anything. On a storefront, only those with seller permissions can.


User Permissions

When it comes to market permissions, there are two key concepts to keep in mind: the access key and the publish key.



	Access Key — Sometimes referred to as “access code”, it lets you join a market or storefront.


	Publish Key — Sometimes referred to as “seller code”, it lets you sell items on a storefront.







When a market is created, anyone that joins it can buy and sell stuff on it.

Storefronts, on the other hand, does not automatically grant seller permissions to everyone that joins. Instead, they require possession of a separate publish key. Only those with access to the storefront AND its seller code are allowed to sell.



Data Encryption

Market-specific data, like listing content and images, is encrypted and stored on the privacy-first SecureMessaging P2P network (SMSG). It is then relayed to other peers of the network without leaking the information to unauthorized parties.

To understand why, it must be understood that a Particl market is, essentially, a combination of public and private keys.

When creating a market, a public key and private key (the access key/code) are generated. By default, the market and its content are encrypted, but possession of the market’s private key (the access code) essentially decrypts its content and gives you access to it.

So while SMSG nodes may relay data from markets they do not have access to, it is impossible for them to determine the content of the data messages they’re circulating.




Market Browser

The Market Browser lets you explore and join markets that have been publicly shared by other users of the network. It also allows you to manually join markets using access and publish keys or create one of your own.

If you see markets or storefronts that you deem undesirable, you can flag them for removal, just like with listings.




See also


	Marketplace Guides - Install and Get Started


	Marketplace Guides - Sell Stuff


	Marketplace Guides - Buy Stuff


	Unofficial Gateway - Particl Store [https://particl.store/]


	Unofficial Gateway - Particl Marketplace Shop [http://particlmarketplace.shop/]


	Marketplace Explained - Content Moderation


	Marketplace Explained - Two Party Escrow System


	Marketplace Explained - Privacy Specifications










            

          

      

      

    

 


  

    
      
          
            
  
Privacy Specifications

Particl Marketplace takes security and privacy very seriously. Its protocol and application are built from the ground up in a way that never creates any useful data about you, your identity, or your assets. When no data exists, it cannot be collected, analyzed, shared, or leaked.

This page dives into some of the critical components of the marketplace and details how they’re designed to preserve your privacy by default.
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	Private Transactions
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Marketplace Content

When you upload content like images online, it often contains sensitive data about you - data like where the picture was taken (geo-location) or what device was used to take the picture. This is a big privacy issue that can lead to catastrophic data leaks, such as unwillingly revealing the GPS location of your home or work environment.

To protect you from this, Particl Marketplace encrypts and strips every image of its metadata before broadcasting it to the rest of the network. This makes it impossible for anyone to collect any useful information about user-uploaded images.



Two-Party Online Escrow System

Usually, when a transaction goes wrong and needs to be resolved by a third-party, marketplaces and payment processors act as the deciding factor by issuing a resolution. They have the final say in who should get the money when a conflict arises. They can also ban users, force refunds, etc.

This puts your data and your online privacy at risk because, while a third-party can protect you from scammers, it also gains full access to all of your information.

To offer the same kind of protection without impeding your online privacy, Particl uses a two-party escrow system that uses autonomous blockchain smart contracts and anonymous cryptocurrency transactions. No entity other than the one you’re transacting with can gain access to your information. No digital footprint is generated.



Secure Messaging

On traditional marketplaces, all your communications with buyers and sellers are stored, monitored, and analyzed by the marketplace itself. This, as you might expect, exposes a great deal of information about you and your business activities. It opens the door wide open for anyone, authorized or not, to collect that information and use it for a variety of reasons, some entirely detrimental to you, such as copying your successful products.

Particl makes sure to put that issue to rest by relying on a completely decentralized messaging network: SecureMessaging (SMSG). It encrypts, end-to-end, all the messages you send to other users and automatically delivers them to the intended recipient. Only the people you’re sending a message to can open and read it. It cannot be intercepted and decrypted by anyone else.



Private Transactions

Sending payments online is usually anything but private. You typically require the use of a payment processor (i.e., Paypal), a bank, or a financial institution. In all cases, it exposes the full details of your transactions and financial data not only to these providers, but also to their partners and other affiliated entities.

That’s why Particl Marketplace forces all transactions between a buyer and a seller to be anonymous by default. Using Anon transactions, the information of the transaction’s participants and the transferred amount are never made public and are encrypted by default. This unique Particl feature ensures that all marketplace trades are anonymous by default without the user requiring to take extra precautions.



Network Connection

To further hide one’s usage of Particl Marketplace, it is possible and, in many cases, recommended, to route its connection through the Tor network.
The Tor network is a free and open-source network that enables anonymous online communication. It protects your digital privacy by anonymizing your IP address. It does so by routing your connection through a vast and global network of volunteers. Tor’s intended use is to protect your personal privacy as well as your freedom and ability to conduct confidential communication.
When enabled on Particl, it makes your node’s IP address entirely anonymous and makes it impossible for an outside party to determine that you’re even using Particl.




See also


	Marketplace Explained - Particl Marketplace Explained


	Particl Explained - Privacy Specifications










            

          

      

      

    

 


  

    
      
          
            
  
Get Started (Install)

Particl Marketplace provides you with the most secure, private, and unrestricted e-commerce experience on the web. This section will teach you how to install and configure it to your liking, as well as how to back up your Marketplace data.
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Install Particl Marketplace

To get started with Particl Marketplace, you need to first download and install the Particl Desktop client.


Download

Choose the correct version to download.


WindowsMacLinux

Windows file version

Download the particl-desktop-X.X.X-win.exe installer file. It supports any version of Windows.

Download sources


	Particl Homepage: https://particl.io/downloads


	Particl Github: https://github.com/particl/particl-desktop/releases/latest








Attention

NEVER download Particl clients from third-party websites! Bad actors are constantly trying to distribute malware-infected versions of popular cryptocurrency wallets to steal your funds! Always download directly from official sources.





MacOS file version

Download the particl-desktop-X.X.X-mac.dmg installer image. It supports any version of MacOS.

Download sources


	Particl Homepage: https://particl.io/downloads


	Particl Github: https://github.com/particl/particl-desktop/releases/latest








Attention

NEVER download Particl clients from third-party websites! Bad actors are constantly trying to distribute malware-infected versions of popular cryptocurrency wallets to steal your funds! Always download directly from official sources.





Linux file version

Depending on your Linux distribution, you can choose between different packages, including Debian-based .deb, .rpm packages, or a distribution-independent .AppImage version.

Once you know which Linux distribution you are running, it is easy to find out which package manager you have,  and which package will suit you. The distribution independent .AppImage will also be of great help.

Download sources





	Particl Homepage: https://particl.io/downloads


	Particl Github: https://github.com/particl/particl-desktop/releases/latest





Attention

NEVER download Particl clients from third-party websites! Bad actors are constantly trying to distribute malware-infected versions of popular cryptocurrency wallets to steal your funds! Always download directly from official sources.








Installation process


WindowsMacLinux
Windows installation


	Verify the checksum of the file.


	Open the downloaded particl-desktop-X.X.X-win.exe installer file.


	Follow the installation instructions.


	An executable file will be added to your desktop and into the application launcher menu. Use this to start Particl Desktop.


	Assign allow-rules to your computer’s firewall and antivirus software. On a standard Windows installation, Microsoft Defender pops up.





Note

Ignoring step 5 may cause a degraded blockchain sync or communications problems with other peers. If you are unsure how to apply rules to your firewall and anti-virus software, please review the vendor’s documentation of your installed programs.




MacOS installation


	Verify the checksum of the file.


	Open the downloaded particl-desktop-X.X.X-mac.dmg installer image by pressing CONTROL + MOUSE-RIGHT ◳ and clicking on Open from the appearing shortcut menu. Do not just double-click the icon.


	Drag and drop the Particl Desktop.app file into the Applications folder.


	Open the Applications folder and locate the Particl Desktop.app file.


	Press CONTROL + MOUSE-RIGHT ◳ on the Particl Desktop.app file and click Open.


	On the first launch, your computer’s firewall must get a rule to allow Particl Desktop to communicate with the blockchain.




From now on, you will be able to start Particl Desktop from the Launchpad or Spotlight (e.g., COMMAND ⌘ + SPACE and type “Particl” > hit ENTER ↵) search.


Note

Ignoring step 6 may cause a degraded blockchain sync or communications problems with other peers. If you are unsure how to apply rules to your firewall and antivirus software, please review the vendor’s documentation of your installed programs.




Linux installation


	Verify the checksum of the file.


	Navigate to where you’ve downloaded your installer file in the terminal.


	Depending on your package manager, this command will vary.


Debian-based installation

sudo apt install particl-desktop-x.x.x-linux.deb








RPM-based installation


sudo dnf -i particl-desktop-x.x.x-linux.rpm





AppImage

chmod a+x particl-desktop-x.x.x-linux.AppImage
./particl-desktop-x.x.x-linux.AppImage










	On the first launch, your computer’s firewall must get a rule to allow Particl Desktop to communicate with the blockchain.




An application launcher will be added to your applications menu when using .deb or .rpm installations. Click it to start the Particl Desktop client.


Note

Ignoring step 4 may cause a degraded blockchain sync or communications problems with other peers. If you are unsure how to apply rules to your firewall and antivirus software, please review the vendor’s documentation of your installed programs.




Tip


If you want to launch it from the terminal, quotation marks may be required because there is a space in the name (Particl Desktop).




user@linux:~> which "Particl Desktop"
/usr/bin/Particl Desktop

user@linux:~> "/usr/bin/Particl Desktop"
(Particl Desktop:16887)










Congratulations! You have installed Particl Marketplace.


Hint

Loading and Syncing Times


Because the Particl Marketplace’s content is hosted on a distributed network for payments and exchange of data, the marketplace may take a few minutes to sync. It may also take a few more minutes to load all marketplace listings fully. Those short wait times are normal in the current state of the marketplace and will get much faster in future updates.

If you open the Market > Browse module, keep an eye on the Refresh button. As soon as a count appears, new listings have arrived. Click on it to refresh the listings display. With very slow connections, the entire syncing process can sometimes take up to an hour.








Checksum verification

Obtain the checksum code from the official download sources for the downloaded file. Each file has its own checksum.

From the official download source, obtain the checksum of the file you’ve just downloaded. Each file has its own checksum, so make sure you select the release you’ve downloaded.

To verify the integrity of the downloaded file — ensuring that it hasn’t been tampered with in any way — validate your file’s hash against the checksum provided in the official download source.


WindowsMacLinux
Checksum verification command with terminal


	Open Windows Explorer.


	Press SHIFT ⇧ + MOUSE-RIGHT ◳ on the Download folder and choose Open command window here or Open power shell here.


	Type the following command into the terminal while changing filename for the real and complete filename of the downloaded file and hit ENTER ↵.


CertUtil -hashfile filename SHA256














Checksum verification command with terminal


Tip

Prerequisite: Head into System Preferences and select Keyboard > Shortcuts > Services. Find New Terminal at Folder in the settings and enable the checkbox.







	Open Finder.


	Press MOUSE-RIGHT ◳ on the Download folder of the file and you’re shown the services > open terminal command to open the terminal at this location.


	Type the following command into the terminal while changing filename for the real filename of the downloaded file.

shasum -a 256 filename










Checksum verification command with terminal


	Open a terminal where you downloaded the file and type the following command by changing filename for the real filename of the downloaded file.

sha256sum filename












Once that is done, compare the checksum output you’ve received in the step above with the checksum provided in the official download sources. The screenshot below shows an example of this checksum highlighted from the GitHub release notes Verification section.


[image: Particl Marketplace installation checksum highlighted image]

Particl Marketplace installation checksum highlighted image



Troubleshooting checksum mismatch

If the output does not match, try downloading the file again. Verify that you did not unzip or rename the file. In some cases, it might be possible that antivirus software may alter files; be sure to have a solution on your own in that case.


Attention

If all attempts fail to have a matching number, do not install Particl Desktop unless you know what you are doing, and reach out to Particl Support for assistance.





Starting Particl Desktop

You have two options: startup with the launcher icon (recommended) or a terminal command.


Startup with Launcher


WindowsMacLinux
Launching Particl Desktop with Launcher


	Open your Start Menu by pressing the WIN ⊞ key.


	Start typing Particl.


	Click on the Particl Desktop launcher icon.





Launching Particl Desktop with Launcher


	Open Spotlight (e.g., COMMAND ⌘ + SPACE).


	Type Particl.


	Click on the Particl Desktop launcher icon.





Launching Particl Desktop with Launcher


	Open your applications menu.


	Click on Particl Desktop launcher icon.









Startup from Terminal

Sometimes it is handy to start Particl Marketplace from the terminal, aka command line. It gives you plenty of output and information about what is happening in the background.


WindowsMacLinux
Launching Particl Desktop from terminal


	Open Windows Explorer.


	Press SHIFT ⇧ + MOUSE-RIGHT ◳ on the Installation folder (e.g., C:/Program Files/Particl) and choose Open command window here or Open power shell here.


	Type the following command into the terminal and hit ENTER ↵.


“Particl Desktop.exe”













Launching Particl Desktop from terminal


	Open Terminal (i.e., COMMAND ⌘ + SPACE and type “terminal” > hit ENTER ↵).


	Type in this command:

/Applications/Particl\ Desktop.app/Contents/MacOS/Particl\ Desktop










Launching Particl Desktop from terminal


	Open a terminal in the folder where you’ve installed Particl Desktop and type the following command.

./Particl\ Desktop
















Backup Account and Data


File locations

After a successful installation of Particl Desktop, the main application has been installed into the standard location of your operating system. When running Particl Desktopfor the first time, it will create user-specific data within your user account. These files include settings, log files, wallets, and the blockchain data itself. We recommend manually backing up that data on a secure device from time to time as a good practice to follow.


WindowsMacLinux
 ## Windows paths

"%UserProfile%\AppData\Roaming\Particl"
"%userprofile%\AppData\Roaming\particl-bot"
"%userprofile%\AppData\Roaming\particl-market"
"%userprofile%\AppData\Roaming\Particl Desktop"






 ## MacOS paths

"~/Library/Application Support/Particl"
"~/Library/Application Support/particl-bot"
"~/Library/Application Support/particl-market"
"~/Library/Application Support/Particl Desktop"






 ## Linux paths

"~/.particl"
"~/.particl-bot"
"~/.particl-market"
"~/.config/particl-desktop"

## Launcher path

"/opt/Particl Desktop/Particl Desktop"









See also

Other sources for useful or more in-depth information:


	Particl Wiki - Backup & Restore wallet [https://particl.wiki/tutorial/security/backup-restore-wallet/]









Install Tor (Network Privacy)


Attention

For security reasons, Tor is the only privacy setting not enabled by default. You can easily enable it by routing your client’s connection through its network.




Danger

Always make sure your Tor node is up-to-date with the latest version. This is a critical requirement that, if not followed, can heavily compromise your online privacy and potentially let other people spy on your online activity.



To make sure you don’t download a compromised version of Tor, always download it from their official website. Additionally, avoid any man-in-the-middle attack [https://en.wikipedia.org/wiki/Man-in-the-middle_attack] by always verifying the encrypted signature attached to the Tor files you download. To do so, follow this tutorial on how to verify Tor signatures [https://support.torproject.org/tbb/how-to-verify-signature/] written by the Tor team itself.

You can run the Tor network using two different methods, after which you can route Particl Desktop through it. Always make sure that, regardless of the installation method you choose, Tor is running the latest version before using it.


Using the Tor browser


	Download the Tor Browser [https://www.torproject.org/download/] and install it on your computer.


	Launch the Tor browser.


	Connect to the Tor network by clicking on Connect or configure your connection parameters by clicking on Configure.


	Once connected, leave the Tor Browser running in the background of your computer.






Using the Tor daemon


WindowsMacLinux

	Download the Tor Browser [https://www.torproject.org/download/] and install it on your computer.


	Open Windows Explorer and navigate to the Tor installation directory (e.g., C:/Program Files/Tor Browser).


	Go into the Tor directory, hold down SHIFT ⇧ and click with MOUSE-RIGHT ◳.


	Open the Open command window here from the menu.


	In the terminal that pops up, type:


tor.exe –service install










	Verify that the Tor service is running, type:


sc query "Tor" | find "RUNNING"















Tip

If you haven’t got Homebrew yet, install it using this terminal command.

 xcode-select --install
ruby -e "$(curl -fsSL https://raw.githubusercontent.com/Homebrew/install/master/install)"
echo "export PATH=/usr/local/bin:/usr/local/sbin:$PATH" >> ~/.profile











	Install the Tor daemon with homebrew by typing:


brew install tor










	Enable Tor as a Brew service by typing:


brew services start tor














	Open a Terminal


	Install the Tor daemon by typing:


sudo apt install tor










	Make sure Tor launches on startup by typing:


sudo systemctl enable tor

















Enable Tor on Particl Desktop

After starting Tor on your computer using either the Tor Browser or a daemon, route your Particl Desktop connection through it. You can do this by either adding a proxy argument to the desktop’s launch command or by changing its settings after launching the application.


Enable Tor by Default From GUI


	Open Particl Desktop and click on Particl Desktop Settings in the bottom left corner.


	Go to Core network connection and enter 127.0.0.1:9150 into the Connect via Proxy field if you are using the Tor Browser OR 127.0.0.1:9050 if you are using the Tor daemon.


	Hit Save changes and restart Particl Desktop.






Enable by Tor Default From Terminal


	Open the configuration file:


nano ~/.particl/particl.conf










	If you are using Tor Browser, add this line to the configuration file:


proxy=127.0.0.1:9150





If you are using Tor daemon, add this line to the configuration file:

proxy=127.0.0.1:9050













Note

From now on, Particl Desktop will always connect to the internet using Tor. If Tor is not running on your machine, then Particl Desktop will not be able to connect to other peers. You can always revert back to the default setting to disable Tor.





Enable Tor Once From Terminal


WindowsMacLinux
Launching Particl With Tor


	Open Windows Explorer, press SHIFT ⇧ + MOUSE-RIGHT ◳ on the installation folder (e.g., C:/Program Files/Particl), and choose Open command window here or Open power shell here.


	If you are using Tor Browser, type the following commands into the terminal and hit ENTER ↵.


“Particl Desktop.exe” -proxy=127.0.0.1:9150





If you are using Tor daemon, type the following commands into the terminal and hit ENTER ↵.

“Particl Desktop.exe” -proxy=127.0.0.1:9050













Launching Particl With Tor


	Open Terminal (e.g., COMMAND ⌘ + SPACE and type “terminal”, then hit ENTER ↵).


	Type in this command if you are using Tor Browser:

/Applications/Particl\ Desktop.app/Contents/MacOS/Particl\ Desktop -proxy=127.0.0.1:9150





Type in this command if you are using Tor daemon:

/Applications/Particl\ Desktop.app/Contents/MacOS/Particl\ Desktop -proxy=127.0.0.1:9050










Launching Particl With Tor


	Open a terminal in the folder where you’ve installed Particl Desktop and type the following command if you are using Tor Browser.

./Particl\ Desktop -proxy=127.0.0.1:9150





Type the following command if you are using Tor daemon.

./Particl\ Desktop -proxy=127.0.0.1:9050














Using Tor as a Hidden Service

On Linux, you can also run Tor as a hidden service and connect your Particl Desktop to it. This allows other people to use your node as an entry or exit point, making the Tor network more decentralized and private for all.


	Open a Terminal and install the Tor network by typing:


sudo apt-get install tor










	Define that you want to use Tor as a hidden service by modifying the Tor config file. To do so, type:


sudo nano /etc/tor/torrc





In the config file, add these two lines:

HiddenServiceDir /var/lib/tor/particl-service/
HiddenServicePort 51738 127.0.0.1:51738





Save and exit the nano file editor by pressing CTRL+c, then type y followed by ENTER ↵ to save the changes.






	Restart Tor by typing into the terminal:


sudo service tor restart










	Find your hidden service’s IP address (.onion) by typing:


sudo cat /var/lib/tor/particl-service/hostname










	Modify your Particl config file to route its connection through your hidden service by typing:


touch ~/.particl/particl.conf && nano ~/.particl/particl.conf





Then add these lines to the file, and don’t forget to set yourexternalip.onion

externalip=[yourexternalip].onion
onion=127.0.0.1:9050
addnode=7vusex6gv5eerqi2.onion
addnode=quf7tm4gk3xn3aee.onion
addnode=46fvsrrq75dx5vq4.onion
addnode=ciikdjtoop7l6p6h.onion
addnode=frlfghlielxq2ncy.onion
addnode=partusq5qad6jd2c.onion
addnode=x6fxdwpq2krxzmr3.onion
addnode=amu2ck7lyw26fiqs.onion
addnode=kfyopkn3shigcneh.onion
onlynet=tor
listen=1
bind=127.0.0.1:51738
maxconnections=30





Save and exit the nano file editor by pressing CTRL + c, then type y followed by ENTER ↵ to save the changes.











Important Considerations


Keep Tor up-to-date

It is critical to manually maintain your Tor node to the latest version. Otherwise, you can heavily compromise your online privacy and security by remaining vulnerable to a wide range of potential attacks on the network.

As the network itself is widely targeted by hackers due to the privacy it provides, unpatched versions of Tor are considered unsafe to use. If exploited, a compromised version of Tor may leak your true identity and even let others spy on your online activity.

Tor constantly pushes important security updates, so make sure to always be on the lookout for them.


WindowsMacLinux
Updating Tor


	Open the Tor Browser.


	Check if the browser prompts you to update to a newer version.





Updating Tor


	Open Terminal (e.g., COMMAND ⌘ + SPACE and type “terminal” > hit ENTER ↵).


	Type this line of code and  hit ENTER ↵.


brew update && brew upgrade













Updating Tor


	Open a Terminal and run the upgrade procedure depending on your package manager.


Example

sudo apt update && sudo apt-upgrade












Depending on your Linux distribution, this command may vary. There are multiple package managers out there, but they all have the same role in this case.







See also


	Marketplace Guides - Install and Get Started


	Marketplace Guides - Sell Stuff


	Marketplace Guides - Buy Stuff


	Particl Wiki - Open Market Protocol [https://particl.wiki/learn/marketplace/open-market-protocol/]


	Particl Wiki - SecureMessaging [https://particl.wiki/learn/marketplace/smsg/]


	Github - Particl Desktop [https://github.com/particl/particl-desktop]


	Github - Particl Core [https://github.com/particl/particl-core]
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How to Sell

Selling products and services on Particl Marketplace gives you more privacy, security, and freedom than on any other online marketplace. It is also entirely free to use, except for a tiny sub-cent cryptocurrency transaction fee, as well as a small anti-spam fee that is then redistributed to the network.

All these benefits are available through Particl Marketplace. And due to its unique decentralized architecture, the process of selling may be slightly different than what you’re used to.

As we’ll see in this user guide, this process isn’t complicated at all. Simply read through it, and you’ll be up to full speed in no time!
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Publish Listings


Attention

To list an item for sale on Particl Marketplace, you need to have PART coins in your Public (default) or Anon balance so that you can pay for listing fees. Funds in your Anon balance are also required to make security deposits into the two-party escrow smart contract.



The first step of selling on Particl is to first put an item up for sale on one of the available markets. There are many ways to create listings on Particl. The right way for you depends on your requirements.





Publish a Single Item



If you only want to list a single item, then simply follow these steps.


	Open Market -> SELL -> Inventory & Products followed by the New button.


	Fill up all the text boxes with your listing information and upload one or more images of the product or service you intend to sell.





	Click on Publish right away tile to select on which market you want to publish your listing and set the correct category for your item.


	Click on the Save and Publish button and choose the duration time of your listing.


	Click on Publish Listing.





Hint

After one (1) blockchain confirmation (approximately 2 minutes), your listing will be live on the desired market(s).



Instead of publishing your listing immediately, you can save its template for later. When creating your listing, instead of clicking on Save and Publish, you can click on the Save button to save your listing template for later.


	Open Market -> SELL -> Inventory & Products, locate your saved listing, and click on its tile to expand its details. Its status will show as Listing unpublished.


	You can still edit the listing by clicking on the  Edit button or publish it by clicking the Publish icon (rocket).


	You can publish your listing in additional markets and storefronts by clicking on the green Clone Product to Market button and selecting which market (and category) you want to add your listing template to.


	Choose the amount of time you want your listing to show up on the additional market and click on Publish Listing.





Hint

After one (1) blockchain confirmation (approximately 2 minutes), your listing will be live on the desired market(s).



You can also publish your listing on multiple markets and storefronts. This option is only available if you already possess publishing permissions on one or more markets.


	Open Market -> SELL -> Inventory & Products, locate the listing you want to publish on multiple markets and click on its tile to expand its details.


	Click on the green Clone Product to Market button and select which market (and category) you want to publish your listing in.


	Choose the amount of time you want your listing to show up on the market and click on Publish Listing.





Hint

After one (1) blockchain confirmation (approximately 2 minutes), your listing will be live on the desired market(s).







Publish Multiple Items at Once



If you are selling multiple items, then you may want to create a CSV inventory file and list all of your products at once. This will save you valuable time as you won’t be required to manually list each item one by one.

Publishing multiple listings at once is separated into two steps: (1) creating listing templates and (2) publishing them.

The first step of the process is to import your inventory into Particl Desktop using a CSV file and create a listing template for each item.


	Open Market -> SELL -> Inventory & Products, followed by a click on the Import button.


	To process your inventory, import your CSV file by clicking on the Choose file button of the IMPORT FROM CSV FILE section and click on the Process CSV import button.


	One listing template per item will be created. Review each template and, if needed, click on their tiles to expand and edit their information.


	Click Import & Save to create your listing templates.





Tip

You can download a .csv template file from the Market -> SELL -> Inventory & Products -> Import section after selecting CSV file as source. Follow the formatting of the template.



The second step of the process is to publish the listing templates you’ve just created.


	Open Market -> SELL -> Inventory & Products followed by a click on the Batch (Re)publish… button.


	Click PUBLISH TO to select in which markets you want to publish your listings.


	Click PUBLISH DURATION to select for how long you want your listings to be available.


	Click their Publish checkboxes or hit Select all in the SELECT… dropdown menu to individually choose the items you want to publish.


	Click on Publish selected products and wait for Particl Desktop to publish your listings. A progress bar at the bottom of the screen indicates the progress.










Sell and Process Orders


Attention

For your Particl Desktop client to receive any bid from buyers, it must be online and unlocked. New orders won’t show up in your Orders or Overview until you unlock your wallet. To do so, click on the padlock icon in the status icons bar at the top right corner.





Accept an Order



When a buyer wants to buy something you’re selling, they’ll first make an order request that you need to accept. Accepting an order indicates to your buyer that you are willing to process his order.


	Open Market -> SELL -> Orders and check the Orders requiring attention checkbox to only see orders that require your attention or filter them by status.


	Look for any new order marked as REQUESTING.


	Click on the order’s tile to expand its details and accept it by clicking on the Accept order request button.








Make the Security Deposit



Once you accept your buyer’s order, they will be required to send their payment as well as a security deposit into a two-party escrow smart contract. After they do so, you will also be required to match that security deposit.


See also

Check out the Two-party Escrow Explained page to know more about it!




	Open Market -> SELL -> Orders and check Orders requiring attention to only see orders that require your attention or filter them by status.


	Look for any order marked as ESCROW. Click on the order’s tile to expand its details and make your security deposit by clicking on the Complete escrow button.


	In the window that appears, you can leave your buyer a note. This is optional. Confirm your security deposit by clicking on the Confirm & Fund.








Package and Ship an Order



After making your security deposit into the two-party online escrow system, you now need to process, package, and ship your customer’s order.


	Package and ship out your item.


	Open Market -> SELL -> Orders and check Orders requiring attention to only see orders that require your attention or filter them by status.


	Look for any order marked as PACKAGING, click on the tile to expand its details, and click on the Mark as shipped button.


	In the window that appears, you can send your buyer a tracking number. This is optional and can be used to send other information as well (i.e., a download link). Confirm the order as shipped by clicking on Yes, order is shipped.








Receive Payment



Once your package is shipped, keep an eye out for your payment. Once your buyer receives their order and marks the transaction as complete, you will receive your security deposit back as well as the full payment for the order at no fee.


	Open Market -> SELL -> Orders and check Orders requiring attention to only see orders that require your attention or filter them by status.


	Check COMPLETED to only see orders that have been completed. Click on the order’s tile to expand its details and see the date and time it was completed.









See also


	FAQ - Selling on Particl


	Marketplace Guides - Install and Get Started


	Marketplace Guides - Buy Stuff


	Github - Particl Desktop [https://github.com/particl/particl-desktop]


	Github - Particl Core [https://github.com/particl/particl-core]


	Unofficial Gateway - Particl Store [https://particl.store/]


	Unofficial Gateway - Particl Marketplace Shop [http://particlmarketplace.shop/]


	Particl Explained - Two Party Escrow System










            

          

      

      

    

 


  

    
      
          
            
  
How to Buy

Buying products and services on Particl Marketplace gives you more privacy, security, and freedom than on any other online marketplace. It is also entirely free to use, except for tiny sub-cent cryptocurrency transaction fees.

All these benefits are available through Particl Marketplace. And due to its unique decentralized architecture, the process of shopping online may be slightly different than what you’re used to.

As we’ll see in this user guide, this process isn’t complicated at all - you’ll be up to speed in no time!
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Purchase an Item


Attention

To purchase an item on Particl Marketplace, you need to have PART coins in your Public (default) or Anon balance.





Place an Order




Attention

Wallet Unlocking

To be able to progress through the steps of the purchasing process, your Particl Desktop client needs to be unlocked. Failure to do so means that you won’t be able to complete the required steps to submit and complete your order. Make sure the padlock icon at the top-right corner of the status bar is unlocked.



To purchase an item on Particl Marketplace, you must first submit an order request to the seller. Keep in mind that, after you do this, you will still need to complete one additional step before your order is properly confirmed!

Add an item to your cart


	Open Market -> BROWSE to find the item you want to purchase and click on it to expand its details.


	Click on the Shipping & Escrow tab within the listing’s details to ensure the item ships to your country and that you have enough PART in your Anon balance. You will find the total number of PART required to send the order request within the Total needed for order column.


	Click on Add to cart.




Submit order request to the seller


	Open Market -> CART to review the content of your cart and enter your shipping information.


	Click the Review & Submit this Order button to review your order’s details, and click the Confirm Order & Submit to send the bid to the seller.


	Your order request has been submitted to the seller. Now we wait for his confirmation.





Hint

Save your shipping information into a user profile. That way, you do not need to rewrite it with every order. To do so, check the Save shipping profile box before moving to the next step and give the profile a name.







Make Security Deposit



Once the seller has confirmed your order, its status will change from REQUESTING to ACCEPTED; it’s time to make your security deposit into the two-party escrow smart contract.


	Await the notification that the seller has accepted your order.


	Open Market -> PURCHASES -> Orders and look for any order marked as ACCEPTED.


	Click on the order’s tile to expand its details and click on Request Escrow.


	You can provide an email address or a phone number to help the seller and shipping provider. This step is optional.


	Confirm your security deposit by clicking on the Confirm & Fund.





Hint

In the Filter section, you can check Orders requiring attention to only see orders that require your attention or filter them by status.




See also

Check out the Two-party Escrow Explained page to know more about it!







Verify Order Status



After locking your security deposit into the two-party escrow contract, you now need to wait for your package to arrive, after which you’ll be required to mark the transaction as complete to receive your security deposit back.

Once the seller marks your order as shipped, he may send you a tracking number through the private Chat function of your specific order.


	Open Market -> PURCHASES -> Orders and find the order you want to monitor. Additional information, like a tracking number or notes, can be seen by clicking on the order’s tile.








Finalize Order and Get Security Deposit Back



After receiving your order, it’s crucial to finalize the transaction on Particl Marketplace. That is how you get back your security deposit, and release the payment to the seller.


	Wait for your package to arrive.


	Open Market -> PURCHASES -> Orders.


	Click on the order’s tile to expand its details, and click on the Mark as delivered button to complete the transaction and receive your security deposit back instantly.





Attention

It is crucial to return to Particl Desktop once you receive your order and mark it as complete. Without it, you won’t recover your security deposit.




Hint

In the Filter by status section, you can check SHIPPING to only see orders that have been shipped by sellers but haven’t arrived your way yet.







Contact a Seller



Resolve Order Issues



If you encounter an issue during your order or want to contact your seller, you can use the marketplace’s dedicated messaging system. Messages are sent through the SecureMessaging P2P network (SMSG). All direct messages are end-to-end encrypted and anonymous by default.


	Open Market -> PURCHASES -> Orders and find the order you have an issue with.


	Open up the order’s chat function and send a message to the seller.








Ask a Question Before Buying



Each listing has a public chat section where you can leave questions for the seller to respond to. Questions and answers published in the chat section of listings are public and visible to everyone else.


Attention

Do not include any personal information in the public chat of a listing. What you write here is visible to everyone on the network.




	Open Market -> BROWSE and click on the listing you have a question about to open up its modal.


	Click on the CHAT tab to open up the listing’s public chat section.


	Accept Particl Desktop’s warning message — do NOT type any sensitive information in the public chat.


	Type your question and click Send button.









See also


	FAQ - Buying on Particl


	Marketplace Guides - Install and Get Started


	Marketplace Guides - Sell Stuff


	Github - Particl Desktop [https://github.com/particl/particl-desktop]


	Github - Particl Core [https://github.com/particl/particl-core]


	Unofficial Gateway - Particl Store [https://particl.store/]


	Unofficial Gateway - Particl Marketplace Shop [http://particlmarketplace.shop/]


	Particl Explained - Two Party Escrow System










            

          

      

      

    

 


  

    
      
          
            
  
Create and Join Markets

On Particl Marketplace, you can create your own markets and storefronts or join a wide variety of user-generated ones.

The only difference between a market and a storefront is user permissions. On a market, anyone with access to it can buy or sell anything. On a storefront, only those in possession of a publish key can sell. Others with access to the storefront but not its publish key can only purchase items.


Note

To simplify the terminology, “markets” and “storefronts” may both be referred to as “markets”.



There’s no limit to how many markets you can join or create, and each of them can host an equally-unlimited number of listings.



Create a Market



You can easily create a new market by following these simple instructions.


	Open Market -> MANAGE MARKETS -> Your Markets and click on the Create new Market button to start the market creation process.


	Enter a title, a short description, and an image representing your market, and then choose the region it targets (can be worldwide).


	Select the Community Market or Storefront option depending on your permission preferences.


	Click on Confirm & Create Market to review the information about your market.




Your market is now created. You can promote it to the Market Browser to enable public access or keep its Access Key private. In the latter case, only those in possession of the market’s Access Key will have access to it or even know the market exists in the first place. Its content will be encrypted and indecipherable to everyone else.


Attention

Anyone in possession of the Access Key of your market will be able to join and sell. If you’ve created a storefront instead, they will require an additional publish key to sell, which you may or may not want to share with others.



Publish Listings

To publish listings to your new community market, go through the normal product listing process and choose your community market when ready to publish your item(s).





Promote a Market



By default, a community market isn’t publicly visible and is only known to its creator and those in possession of its Access Key. However, a market can be published publicly within Particl Desktop’s Market Browser.


	Open Market -> MANAGE MARKETS -> Your Markets.


	Click on the tile of the market you want to promote and open the market promotion window by clicking on the Promote in Market Browser icon at the bottom of the expanded tile.


	Select the number of days you want to promote your market on the Market Browser and confirm with a click on Promote Market.








Browse Markets



You can browse through all the markets promoted by the community and join those that interest you by navigating the Market Browser.


	Open Market -> MANAGE MARKETS -> Browser.


	Browse the publicly listed markets and find one that interests you.


	Click on its tile to expand its options, and click on Join this Market to connect to it.





Hint


	Open Market -> MANAGE MARKETS -> Your Markets to see all the markets you have joined.


	You can browse the market’s listings by going to Market -> BROWSE and selecting the community market in the FILTER section.










Manually Join a Market



If you are in possession of the Market ID and Access/Publish keys of a particular market, you can directly join it even if it’s not promoted in the Market Browser. If you only possess the Access Key of a storefront, you will only be able to buy items. If you also possess its Publish Key, then you’ll be able to sell items as well.


	First, make sure you possess the Market ID and Access Key of the market/storefront you want to join. You may need to collect this information from private sources if its creator or users do not publicly broadcast them.


	Open Market -> MANAGE MARKETS -> Browser and click on the Join via Market ID button to expand the window to join a new market.


	Fill in the community market’s information. You can decide to enter the information that feels the most helpful and relevant to you.


	Enter the community market’s Market ID and Access/Publish Key, and then click on the Join this Market button to join the community market.





Hint


	Open Market -> MANAGE MARKETS -> Your Markets to see all the markets you have joined.


	You can browse the market’s listings by Market -> BROWSE and select the community market in the FILTER section.










Flag Markets



Just like with undesirable listings, you can flag an entire market if you see  content that you deem appropriate. If enough people downvote the market with you, it will be filtered off by Particl Marketplace’s moderation system. To learn more about the Particl Marketplace moderation mechanism, read Market Moderation Explained.


	Open Market -> MANAGE MARKETS -> Your Markets.


	Click on the tile of the community market you want to flag to expand its options.


	Click on Report Inappropriate Market to open the Flagging window and click on the Flag this market button to flag it.





Hint

The total number of coins you hold in your Public balance will now be used as downvotes for this community market. If the market’s moderation score goes below the remove threshold of -9,000 PART, it will be taken off the Particl Network.







Vote to Keep a Market



Sometimes, other users may flag markets that you believe should remain on Particl. In those cases, you need to make your voice heard by upvoting the market, essentially countering the downvotes. To learn more about the Particl Marketplace moderation mechanism, read Market Moderation Explained.


	Open Market -> MANAGE MARKETS -> Your Markets.


	Click on the tile of the flagged market you believe should remain on Particl. Flagged markets will have their flag icon highlighted in red instead of black.


	In the window that appears, click on the Keep Market green button to confirm that you believe this market shouldn’t be moderated out.





Hint

The number of coins you hold in your Public balance will now be used as upvotes for this community market. As long as the market’s overall moderation score doesn’t go below the removal threshold of -9,000 PART, the market will remain on the Particl Network.








See also


	Marketplace Guides - Sell Stuff


	Marketplace Guides - Buy Stuff


	Marketplace Explained - Markets and Storefronts


	Marketplace Explained - Content Moderation


	Marketplace Explained - Two Party Escrow System









            

          

      

      

    

 


  

    
      
          
            
  
BasicSwap Explained

BasicSwap is a cross-chain and privacy-centric DEX (decentralized exchange) that lets you trade cryptocurrencies without middleman interference. Its distributed ledger technology enables users to place or accept orders without fees, promoting a free and open trading environment devoid of central points of failure.

Developed as a countermeasure to the intrusive data collection and demands prevalent in modern cryptocurrency exchanges and third-party services, BasicSwap aims to restore sovereignty and privacy to cryptocurrency trading for users worldwide.
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What is it?


[image: BasicSwap's order book — WIP, design subject to change]

BasicSwap’s order book — WIP/Beta, UI/UX subject to change



The BasicSwap decentralized exchange (DEX) is designed for ease of use and clarity in operation, but its underlying protocol is rather intricate and sophisticated.

It incorporates several distributed and open-source technologies, including atomic swaps, scriptless scripts, adaptor signatures, and the SMSG network to function independently without the need for centralized servers, databases, or administrative staff. Instead, it is developed, upheld, and operated by an extensive, decentralized community of open-source contributors and participants.


Benefits

BasicSwap distinguishes itself from conventional exchanges, often known as “centralized exchanges” or “CEX,” through its decentralized framework which offers several key advantages:


	No trading fees — Trading fees are a thing of the past.


	Total privacy — Your data and personal information remain confidential.


	Secure — A non-custodial model ensures unparalleled security for your assets.


	No KYC or account — Account creation or KYC documentation is not required.


	Complete freedom — No bans, geographical restrictions, or asset confiscations.


	Unstoppable — It is immune to censorship or shutdown.


	Autonomous — Operates independently without human intervention.




These benefits stem directly from the inherently decentralized nature of the BasicSwap protocol and aren’t possible on centralized infrastructure.



Features

Currently in beta, BasicSwap already supports essential trading functionalities typical of centralized exchanges, with ongoing developments to introduce additional features.


	True cross-chain support — Swap cryptocurrencies across different blockchains, like Bitcoin and Monero.


	Distributed order book — Place or accept limit orders through a fully distributed order book.


	No third-party or middleman — Offers direct crypto trades without intermediaries.


	No trading fees — You are only subject to standard cryptocurrency network fees, eliminating any other additional trading costs.


	Privacy from the ground up — Designed with a privacy-first approach in all components.


	Full Monero support — Provides direct swaps between Monero and other cryptocurrencies, such as Bitcoin, Litecoin, or Particl, without relying on wrapped assets or convoluted L2 layers.


	User-friendly interface — Features a straightforward and intuitive interface, simplifying complex processes for the user.







Compatible Coins


[image: BasicSwap's wallets page — WIP, design subject to change]

BasicSwap’s wallets page — WIP/Beta, UI/UX subject to change



BasicSwap provides decentralized trading services for a selection of cryptocurrencies. (check out the full list on BasicSwap website [https://basicswapdex.com/markets]).



	Coin Name

	Ticker



	Bitcoin

	BTC



	Monero

	XMR



	Dash

	DASH



	Litecoin

	LTC



	Firo

	FIRO



	PIVX

	PIVX



	Particl

	PART






Plans are underway to expand the list of available assets such as ETH and its ERC-20 tokens. Cryptocurrencies based on Bitcoin and enabled for Segwit can be seamlessly integrated with minimal effort, and token-issuing blockchains like Fantom, Solana, Avalanche, Polygon, or BSC might be incorporated into BasicSwap during later phases of our integration roadmap.



Access Gateways

Access gateways are the platforms through which end-users access and interact with BasicSwap, essentially serving as the application’s graphical interface.

Given that BasicSwap is fundamentally an open DEX protocol, it can support access and usability across a diverse array of gateways.

These gateways, each with its unique advantages and limitations, may vary in presentation or feature set. However, since all gateways connect to the same underlying protocol, they are interoperable, sharing identical order books and liquidity pools. This ensures that traders can transact with each other regardless of the specific gateway they choose to use.



BasicSwap Desktop



BasicSwap Desktop is the primary access point for the BasicSwap open beta, with plans to introduce additional gateways. It facilitates management of multiple non-custodial cryptocurrency wallets and enables direct trading without third-party involvement.

Pros:


	No compromise — Operate on BasicSwap devoid of any centralized service.


	Desktop access — Directly engage with the DEX from your personal computer.


	Maximum privacy — Easily achieve complete privacy during trades.




Cons:


	Slower setup — Manual compilation is required for the local client, making the initial setup potentially complex.


	No web access — Trades must be conducted via a local client, lacking the convenience of web browser access.


	Continuous online presence — To maintain your offers on the order book and fulfill trades, your BasicSwap node must stay connected.


	Storage demands — Enabling certain coins requires downloading and storing their full blockchain nodes, which can consume significant disk space.








Web Gateway



A web gateway, which is not yet available, is planned to be released to allow DEX access via web browsers. This initiative aims to leverage the ubiquity of web applications in our digital routines and the commonality of web-based exchange platforms, positioning BasicSwap’s web gateway as a highly convenient but still secure option for trading.

Pros:


	Universal access — Engage with BasicSwap on any device with internet access.


	Quick setup — Begin trading in moments, thanks to a streamlined setup process that eliminates the need to maintain full blockchain nodes on your device.


	User-friendly — The web offers the most straightforward trading experience.




Cons:


	Dependence on third-party nodes — Utilizing third-party nodes slightly diminishes decentralization but maintains privacy and security through end-to-end encryption and non-custodial practices.


	Increased phishing risk — Web platforms are inherently more susceptible to phishing, cloning, and social engineering schemes.








Third-Party Integrations



BasicSwap is planned to support integrations with external applications, such as cryptocurrency wallets, payment services, and web plugins, in a bid to broaden the ecosystem and bring its benefits to as many people as possible. Further development of a comprehensive SDK and user-friendly modules is still required to allow for this.

Pros:


	Enhanced functionality — Add coin swapping functionality to your products by incorporating BasicSwap DEX capabilities.


	Diverse access points — Utilize BasicSwap through familiar third-party applications, like a cryptocurrency wallet for example.


	Web and mobile gateways — Third-party app integration can offer the conveniences of web or mobile gateways.




Cons:


	Reduced decentralization — Reliance on third-party nodes can slightly impact the network’s decentralized nature.


	Potential privacy concerns — Third-party applications may not adhere strictly to Particl’s privacy principles, posing risks of data collection or user tracking.


	Dependence on third-party integrity — Trust in the third-party’s implementation is essential, introducing potential risks.


	Introduction of custodianship — Some third-parties may offer a custodial solution, meaning that you may not fully own your privacy keys.









See also


	Blog Post - BasicSwap The Fully Private Cross Chain DEX [https://particl.news/basicswap-the-fully-private-cross-chain-dex/]


	Github - BasicSwap [https://github.com/tecnovert/basicswap]


	BasicSwap Explained - DEX Comparison


	BasicSwap Explained - Under the Hood


	BasicSwap Guides - Install and Get Started


	BasicSwap Guides - How to Use


	BasicSwap Guides - Add or Remove a Coin


	BasicSwap Guides - Apply for Coin Listing










            

          

      

      

    

 


  

    
      
          
            
  
Under the Hood

BasicSwap is a cross-chain and privacy-centric DEX (decentralized exchange) that lets you trade cryptocurrencies without middleman interference.

Its user-friendly interface allows users to easily benefit from its groundbreaking benefits, but what makes them possible in the first place is rather complex and intricate.

This page will break down, in detail, the key technical components that live under the hood and make BasicSwap the unique DEX that it is.
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Similarly to the Particl Marketplace, BasicSwap relies on an intricate combination of distributed technologies developed, maintained, and run by a vast and global network of participants.


Key Components

Three key technologies make BasicSwap the powerhouse that it is: the SecureMessaging (SMSG) protocol, scriptless scripts technology, and the more widely-known ‘atomic swaps’ protocol.


Atomic Swaps

Atomic swaps have been around for quite some time and are an important part of many DEX platforms currently available. They allow for swapping digital assets between two users in a peer-to-peer fashion, assuming that the logistical requirements behind executing such a swap exist.

The atomic swap technology is, in and of itself, a relatively narrow-scoped protocol; it does not match orders between two users or provide any DEX framework. Instead, it just safely swaps assets and does so very securely.


See also


	Atomic Swaps Explained - Bitcoin Wiki [https://en.bitcoinwiki.org/wiki/Atomic_Swap]


	Atomic Swap Protocol - Decred-style [https://github.com/decred/atomicswap]


	Atomic Swap Protocol - Monero-style [https://eprint.iacr.org/2020/1126.pdf]






That’s why it needs to be complemented by a common and decentralized channel in which the information related to a swap is transferred between two parties — often across two entirely different chains. Without this added layer, it is impossible for a chain to know when to release the swap in question because it isn’t directly connected to the other blockchain.

In the case of BasicSwap and the wider Particl ecosystem, that is where the distributed SecureMessaging (SMSG) network comes into play.



SecureMessaging (SMSG)

SecureMessaging (SMSG) is Particl’s own custom-built and unique P2P messaging network that stands at the very core of its ecosystem. Inspired by the BitMessage protocol, the SMSG network is a mixnet that acts as a decentralized storage network (DSN). It stores and transfers data across nodes in a privacy-preserving manner, encrypted from end to end (E2EE), and without requiring the use of any central server.

This decentralized technology is essential in providing the BasicSwap DEX with functionality that atomic swaps alone cannot, such as an order book and order matching system, transferring swap data between two different blockchains, etc.

When running a BasicSwap client, you are also automatically running an SMSG node along with it.
DEX and swap-related data are transferred between users through the SMSG network. BasicSwap nodes then receive this data and let other users interact with it using scriptless scripts. This creates an all-in-one DEX that works entirely without third-parties and in total privacy.


See also


	Particl Wiki - SecureMessaging P2P Network [https://particl.wiki/learn/marketplace/smsg/]








Scriptless Scripts

Whereas typical DEX platforms use traditional smart contracts, some cryptocurrencies like Monero are not compatible with them. BasicSwap uses scriptless scripts in these scenarios.
Scriptless scripts are an off-chain form of smart contract that provides more privacy and scalability than their on-chain counterparts. On BasicSwap, they are used to safely spend Monero coin outputs collaboratively and without third-party involvement.

Indeed, when swapping assets on BasicSwap, the participants’ coins are sent to a scriptless chain and into an address created from the sum of their private keys.

The only way to spend that output requires participants to cooperate through One-Time Verifiably Encrypted Signatures (OtVES). OtVES allows for the safe and trustless exchange of digital signatures without requiring a trusted party to serve as an adjucator. The one-time property of OTVES ensures both participants can get the decryption key they need to process through the process of swapping their coins.


See also


	Whitepaper - OtVES Signatures [https://raw.githubusercontent.com/LLFourn/one-time-VES/master/main.pdf]









Other Notable Protocols


Tor Network

The Tor network is a free and open-source network that enables anonymous online communication. It protects your digital privacy by anonymizing your IP address. It does so by routing your connection through a vast and global network of volunteers. Tor’s intended use is to protect your personal privacy as well as your freedom and ability to conduct confidential communication.

When enabled on BasicSwap, it makes your node’s IP address entirely anonymous and makes it impossible for an outside party to determine that you’re even using the DEX.


Note


	BasicSwap Guides - Enable Tor








Taproot Forward Compatibility

Taproot is a new protocol improvement enabled on Particl that adds the ability to script more advanced logic and condition-based requirements into Bitcoin-style scripts, allowing for more advanced smart contracts to happen on the Particl Blockchain.

When combined with scriptless scripts and the SMSG network, it makes possible complex privacy-first dApps (i.e., BasicSwap) that carry a much lesser degree of risk compared to complex turing-complete smart contracts.

Additionally, Taproot’s off-chain nature, as well as its ability to aggregate multiple signatures, keys, and scripts significantly improves the level of privacy of the blockchain’s smart contracts and dApps by transforming complex condition-based transactions into standard-looking transactions. This preserves the fungibility and financial information of coins transferred through Particl smart contracts and dApps.

At the time of this writing, Taproot isn’t yet added to BasicSwap but is expected to make its way onto it at some point during the open beta as the DEX is forward-compatible with it. This will make swaps on BasicSwap indistinguishable from standard blockchain transactions, significantly improving the privacy of its users.




See also


	Blog Post - BasicSwap The Fully Private Cross Chain DEX [https://particl.news/basicswap-the-fully-private-cross-chain-dex/]


	Github - BasicSwap [https://github.com/tecnovert/basicswap]


	BasicSwap Explained - BasicSwap Explained


	BasicSwap Explained - DEX Comparison


	BasicSwap Guides - How to Use











            

          

      

      

    

 


  

    
      
          
            
  
DEX Comparison

BasicSwap is not the first DEX to see the day, but it certainly holds a unique position for itself, notably in relation to its strong commitments to privacy, security, and an uncompromising level of decentralization. Let’s take a look at how it compares to other popular DEXs available today.




[image: DEX Comparison]

Comparison of the most popular DEXs (26-06-2022)



To get a better idea of how BasicSwap DEX compares to other cryptocurrency trading exchanges, you can first take a look at the following comparison chart.



Order Books



An order book is an aggregated and public list of offers put by other traders. It is possible to either place an offer on the books, at the desired price, or take one already listed by another trader.

Typically, order books require a central database to host the data. It is also often used to determine trading fees, with a different fee model being proposed for “makers” and “takers”.

Because BasicSwap is entirely decentralized, its order book is powered by the open-source SMSG network, as opposed to databases, and charges no fee at all.





No KYC



KYC is used here as an umbrella term referring to any user verification or document requirement from exchanges. This usually includes an ID such as a driving license or a passport, a proof of address, and a face picture with the accompanying documentation in hand. Certain exchanges will ask for more information and may do so often, significantly increasing the risks of data leaks and identity thefts.

BasicSwap doesn’t require any of that. In fact, it doesn’t even require an email address or to register an account to get started. It is a completely decentralized trading platform that is open to all without restriction or discrimination.





Financial Privacy



When you trade cryptocurrencies on an exchange, all of your financial data and activities are logged by the exchange operator and may be analyzed, shared with unauthorized parties, sold, or even leaked.
Additionally, depositing coins on an exchange reveals your wallet address, allowing that exchange to track and analyze all your previous transactions, as well as your current holdings, and share that information with their partners.

On BasicSwap, privacy isn’t an afterthought. It’s built at the core of the DEX from the ground up. As such, depositing coins on your BasicSwap address won’t leak your financial information to a central authority. In fact, it is possible to trade on BasicSwap in full anonymity, with more privacy-boosting features coming during the DEX’s open beta phase.





No Fees



Trading fees are a highly inconvenient fact one has to deal with when trading cryptocurrencies. They make trading often costly and eats on profits. At times, exchanges will have different fees for makers than for takers.

That’s not the case with BasicSwap. The DEX is offered for free; the only fee you need to pay when swapping is the usual cryptocurrency transaction fee of the coin you’re swapping against; a small price to pay for true cross-chain swaps, especially compared to the large trading fees one has to pay if trading on other exchanges (including the vast majority of decentralized ones).





Monero Support



Monero is dubbed the king of privacy coins, and it’s certainly the one with the largest level of adoption. As such, its users are often persecuted or hit with invasive “source of funds” or KYC requests. The coin also itself tends to be delisted from more and more exchanges.

BasicSwap offers a permanent and easy-to-use solution to that problem by allowing Monero to be swapped against a large number of cryptocurrencies, including Bitcoin.

And because of its decentralized nature, traders can rest easy knowing they will never be hit with any source of funds request, invasive KYC, have their accounts frozen, or wake up one day with Monero delisted from the exchange.

Monero’s very rigid codebase typically makes it impossible for the coin to be listed on decentralized exchanges without some form of asset wrapping. But thanks to BasicSwap’s revolutionary back-end protocol and Monero’s atomic swap protocol, swapping XMR in a completely decentralized fashion is now a reality.





Non-Custodianship



“Not your keys, not your coins”. You’ve probably heard this often already, but it’s a major tenet of cryptocurrencies. When you deposit coins on an exchange, you essentially lose full access to their private keys, granting custodianship to a central party that may then freeze your account, prevent you from accessing your coins, or even lose them through a not-so-uncommon exchange hack.

BasicSwap flips the script by allowing you to remain in full control, at all times, of your private keys. Here, there is no third-party custodian; you are the full owner of your coins at every step of the way.
Even when trading, BasicSwap uses a combination of the SMSG network, atomic swaps, and scriptless scripts instead of a central custodian to swap cryptocurrencies.





Fiat or Stablecoin Support



Being able to trade cryptocurrencies against more stable forms of currencies is a vital capability of exchanges. That’s because traders may want to hedge against the often-wild fluctuations of cryptocurrencies and, eventually, withdraw the fiat equivalent of their holdings.

Unfortunately, BasicSwap does not currently support any stablecoin. It is, however, planned for later during the open beta as it is a vital feature of any exchange.





Accessibility



Availability or accessibility refers to how one interacts with an exchange. With most traditional exchanges, they can simply be accessed through the web by navigating to their URL. Some exchanges also offer mobile platforms.

BasicSwap, on the other hand, is currently only available through a local desktop client that has to be run on a computer. This offers the maximum level of privacy and security for your funds but is less accessible and convenient to most people.

As such, BasicSwap will be made available through the web at a later stage during the open beta.





Set up Process



Traditional exchanges have their share of challenges when first setting up an account. They typically require an account to be created, an identity and an address to be verified, etc. However, most traders have grown accustomed to these practices.

BasicSwap, like most other DEX, requires a bit more involved process in setting things up. In the case of BasicSwap, a full node of all enabled coins must be synced locally and the local client has to be manually built up in the first place. This makes for a longer and, in some cases, more complicated setup process.

To improve the platform’s level of adoption, BasicSwap’s setup process is planned to be majorly simplified and sped up as we progress through its open beta phase. Notably, the web versions planned for it will use some kind of light services, essentially skipping any syncing and building requirements.



As this comparison table shows, each exchange, centralized or decentralized, has its pros and cons and caters to a niche and use case of its own.

While BasicSwap DEX may be at an earlier stage of development compared to others, it may carry some downsides but makes up for them with its incredible level of financial privacy. With sufficient development time, these downsides are fully expected to be dealt with appropriately.




See also


	Blog Post - BasicSwap The Fully Private Cross Chain DEX [https://particl.news/basicswap-the-fully-private-cross-chain-dex/]


	Github - BasicSwap [https://github.com/tecnovert/basicswap]


	BasicSwap Explained - DEX Comparison


	BasicSwap Explained - Under the Hood


	BasicSwap Guides - Install and Get Started


	BasicSwap Guides - How to Use


	BasicSwap Guides - Add or Remove a Coin


	BasicSwap Guides - Apply for Coin Listing









            

          

      

      

    

 


  

    
      
          
            
  
Get Started (Install)

BasicSwap DEX is a cross-chain and privacy-first decentralized exchange (DEX) enabling direct cryptocurrency trades without intermediaries, restrictions, or fees. This guide provides comprehensive instructions for installing and configuring it according to your needs.




Table of Contents


	Automated Installation Methods


	Windows Installation Wizard (.exe)


	Linux Installation Scripts Suite






	Install Using Docker


	Install Docker


	Create the Docker Image


	Configure the Docker Image


	Start BasicSwap






	Install Without Docker


	Build BasicSwap


	Configure BasicSwap


	Start BasicSwap












Tip

To significantly improve your network privacy (e.g., masking your IP address and location), consider running BasicSwap via the Tor network. For step-by-step guidance, refer to the BasicSwap Tor Guide.




Attention

During the installation of a full BasicSwap node, closely monitor the terminal’s output. It’s crucial to ensure there are no error messages at any step. Errors must be addressed immediately; failure to do so may prevent BasicSwap from launching successfully.




Automated Installation Methods


Windows Installation Wizard (.exe)

Install BasicSwap on Windows effortlessly with a graphical installation wizard by downloading the .exe installer from this Github link [https://github.com/gerlofvanek/basicswap-installation-GUI/releases]. This intuitive installer streamlines the setup process via an easy-to-navigate menu. Note that you must run it as an administrator for it to work properly.



Linux Installation Scripts Suite

For Linux users, the simplest installation method is through the use of community-developed scripts, available here on Github [https://github.com/nahuhh/basicswap-bash/releases]. This collection of scripts automates common setup tasks, including installing, adding/removing/updating coin cores, updating BasicSwap, and enabling Tor.




Install Using Docker

As BasicSwap is currently in early beta, it lacks ready-made executables or in-app integrations (such as Particl Desktop, web gateways, or third-party services). Thus, the initial step involves compiling and running a full BasicSwap node on your device.


Install Docker

Docker offers a straightforward method for setting up BasicSwap without one of the automated solutions. Please note, this installation method does not support OSX. If you are using a Mac, refer to the subsequent section for alternative setup instructions.


WindowsLinux
Install the Docker engine on your device



	Begin by completing the prerequisites listed on the Docker Desktop WSL 2 backend page [https://docs.docker.com/desktop/windows/wsl/]. This involves activating the WSL2 feature on Windows.


	Proceed to download Docker Desktop for Windows [https://docs.docker.com/desktop/windows/wsl/].


	Follow the detailed installation guide for Docker with WSL 2 on the Docker Desktop WSL 2 backend page.





Note

Be aware that certain versions of Docker might not be fully compatible with Windows 11. Should issues arise, trying an earlier version of Docker could be beneficial.




Note

You may need to adjust BIOS settings, such as enabling hardware-assisted virtualization, to ensure Docker runs smoothly. Please adhere to any guidance provided during the setup process if that’s the case.







Install the Docker engine on your device


	Install the required dependencies.


apt-get install curl jq git










	Check if Docker is already installed on your system.


docker -v





If you see a message indicating Docker version (…), Docker is already installed and you can move on to the next steps without reinstalling it.






	Install Docker by following the instructions on their website [https://docs.docker.com/engine/install/#server].


	Configuring Docker to run without sudo is recommended, as outlined in this guide [https://docs.docker.com/engine/install/linux-postinstall/]. Without this setup, you’ll need to include sudo before every docker-compose command.









Create the Docker Image

Create BasicSwap’s docker image, which you’ll need to run whenever you want to launch the DEX.


WindowsLinux

	Open a WSL (Linux) terminal.


Windows + R > “wsl” -> ENTER.






	Install Git.


sudo apt update
sudo apt install git jq curl










	Download the BasicSwap code.


git clone https://github.com/tecnovert/basicswap.git










	Navigate to BasicSwap’s Docker folder.


cd basicswap/docker/










	Copy the default environment file.


cp example.env .env










	(Optional) Set a custom coin data path by modifying the target path in your .env file.


nano .env










	Create the BasicSwap Docker image (make sure you are in basicswap/docker.


docker-compose build















	Open a terminal.


	Install Git.

sudo apt update
sudo apt install git jq curl







	Download the BasicSwap code.


git clone https://github.com/tecnovert/basicswap.git










	Navigate to BasicSwap’s Docker folder.


cd basicswap/docker/










	Copy the default environment file.


cp example.env .env
















	(Optional) Set a custom coin data path by modifying the target path in your .env file.


nano .env














	Create the BasicSwap Docker image (make sure you are in basicswap/docker.


docker-compose build




















Configure the Docker Image

After creating BasicSwap’s Docker image, it’s time to configure it to your preferences.


WindowsLinux

	Open a WSL (Linux) terminal.


Windows + R > “wsl” -> ENTER.






	Navigate to BasicSwap’s Docker folder.


cd basicswap/docker/










	Set xmrrestoreheight to Monero’s current chain height.


CURRENT_XMR_HEIGHT=$(curl https://localmonero.co/blocks/api/get_stats | jq .height)










	Select the cryptocurrencies you want to activate (Particl is activated by default). You must specify your choices in the configuration command. See here for a complete list of compatible currencies on BasicSwap.


	Decide on whether to perform a fast sync of the Bitcoin blockchain using a checkpoint or to synchronize from the beginning. This choice affects whether you include the –usebtcfastsync parameter in your configuration command.


	Execute the following command to configure your BasicSwap Docker image, adjusting it according to your preferences as described above.


export COINDATA_PATH=/var/data/coinswaps
docker run --rm -t --name swap_prepare -v $COINDATA_PATH:/coindata i_swapclient basicswap-prepare --datadir=/coindata --withcoins=monero,bitcoin --htmlhost="0.0.0.0" --wshost="0.0.0.0" --xmrrestoreheight=$CURRENT_XMR_HEIGHT --usebtcfastsync










	Securely record and store the mnemonic provided by the above command. It serves as your wallet’s backup key.


	Safely note the result of the following command, it is useful if you need to recover your Monero wallet.


echo $CURRENT_XMR_HEIGHT










	(Optional) Adjust your timezone by specifying the appropriate TZ value in your .env file, located within the BasicSwap Docker directory. Use the timedatectl list-timezones command to view valid timezone options.


nano .env





To save changes, press CTRL + X, then Y + ENTER.










	Open a terminal.


	Navigate to BasicSwap’s Docker folder.


cd basicswap/docker/










	Set xmrrestoreheight to Monero’s current chain height.


CURRENT_XMR_HEIGHT=$(curl https://localmonero.co/blocks/api/get_stats | jq .height)










	Select the cryptocurrencies you want to activate (Particl is activated by default). You must specify your choices in the configuration command. See here for a complete list of compatible currencies on BasicSwap.


	Decide on whether to perform a fast sync of the Bitcoin blockchain using a checkpoint or to synchronize from the beginning. This choice affects whether you include the –usebtcfastsync parameter in your configuration command.


	Execute the following command to configure your BasicSwap Docker image, adjusting it according to your preferences as described above.


export COINDATA_PATH=/var/data/coinswaps
docker run --rm -t --name swap_prepare -v $COINDATA_PATH:/coindata i_swapclient basicswap-prepare --datadir=/coindata --withcoins=monero,bitcoin --htmlhost="0.0.0.0" --wshost="0.0.0.0" --xmrrestoreheight=$CURRENT_XMR_HEIGHT --usebtcfastsync










	Securely record and store the mnemonic provided by the above command. It serves as your wallet’s backup key.


	Safely note the result of the following command, it is useful if you need to recover your Monero wallet.


echo $CURRENT_XMR_HEIGHT










	(Optional) Adjust your timezone by specifying the appropriate TZ value in your .env file, located within the BasicSwap Docker directory. Use the timedatectl list-timezones command to view valid timezone options.


nano .env





To save changes, press CTRL + X, then Y + ENTER.













Start BasicSwap

After configuring your Docker image, the next step is to run it. Doing so will launch BasicSwap, making it accessible through web browsers.


WindowsLinux

	Open a WSL (Linux) terminal.


Windows + R > “wsl” -> ENTER.






	Navigate to BasicSwap’s Docker folder.


cd basicswap/docker/










	Start the Docker image. This will launch BasicSwap’s startup process.


export COINDATA_PATH=/var/data/coinswaps
docker-compose up










	Wait for BasicSwap to start fully, then open it up in your favorite web browser by navigating to the following address.


http://localhost:12700














	Open a terminal.


	Navigate to BasicSwap’s Docker folder.


cd basicswap/docker/










	Start the Docker image. This will launch BasicSwap’s startup process.


export COINDATA_PATH=/var/data/coinswaps
docker-compose up










	Wait for BasicSwap to start fully, then open it up in your favorite web browser by navigating to the following address.


http://localhost:12700


















Install Without Docker


Build BasicSwap

The first step to running BasicSwap without docker is to build it locally on your device.


Mac OSLinux

	Open Terminal (i.e., COMMAND ⌘ + SPACE and type “terminal” > hit ENTER ↵).


	Install Homebrew by executing the following command in the Terminal. Homebrew extends MacOS with a wealth of Linux-style package management capabilities.


/bin/bash -c "$(curl -fsSL https://raw.githubusercontent.com/Homebrew/install/HEAD/install.sh)"










	Install the required dependencies


brew install wget unzip python git protobuf gnupg automake libtool pkg-config curl jq










	Close the terminal and open a new one. This will update the python symlinks and allow you to progress through the next steps.


	Execute the commands below sequentially to setup the environment. Each line must be run one-by-one to prevent errors and ensure successful execution.


export SWAP_DATADIR=/Users/$USER/coinswaps
mkdir -p "$SWAP_DATADIR/venv"
python3 -m venv "$SWAP_DATADIR/venv"
. $SWAP_DATADIR/venv/bin/activate && python -V
cd $SWAP_DATADIR
wget -O coincurve-anonswap.zip https://github.com/tecnovert/coincurve/archive/refs/tags/anonswap_v0.1.zip
unzip -d coincurve-anonswap coincurve-anonswap.zip
mv ./coincurve-anonswap/*/{.,}* ./coincurve-anonswap || true
cd $SWAP_DATADIR/coincurve-anonswap
pip3 install .
cd $SWAP_DATADIR
git clone https://github.com/tecnovert/basicswap.git
cd $SWAP_DATADIR/basicswap










	Install root SSL certificates for the SSL module (more information here [https://pypi.org/project/certifi/]).


sudo python3 bin/install_certifi.py










	Continue with the BasicSwap installation, executing the following two commands one by one.


protoc -I=basicswap --python_out=basicswap basicswap/messages.proto
pip3 install .














	Install the required dependencies


apt-get install -y wget python3-pip gnupg unzip protobuf-compiler automake libtool pkg-config curl jq










	Execute the commands below sequentially to setup the environment. Each line must be run one-by-one to prevent errors and ensure successful execution.


export SWAP_DATADIR=/Users/$USER/coinswaps
mkdir -p "$SWAP_DATADIR/venv"
python3 -m venv "$SWAP_DATADIR/venv"
. $SWAP_DATADIR/venv/bin/activate && python -V
cd $SWAP_DATADIR
wget -O coincurve-anonswap.zip https://github.com/tecnovert/coincurve/archive/refs/tags/anonswap_v0.1.zip
unzip -d coincurve-anonswap coincurve-anonswap.zip
mv ./coincurve-anonswap/*/{.,}* ./coincurve-anonswap || true
cd $SWAP_DATADIR/coincurve-anonswap
pip3 install .
cd $SWAP_DATADIR
git clone https://github.com/tecnovert/basicswap.git
cd $SWAP_DATADIR/basicswap
protoc -I=basicswap --python_out=basicswap basicswap/messages.proto
pip3 install .

















Configure BasicSwap

After the installation, configure BasicSwap according to your requirements.


Mac OSLinux


	Open Terminal (i.e., COMMAND ⌘ + SPACE and type “terminal” > hit ENTER ↵).


	Navigate to your BasicSwap folder.


cd /Users/$USER/coinswaps










	Set xmrrestoreheight to Monero’s current chain height.


CURRENT_XMR_HEIGHT=$(curl https://localmonero.co/blocks/api/get_stats | jq .height)
















	Select the cryptocurrencies you want to activate (Particl is activated by default). You must specify your choices in the configuration command. See here for a complete list of compatible currencies on BasicSwap.


	Decide on whether to perform a fast sync of the Bitcoin blockchain using a checkpoint or to synchronize from the beginning. This choice affects whether you include the –usebtcfastsync parameter in your configuration command.


	Execute the following command to configure your BasicSwap Docker image, adjusting it according to your preferences as described above.


basicswap-prepare --datadir=$SWAP_DATADIR --withcoins=monero,bitcoin --xmrrestoreheight=$CURRENT_XMR_HEIGHT --usebtcfastsync














	Open a terminal.


	Navigate to your BasicSwap folder.


cd /Users/$USER/coinswaps










	Set xmrrestoreheight to Monero’s current chain height.


CURRENT_XMR_HEIGHT=$(curl https://localmonero.co/blocks/api/get_stats | jq .height)










	Select the cryptocurrencies you want to activate (Particl is activated by default). You must specify your choices in the configuration command. See here for a complete list of compatible currencies on BasicSwap.


	Decide on whether to perform a fast sync of the Bitcoin blockchain using a checkpoint or to synchronize from the beginning. This choice affects whether you include the –usebtcfastsync parameter in your configuration command.


	Execute the following command to configure your BasicSwap Docker image, adjusting it according to your preferences as described above.


basicswap-prepare --datadir=$SWAP_DATADIR --withcoins=monero,bitcoin --xmrrestoreheight=$CURRENT_XMR_HEIGHT --usebtcfastsync

















Start BasicSwap

After configuring your Docker image, the next step is to run it. Doing so will launch BasicSwap, making it accessible through web browsers.


Mac OSLinux

	Open Terminal (i.e., COMMAND ⌘ + SPACE and type “terminal” > hit ENTER ↵).


	Navigate to your BasicSwap folder.


cd /Users/$USER/coinswaps










	Launch BasicSwap.


basicswap-run --datadir=$SWAP_DATADIR










	Open BasicSwap’s user interface in your favorite web browser by navigating to the following address.


http://localhost:12700














	Open a terminal.


	Navigate to your BasicSwap folder.


cd /Users/$USER/coinswaps










	Launch BasicSwap.


basicswap-run --datadir=$SWAP_DATADIR










	Open BasicSwap’s user interface in your favorite web browser by navigating to the following address.


http://localhost:12700


















See also


	BasicSwap Explained - BasicSwap Explained


	BasicSwap Guides - Update BasicSwap


	BasicSwap Guides - Route BasicSwap Through Tor


	BasicSwap Guides - Make an Offer


	BasicSwap Guides - Take an Offer











            

          

      

      

    

 


  

    
      
          
            
  
Update BasicSwap

BasicSwap DEX is an open-source work in progress, and, as such, constant and regular updates are to be expected.

To benefit from new features, improvements, and bug fixes, it is recommended that you update your BasicSwap instance frequently.

This guide will show you how to update BasicSwap properly.




Table of Contents


	Update a Docker Image


	Update Without Docker








Update a Docker Image

If you’ve built BasicSwap using the Docker method, follow these steps to update your instance to the most up-to-date version.


Update BasicSwapUpdate Coin Core Versions
Update BasicSwap to the most up-to-date version.



	Navigate to your BasicSwap’s docker folder (where BasicSwap is installed).

cd basicswap/docker







	Make sure BasicSwap is stopped.

docker-compose stop







	Pull the latest BasicSwap updates from Github.

git pull







	If you haven’t set your COINDATA_PATH variable permanently in your .env file, you’ll need to export the variable first.

export COINDATA_PATH=/var/data/coinswaps







	Apply the updates you’ve pulled from Github to your docker image.

docker-compose build





If BasicSwap’s dependencies have changed, the update must be applied with the –no-cache argument.


docker-compose build --no-cache










	Launch BasicSwap

docker-compose up













Attention

If updating from versions below 0.21, you may need to add wallet=wallet.dat to the core config.




Update the core version of one or more coins you’ve enabled on BasicSwap. You need to first update BasicSwap before you can update coin cores.



	Make sure your BasicSwap instance if up-to-date with the latest updates.


	Navigate to your BasicSwap docker folder (where your BasicSwap docker image is located).

cd basicswap/docker







	Make sure BasicSwap is stopped.

docker-compose stop







	If you haven’t set your COINDATA_PATH variable permanently in your .env file, you’ll need to export the variable first.

export COINDATA_PATH=/var/data/coinswaps







	Apply coin core updates to your docker image. Make sure to write what coin core(s) you want to update using the –withcoins argument.

docker-compose run --rm swapclient \
   basicswap-prepare --datadir=/coindata --preparebinonly --withcoins=monero,bitcoin













Attention

If updating from versions below 0.21, you may need to add wallet=wallet.dat to the core config.








Update Without Docker

If you’ve built BasicSwap without using the Docker method, follow these steps to update your instance to the most up-to-date version.


Tip

For Linux users, updating BasicSwap and the coin cores you’ve enabled is simplified through community-developed scripts available here on Github [https://github.com/nahuhh/basicswap-bash/releases].




Update BasicSwapUpdate Coin Core Versions
Update BasicSwap to the most up-to-date version.



	Properly shutdown BasicSwap.


	Prepare your BasicSwap to receive updates by executing these two commands one by one.

export SWAP_DATADIR=/Users/$USER/coinswaps
. $SWAP_DATADIR/venv/bin/activate && python -V







	Navigate to your BasicSwap folder.

cd $SWAP_DATADIR/basicswap







	Pull the latest BasicSwap updates from Github.

git pull







	Apply the updates to your BasicSwap instance

pip3 install .













Attention

If updating from versions below 0.21, you may need to add wallet=wallet.dat to the core config.




Update the core version of the coins you’ve enabled on BasicSwap. Note that you need to first update BasicSwap before you can update individual coin cores.



	Properly shutdown BasicSwap.


	Make sure your BasicSwap instance is up-to-date with the latest updates.


	Apply coin core updates to your BasicSwap instance. Make sure to input what coin core(s) you want to update using the –withcoins argument.

basicswap-prepare --datadir=$SWAP_DATADIR -preparebinonly --withcoins=monero,bitcoin













Attention

If updating from versions below 0.21, you may need to add wallet=wallet.dat to the core config.









See also


	BasicSwap Explained - BasicSwap Explained


	BasicSwap Guides - Install BasicSwap


	BasicSwap Guides - Route BasicSwap Through Tor


	BasicSwap Guides - Make an Offer


	BasicSwap Guides - Take an Offer










            

          

      

      

    

 


  

    
      
          
            
  
Enable or Disable Coins

By default, BasicSwap only comes with Particl enabled, but you can easily enable other coins that you want to trade.

This guide will show you how to enable or disable coins on BasicSwap.




Table of Contents


	BasicSwap on Docker


	BasicSwap Without Docker








Attention

Currently, each coin you add has to be added one by one. Repeat the following step for each coin you want to enable.




Attention

Currently, adding a new coin to BasicSwap requires you to download its blockchain locally. We are working on adding more options, such as using light services and access gateways (i.e., web), which will be available at a later beta stage.




BasicSwap on Docker

If you’ve built BasicSwap using the Docker method, follow these steps to enable or disable coins your instance to the most up-to-date version.


Enable CoinsDisable Coins

	Stop the docker image (this will shut down all BasicSwap processes).


docker-compose stop










	If you haven’t set your COINDATA_PATH variable permanently in your .env file, you’ll need to export the variable first.

export COINDATA_PATH=/var/data/coinswaps







	Enable coins by typing the following commands accompanied by the coin you want to enable after the –addcoin.


docker run --rm -t --name swap_prepare -v $COINDATA_PATH:/coindata i_swapclient basicswap-prepare --datadir=/coindata --addcoin=bitcoin













Note

You can copy an existing pruned datadir (excluding bitcoin.conf and any wallets) over to $COINDATA_PATH/bitcoin. Remove any existing wallets after copying over a pruned chain, or the Bitcoin daemon won’t start.





	Stop BasicSwap completely.


docker-compose stop










	Remove the coin’s record in the basicswap.json config file.


sudo nano /var/data/coinswaps/basicswap.json





In this example, here is the excerpt you would remove from basicswap.json if you wanted to remove Monero.

"monero": {
        "connection_type": "rpc",
        "manage_daemon": true,
        "manage_wallet_daemon": true,
        "rpcport": 29798,
        "zmqport": 30898,
        "walletrpcport": 29998,
        "rpchost": "127.0.0.1",
        "walletrpchost": "127.0.0.1",
        "walletrpcuser": "xmr_wallet_user",
        "walletrpcpassword": "xmr_wallet_pwd",
        "walletfile": "swap_wallet",
        "datadir": "/coindata/monero",
        "bindir": "/coindata/bin/monero",
        "restore_height": 2731435,
        "blocks_confirmed": 7,
        "walletsdir": "/coindata/monero"
},










	If you haven’t set your COINDATA_PATH variable permanently in your .env file, you’ll need to export the variable first.

export COINDATA_PATH=/var/data/coinswaps







	Launch BasicSwap normally.


docker-compose up

















BasicSwap Without Docker

If you’ve built BasicSwap without using the Docker method, follow these steps to add or remove coins to your BasicSwap instance.


Tip

For Linux users, adding or removing coins is simplified through community-developed scripts available here on Github [https://github.com/nahuhh/basicswap-bash/releases].




Enable CoinsDisable Coins

	Stop BasicSwap completely.


docker-compose stop










	Enable coins by typing the following commands accompanied by the coin you want to enable after the –addcoin.


export SWAP_DATADIR=/Users/$USER/coinswaps
basicswap-prepare --usebtcfastsync --datadir=/$SWAP_DATADIR --addcoin=bitcoin










	Activate the change to your BasicSwap instance.


export SWAP_DATADIR=/Users/$USER/coinswaps
. $SWAP_DATADIR/venv/bin/activate && python -V













Note

You can copy an existing pruned datadir (excluding bitcoin.conf and any wallets) over to $COINDATA_PATH/bitcoin. Remove any existing wallets after copying over a pruned chain, or the Bitcoin daemon won’t start.





	Stop BasicSwap completely.


	Remove the coin’s record in the basicswap.json config file.


sudo nano /Users/$USER/coinswaps/basicswap.json





In this example, here is the excerpt you would remove from basicswap.json if you wanted to remove Monero.

"monero": {
        "connection_type": "rpc",
        "manage_daemon": true,
        "manage_wallet_daemon": true,
        "rpcport": 29798,
        "zmqport": 30898,
        "walletrpcport": 29998,
        "rpchost": "127.0.0.1",
        "walletrpchost": "127.0.0.1",
        "walletrpcuser": "xmr_wallet_user",
        "walletrpcpassword": "xmr_wallet_pwd",
        "walletfile": "swap_wallet",
        "datadir": "/coindata/monero",
        "bindir": "/coindata/bin/monero",
        "restore_height": 2731435,
        "blocks_confirmed": 7,
        "walletsdir": "/coindata/monero"
},










	Once that is done, save the changes with CTRL + X, following by an ENTER.


	Launch BasicSwap normally.










See also


	BasicSwap Explained - BasicSwap Explained


	BasicSwap Guides - Install BasicSwap
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Manage Enabled Coins

BasicSwap DEX is a non-custodian DEX (decentralized exchange), meaning that you remain in full control of your coins at every step.

This aspect of BasicSwap significantly improves your security and privacy, but it also means that you need to maintain a full node of every coin you’ve enabled.

This guide will walk you through everything you need to know about managing coins on BasicSwap.
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Note

While BasicSwap currently requires that you run full coin nodes locally at this beta stage, we are working on solutions to allow for light services and alternative gateways (i.e., web and third-party integrations).




Enable Coins

Only Particl is enabled by default on BasicSwap. That’s because the DEX leverages the SecureMessaging (SMSG) network to function, which runs parallel to the Particl blockchain.

If you want to enable other coins such as Bitcoin, Litecoin, or even Monero, follow the steps detailed in the Enable or Disable Coins guide.



Monitor Sync Status

When running a full BasicSwap node, you also host coin nodes (i.e., a Bitcoin node) locally on your device.

You can check the sync status of each coin node by following these steps.


	On BasicSwap, navigate to the Wallets section by clicking on the blue Wallets button.


	Each coin will display a progress bar that shows the sync progress.


	You can also verify that each node is connected to its respective network by ensuring that it is marked as Updating next to the coin’s core version.






Manage Wallets (Deposit/Withdraw)

You can manage various coin-related options directly from BasicSwap. Typically, most settings are made available on a per-coin basis (some coins have unique features that you’ll find here), but that’s also where you’ll find the option to deposit and withdraw coins.


	On BasicSwap, navigate to the Wallets section by clicking on the blue Wallets button.


	Each coin has an associated Manage button. Click on it to open a coin’s settings.


	In the coin’s Manage page, you’ll find various coin-specific options (i.e., balance conversion for PART) and the ability to deposit and withdraw coins.





Note

Specifically for PIVX, Dash, and Firo, you may need to click on the Reseed wallet button after the blockchain is fully synced to enable deposits and withdrawals.






See also


	BasicSwap Explained - BasicSwap Explained


	BasicSwap Guides - Install BasicSwap
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Enable Tor

By default, connections to the BasicSwap network are public, much like connecting to other P2P networks (i.e., torrents). However, you can easily anonymize your network information (i.e., IP address, location) by routing your BasicSwap connection through the privacy-preserving Tor network [https://www.torproject.org/].

This guide will show you how to protect your network information by routing BasicSwap’s connection through the Tor network.
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BasicSwap on Docker


Create Initial Files

If you’re about to connect BasicSwap to Tor for the first time, you first need to create Tor configuration files.


	Create the initial files BasicSwap needs to connect to the Tor network. Docker will create directories instead of files if these don’t exist.


mkdir $COINDATA_PATH/tor
touch $COINDATA_PATH/tor/torrc














Enable Tor on First Startup

If you are doing a fresh installation of BasicSwap and want to route it through the Tor network, the torrc configuration file won’t exist yet. Follow these instructions to create it.


	Install BasicSwap through the installation process detailed here.


	Create the torrc configuration file by typing these two commands one by one.

docker compose -f docker-compose_with_tor.yml run --name tor --rm tor \
      tor --allow-missing-torrc --SocksPort 0.0.0.0:9050

docker compose -f docker-compose_with_tor.yml run -e TOR_PROXY_HOST=172.16.238.200 --rm swapclient \
      basicswap-prepare --usetorproxy --datadir=/coindata --withcoins=monero,particl







	Start BasicSwap with the following command.

docker compose -f docker-compose_with_tor.yml up











Enable Tor

If you have been using BasicSwap previously and want to enable Tor now, you can easily activate it with a single command.


	Shutdown BasicSwap entirely.


	Enable Tor and make the required modifications to your data directory.

docker compose -f docker-compose_with_tor.yml run -e TOR_PROXY_HOST=172.16.238.200 --rm swapclient \
      basicswap-prepare --datadir=/coindata --enabletor







	Start BasicSwap along with Tor.

export COINDATA_PATH=/var/data/coinswaps && docker compose -f docker-compose_with_tor.yml up











Update Coins Through Tor


	Shutdown BasicSwap entirely.


	Start a Tor-connected BasicSwap instance in the background.

docker compose -f docker-compose_with_tor.yml up -d tor







	Update the coin you want by typing this command and modifying the withcoins argument.

docker compose -f docker-compose_with_tor.yml run -e TOR_PROXY_HOST=172.16.238.200 --rm swapclient \
      basicswap-prepare --usetorproxy --datadir=/coindata --preparebinonly --withcoins=bitcoin







	Once the process from the last step completes, shutdown BasicSwap instance running in the background.

docker compose -f docker-compose_with_tor.yml stop











Disable Tor


	Shutdown BasicSwap entirely.


	Enable Tor and make the required modifications to your data directory.

docker compose -f docker-compose_with_tor.yml run --rm swapclient \
      basicswap-prepare --datadir=/coindata --disabletor







	Start Tor normally.

export COINDATA_PATH=/var/data/coinswaps && docker-compose up












BasicSwap Without Docker

For Linux users that have installed BasicSwap without Docker, enabling Tor is simplified through community-developed scripts available here on Github [https://github.com/nahuhh/basicswap-bash/releases].




See also


	BasicSwap Explained - BasicSwap Explained
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Create an Offer

BasicSwap DEX is a cross-chain and privacy-centric DEX (decentralized exchange) that lets you trade cryptocurrencies without middleman interference.

One of its particularities is the presence of a distributed order book that lets you make or take offers without third-party involvement.

This guide will walk you through the full process of making an offer and placing it on the books.
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Create an Offer


	In BasicSwap, click on the blue New Offer button.


	Enter the coin and amounts you want to send in You Send.


	Enter the coin and amounts you want to get in exchange in You get.



Note

You can see the most recent rates by clicking on the Check Current Rates button at the bottom of the page.








	Select your offer preferences.



	Lock Rate: Automatically adjusts the You Get value based on the rate you’ve entered. Without it, the rate value is automatically adjusted based on the number of coins you put in You Get.


	Amount Variable: Allow bids with a different amount to the offer.


	Rate Variable: Allow bids with a different rate to the offer.









	Click on the blue Continue button to progress to the next step.






Setup Offer Preferences


	Determine how long you want your coins to be listed on the order book by adjusting the Offer valid (hrs) value.


	Set the contract lock time by adjusting the Contract Locked (Mins) value. This is the timer that determines whether a swap has failed or not. When a swap fails for any reason, both participants are refunded their coins.


	Choose whether you want to auto-accept bids on your offer or not. Accept All will accept all bids automatically, while Accept Known will only accept bids from other traders you’ve swapped with in the past.



Attention

When you successfully complete a swap, your offer does not automatically disappear from the books. Keep that in mind when setting an offer as either Accept All or Accept Known.








	Click on the blue Continue button to progress to the next step.






Confirm the Offer


	Review your order information and click on the blue Confirm Offer button if satisfied.






See my Active Offers


	Review the current and previous orders you’ve placed on BasicSwap’s order book by navigating to the Your Offers tab.






Accept a Bid

If your offer is set to accept all bids automatically, you don’t need to do anything. Swaps will happen automatically whenever someone picks up your offer.

If you’ve set your offer to only accept bids from known peers or not automatically accept any offer at all, you need to look out for incoming bids and accept them.


	Navigate to the Bids Received tab. If you receive bids, they will show up here.


	When you receive a bid, click on its BID ID to open its details.


	Review the bid’s information and click on Accept Bid if you want to initiate the swap.


	The rest of the process is entirely automatic. Just wait a few minutes and the swap will complete.





Tip

You can follow a swap’s progress from the Events section of its bid page.






See also


	BasicSwap Explained - BasicSwap Explained
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Take an Offer

BasicSwap DEX is a cross-chain and privacy-centric decentralized exchange that lets you trade cryptocurrencies without middleman interference.

One of its particularities is the presence of a distributed order book that lets you make or take offers without third-party involvement.

This guide will walk you through the full process of taking an offer from the books.
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Explore the Order Book


Note

Prices displayed on the graph may differ from the actual trading history on the BasicSwap platform. This data is acquired through APIs and is purely for convenience purposes.




	Navigate to the order books by clicking on the Show Order Book tab.


	Scroll down the books to find an offer that you want to fill.


	You can fine-tune what the order book shows you by using the filters available just under the price history graph.






Place a Bid


	When you find an offer that you want to take, click on the Swap button on the right side of its tile.


	Review the swap details and click on the blue New Bid button if you’re satisfied.


	You’ve successfully placed a bid on the offer.






Monitor the Swap

If the trader that placed the offer has set it to accept bids automatically, then you don’t need to do anything. The swap is already underway and will complete automatically.

If it has instead been set to accept bids manually, you need to wait for your bid to be accepted. In the meantime, you can monitor your swaps’ progress.


	Navigate to the Bids Sent tab. The bid you placed will show up here.


	Monitor the BID STATUS value that will tell you whether the bid has been accepted or not.


	Click on a bid’s BID ID to open more information in a new page.


	Here you can monitor a bid or swap’s progress down to the exact technical details.


	Once the offer’s maker accepts your bid, the swap will complete automatically and you will receive your coins shortly after.







See also


	BasicSwap Explained - BasicSwap Explained
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Automated Market Making Script

You can use a variety of tools to help you provide liquidity and manage positions more easily on BasicSwap DEX. This guide walks you through all the instructions to make full use of them.
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Attention

Certain liquidity tools may link to external services, potentially diminishing your privacy depending on their usage. As a result, they are presently provided as optional companion scripts requiring independent operation.

Aspects of these tools that don’t establish connections with third-parties are anticipated to be incorporated into the central BasicSwap protocol in the future.




Offer Management

By default, BasicSwap allows offers to be published on the order book for a maximum of 48 hours. This is due to the nature of the SecureMessaging (SMSG) networking protocol used to propagate offers on the network.

The createoffers.py script enables you to keep your offers consistently on the order book, while also dynamically managing their parameters.


Automatically Republish Offer and Adjust Prices

Using createoffers.py, you can ensure that your offers stay persistently listed on the order book, with periodic price updates.


	Navigate to your /docker folder and make sure that your BasicSwap instance is up-to-date.

git pull
docker-compose build







	Navigate to your /scripts folder.


	Enable the script’s configuration file by renaming it createoffers.json.

cp template_createoffers.json createoffers.json







	Open the createoffers.json file in a text editor.

nano createoffers.json







	Edit the file and set the correct parameters by modifying the following values to your preferences.



	coin_from: The coin you want to send.


	coin_to: The coin you want to receive in exchange of your coin_from.


	amount: The number of coin_from coins you want to offer on the books.


	minrate: This refers to the lowest acceptable rate under which the script should not consider an offer. Note that this isn’t the effective exchange rate, but merely the absolute minimum rate you deem acceptable. The script will refrain from publishing offers on the books that fall below this value, thereby offering protection against sudden and unexpected liquidity spikes.


	ratetweakpercent: This parameter specifies the percentage above or below the current market price (as reported by CoinGecko’s API) at which you want to list your orders. For instance, if you set this to a value of 5, your offers will be listed at 5% above the market reported price. This feature automates the process of listing profitable offers on the order book.


	amount_variable: Either True or False, determines whether you permit your offer to be partially fulfilled. For example, if you enable this option (set it to True), someone could fulfill just 25 PART of your 100 PART offer instead of the entire amount.


	address: This refers to your swap identity or swap address. You have the option to specify one (this would be a Particl address from your BasicSwap Particl wallet), or if you prefer, you can set this to -1, which will prompt the system to generate a new random address each time your offer is updated.


	name: The name of your offer. Keep it as offer 0, offer 1, and so on.


	min_coin_from_amt: This refers to the smallest amount of coins a bid must request for the script to automatically accept the offer. Remember that each transaction incurs on-chain transaction fees. Thus, it may be beneficial to set this value higher than the current on-chain fees.


	offer_valid_seconds: This parameter determines the duration (in seconds) for which your offer will remain on the books. After this time has elapsed, your offer will be re-published with a price adjustment, provided the script is still in operation. For instance, setting it to 3600 will prompt the script to re-publish your offer every hour with a revised price (current market price + ratetweakpercent). This parameter can be set universally instead of on a per-order basis.


	swap_type: The script defaults to publishing offers using the more private adaptor_sig swap type, which requires the offering blockchain to contain a transaction malleability fix (i.e., Segwit). If that’s not the case for your offer, you’ll need to change this to secret_hash.







To save changes, press CTRL + X, then Y + ENTER.



	With BasicSwap running in the background, start the python script.

python createoffers.py






Note

The script needs to run continuously to take effect. Closing the terminal tab that runs it will terminate it. For this reason, we recommend executing the script using Byobu [https://www.digitalocean.com/community/tutorials/how-to-install-and-use-byobu-for-terminal-management-on-ubuntu-16-04?] or screen [https://linuxize.com/post/how-to-use-linux-screen/].












            

          

      

      

    

 


  

    
      
          
            
  
Apply for Listing

The BasicSwap DEX lets you trade a range of cryptocurrencies in total privacy and without third-party assistance. And thanks to its open-source framework, anyone can add new coins to the DEX.

This guide will show you how to add new coins to the BasicSwap DEX; either by manually integrating them or by submitting a coin listing application to the BasicSwap team.
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Attention

BasicSwap is a cross-chain DEX that makes on-chain swaps. For this reason, each coin integration has to be worked out on a case-by-case basis. If you struggle to integrate a coin manually, consider submitting a listing application request.




Manual Integration

Thanks to its open-source nature, it is possible for anyone to submit their own coin integrations on Github. When successfully merged into the code, anyone with an up-to-date version of BasicSwap can then trade that new coin.


Requirements


Note

The following requirements are up-to-date with BasicSwap’s latest version (v0.20).



Because BasicSwap is an entirely cross-chain DEX, there are basic requirements that a coin must possess to be readily integrated.

The blockchain…


	Uses UTXO scripts


	Has CLTV or CSV


	Has Segwit enabled


	Works with watch-only addresses





Testing for Requirements

In most cases, BasicSwap’s requirements test script can help you quickly determine whether a coin can be readily integrated or not.

If a coin does not pass the test or misses a few requirements, don’t worry; it can probably still be integrated but may require the BasicSwap team to work on a custom integration framework. If that’s your case, consider submitting a listing application request.


	Install BasicSwap and ensure you are running the latest version (v0.20).


	Open the basicswap folder in a terminal.


	Navigate to where the test script is located.


cd scripts










	Run the script by typing the following command while making sure to put the right destination folder for your coin’s core.


py requirements.python ~/Applications/particl/bin/particld -d















Integration Process

If the coin you want to integrate meets all the requirements mentioned above, then there are good chances you will be able to add it to the DEX.

But remember, new coin integrations remain a case-by-case process that varies depending on what coin is being integrated.

With this in mind, you can check how other coins that may be similar to yours have been integrated into the DEX and derive your own process from these examples. Click on the numbers next to each coin’s name to study their integration code.




	Coin

	UTXO Scripts

	Bitcoin Version

	CLTV

	CSV

	Segwit

	Watch-only Addresses





	Bitcoin

	Yes

	24.0

	Yes

	Yes

	Yes

	Yes



	Monero

	No

	—

	—

	—

	—

	—



	Litecoin

	Yes

	0.21

	Yes

	Yes

	Yes

	Yes



	Dash (1 [https://github.com/tecnovert/basicswap/commit/7298867e18efbaf1a6630769da651084ea8e954c], 2 [https://github.com/tecnovert/basicswap/commit/4866ff4db89593472d21261ebbbb6a87e3f1f922], 3 [https://github.com/tecnovert/basicswap/commit/aa14da27af33b5b02845d6c87e32b46e57d741a4])

	Yes

	—

	Yes

	Yes

	No

	Yes



	Firo (1 [https://github.com])

	Yes

	—

	Yes

	Yes

	No

	Yes



	PIVX (1 [https://github.com/tecnovert/basicswap/commit/d74699992be727ea4bb6df0871da5983ef775566])

	Yes

	—

	Yes

	No

	No

	Yes



	Particl

	Yes

	24.0

	Yes

	Yes

	Yes

	Yes












Apply for a Listing

Alternatively, you can send us a listing application [https://basicswapdex.com/apply]. This is a great option if your coin does not meet most of the requirements or if you would rather focus your development resources elsewhere.

Please note, however, that on top of adding new coins, we are also constantly working on tackling our roadmap; improving and growing BasicSwap in the process. For this reason, we cannot guarantee a swift integration for all applicants.

To submit a listing application for your coin, follow this link: https://BasicSwapDEX.com/apply


Tip

To bump the priority of your application, consider pledging a donation to our open-source developers as part of your application.
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Frequently Asked Questions


Note

The Particl Academy is up-to-date with Particl’s latest version, Particl Desktop 3.3.1.

Got any questions not answered here? Then let us know about it so that we can help you out and update the Particl Academy!




PART and Blockchain FAQ

Coin Staking FAQ



Why are some of my coins not staking after receiving my last staking reward?



When staking, your coins are separated into multiple outputs. Each output stakes separately with the hopes of finding and verifying a block.

When one of your outputs stakes a block, or when you receive a transaction, the output is temporarily unavailable until it can be moved or stake blocks again. This process is referred to as “maturing” and lasts for 225 blocks (~8 hours).

Once your output is mature once again, you’ll be able to transact the coins it contains, and it’ll be able to stake blocks once again.







Particl Marketplace FAQ

General Marketplace FAQ



How can I create a new market identity?



The ability to create a new market identity is not enabled by default. To enable it, go to Market Settings > Advanced Features and check the Enable multiple identities for the current profile box.

Then, click on the downward-facing arrow located above the Overview button in the menu on the left. This will display a new option. Simply click on Click to create… button to create a new market identity.





How much can I earn staking PART?



This depends on many factors such as the total number of PART coins being staked by other users, your total number of coins, the number of transactions on the marketplace, the number of transactions on the blockchain, Particl dApp usage, etc.

To know everything about staking, head over to our staking guide.





Why can’t I see any listing on the marketplace?



To see listings on the marketplace, your Particl Desktop client needs to be fully synced with the Particl Blockchain AND the SMSG network. This process can take several minutes, especially if you have a slow internet connection. Just leave your Particl Desktop client open while it syncs and head over to the Browse page of the marketplace to monitor incoming listings.

Once your client is fully synced, it will be much faster to get started whenever you open the marketplace again. The initial syncing is a one-time process that doesn’t need to be repeated every time.





I think I’ve found a bug. Where can I report it?



If you think you’ve found a bug or issue, click on the bug 🐛 icon at the bottom left corner of your Particl Desktop client and create a new Github report by clicking on the green New issue button.

Thanks for your help!





How can I get more technical support?



First, make sure that your question or issue isn’t already addressed somewhere in the Particl Academy. That’s the easiest way to fix most problems. Have you tried the search function?

If you can’t find the answer you’re looking for in there, then head over to the Get Support section to get more help!



Customer’s Frequently Asked Questions



How do I open the marketplace in order to see listings?




	Be sure to be on the latest version (Particl Desktop 3.3.1). The installation guide guide may help you greatly.


	After the initial startup, let the network sync. On slow connections, it may take a while, but you can monitor incoming listings if you head over to the Browse page.




Be sure that you don’t see any warnings in the top right status bar. If you still don’t see any listings, feel free to Get Support.





What does each order status mean?




	ORDER REQUEST: You have requested an order on an item and are now waiting for the vendor to accept it.


	ACCEPTED: The vendor has accepted your order and is now waiting for you to send the payment and your security deposit in escrow.


	ESCROW: You have locked your funds in escrow and are now waiting for the vendor to lock their security deposit as well.


	PACKAGING: The vendor is now packaging your order and getting it ready to ship.


	SHIPPING: The vendor has shipped your item and is now waiting for you to receive and confirm the delivery.


	COMPLETE: You have received your order and have confirmed the order as “complete”. There are no more required actions in this transaction, and you’ve received your security deposit back.








Why am I not getting updates on my orders?



If your Particl Desktop is protected by a password (encrypted), you need to unlock it with your password to receive order updates. If you keep your client locked, you won’t receive the notifications and won’t be able to progress to the next step.

If your order is still not updated after unlocking your client, that’s because the seller hasn’t done it yet. Wait for the vendor to update the order, or try leaving them a message in the Chat section of your order!





Why do I need to pay twice the value of the order I’m purchasing?



That’s because you need to fund the escrow contract with a security deposit equal to the total value of your order. This deposit will be refunded to you at no fee once the transaction is fully completed.

To learn more about Particl’s two-party escrow system, head over to the Two-Party Escrow System guide.





Can anyone else other than the seller see my shipping address and communications?



No. Only the seller can access your shipping details and private chat conversations because they are end-to-end encrypted before they are broadcast to the network. Check out our marketplace privacy guide to learn more about data security.

Note that, contrary to private in-order discussions, public questions and answers posted in a listing’s Chat section are publicly displayed.





How can I directly contact a seller?



You can leave a comment in a listing’s Chat section. This will notify the seller that they’ve received a message and they’ll be able to answer you. Keep in mind that a listing’s Chat section is public, meaning all messages you and the seller leaves in there are publicly visible.

Alternatively, you may contact a seller in private once you open an order with them. A private chat window is accessible in Purchases as well as in the Chat Messages section.





Where can I find the tracking number of one of my orders?



When a seller leaves you a tracking number, you can check it out right from your Particl Desktop client. To do so, head over to the Orders page of the SELL section. Find the order that you want to find the tracking number of and click on its tile to expand its details.

A seller may not always leave a tracking number, but when they do, that’s where you’ll find it!





How can I cancel an order?



It’s only possible to cancel an order if the seller hasn’t accepted it yet. Otherwise, you can try reaching out to the seller by their provided contact information or through the order’s Chat section to reach an agreement.



Vendor’s Frequently Asked Questions



How can I edit or delete a listing after it has been published?



Due to the current stage of development of the Particl Marketplace (Beta), it is currently not possible. If you want to change the description or image of an item, please publish a new listing.

This functionality is plan to be added at a later stage.





How can I manage my inventory quantities?



Due to the current stage of development of the Particl Marketplace (Beta), it is currently not possible. This is, however, one of the next functionality that is going to be added to the marketplace. It will allow you to manage quantities for your products and various other variants such as sizes, colors, fabrics, etc.





How can I offer item options such as size, color, and other variants?



Due to the current stage of development of the Particl Marketplace (Beta), it is currently not possible. This is, however, one of the next functionality that is going to be added to the marketplace. It will allow you to manage quantities for your products and various other attributes such as sizes, colors, fabrics, etc.





For how long do listings stay on the marketplace?



That’s all up to you! The expiry time for listings on the marketplace depends on the listing fee you pay. When publishing one or multiple listings, the Particl Desktop client will prompt you to select the number of days you want your listings to be published. Simply choose the number of days you prefer from the dropdown menu, and you’re all set!





How can I republish listings after they’ve expired?



Go to the Inventory & Products tab of the SELL page and find the template of the listing you want to republish. Click on it to display more options and click on the publishing icon (rocket) next to the market(s) or storefront(s) you want to publish your listing in. You can publish the same listing in many different markets.

Alternatively, you can instead click on the Batch (Re)publish… button on the same page to open up the publishing tool. On there, you can publish multiple listings at once on any market or storefront in which you have publishing rights.





How can I reply to a question left on one of my listings?



Go to your marketplace Overview page and look for the New questions and New answers tiles. Clicking on them will bring you to the right page and show you all outstanding questions and replies.





Why does my product show up in “Reported listings”, and what does it mean?



If one of your listings shows up in the Reported listings section, it means at least one person has flagged it as inappropriate. If enough people do the same, it will be taken off the marketplace entirely. If your listing shows up in the reported listings section but still shows up on the marketplace, it means that not enough people have voted to delete it.

Want to know more about Particl’s marketplace moderation system? Head over to the Marketplace Content Moderation guide!





Why do listing fees vary between items?



Listing fees are determined by two dynamic factors — the expiry time of the listing and its size (measured in kb). If you publish your listing for a long time, or if it contains many pictures and a large description, it will be more expensive to list than a smaller listing in comparison.



Vendor’s Frequently Asked Questions Regarding Sell Orders



What does each order status mean?




	BIDDING: A buyer has made a bid on an item and is now waiting for you to accept it.


	ACCEPTED: You have accepted a bid on an item and are now waiting for the buyer to confirm payment and lock their funds (payment + security deposit) in escrow.


	ESCROW: The buyer has locked their funds in escrow and is now waiting for you to lock your security deposit as well.


	PACKAGING: The buyer is now waiting for you to package the order and ship it.


	SHIPPING: You have marked the item as shipped and are now waiting for the buyer to receive and confirm the delivery.


	COMPLETE: The item has been confirmed to be received by the buyer. There are no more required actions in this transaction, and you’ve received both the payment for the order and your security deposit back.








Why am I not receiving any new buy orders?



If your Particl Desktop client is protected by a password (encrypted), you need to unlock it so that it can pick up new orders from the Particl network. If you keep your client locked, you won’t receive any new orders now will you get updates from your currently active ones.





How can I send a tracking number or note to my customer?



Once you mark an order as SHIPPED (Package and Shipping an Order), your Particl Desktop client will prompt you to enter a tracking number or note to your customer. It’s an entirely optional step, but it helps your customers keep track of their order(s).

You can also securely leave that information to the customer in the Chat section of each individual order located in the SELL page.





How can I manage refunds and returns through the marketplace?



Due to the current stage of development of the Particl Marketplace (Beta), this feature is currently not supported on the marketplace itself.

Of course, nothing stops you from reaching mutually beneficial resolutions with your customers. You can discuss any matter from the Chat section of each order.





How can I directly contact a customer?



You can also securely chat with customers from the Chat section of each individual order located in the SELL page. Conversations here and end-to-end encrypted and cannot be intercepted.





How can I cancel an order?



You can only cancel an order you haven’t yet accepted. To do so, head over to the SELL page and click on the tile of the order you want to cancel. On there, you will find a Cancel button.

Due to the current stage of development of the Particl Marketplace (Beta), it’s currently not possible to cancel an order once you have fully locked your security deposit in escrow.





BasicSwap DEX FAQ

User Experience



Does BasicSwap require a native coin or token to use?



No. BasicSwap is an open and unrestricted DEX protocol. It isn’t tied to a native coin or token and doesn’t contain any monetization layer. This approach makes it an ideal base layer for other DEXs to be built on top of.





What coins are available to trade?



We are always working on adding more assets to BasicSwap. You can see the list of currently available coins here.

If you’d like to see the addition of a specific coin or token to the DEX, please take a look at this page to learn how you can apply for a listing. Alternatively, you can integrate compatible coins yourself by following this integration example here [https://github.com/tecnovert/basicswap].





What are the fees?



0%. BasicSwap does not charge trading or service fees. However, please note that, because it uses atomic swap technology, all swaps are settled on-chain, meaning that you’ll need to pay the typical blockchain transaction fee for the coins that you are swapping. In most cases, this is only a few cents, sometimes less.





How long does it take to set up BasicSwap?



At this current stage of the beta, only full BasicSwap nodes are available. There are two main steps in setting them up: “building” the application and syncing the blockchains of the coins you’ve decided to enable.

Building the application should take between 10 to 30 minutes, depending on whether or not your system is already set up to build applications and if you follow the instructions carefully.

The process of syncing the blockchains on your computer is difficult to estimate because it is entirely dependent on your internet connection speed and which coins you have chosen to enable.

As a general rule of thumb, we recommend activating Bitcoin’s “fast sync” option, which will speed up Bitcoin’s syncing time by ~94%. For Monero, you don’t need to wait for the blockchain to be fully synced up to start swapping. That’s because we use its bootstrapping functionality, which temporarily connects you to a public node while it syncs.

We are working on more convenient solutions such as light services and alternative gateway frameworks (i.e., web availability). These are expected to come at a later stage of the beta.





How long does it take to complete a swap?



The time it takes to complete a swap is entirely dependent on what coins are being swapped. Because BasicSwap uses the atomic swap protocol, swap settlements happen on-chain. That means you have to wait for a few blocks for swaps to confirm on both chains, thus making swap times dependent on the blockchains’ own block time.

You can estimate the time of a swap by multiplying a coin’s block time by 6 (10 for Monero), which is the average number of confirmations it takes to complete, in full, a swap.





What order types are available?



BasicSwap currently only works with limit orders, but we’ll soon add market orders at a later point in the beta.





What happens if the other participant or a swap fails?



If any problem occurs during a swap, like a bug happening or the other swapper failing a specific step for any reason, the coins of both participants will be refunded automatically at no additional charge. That’s due to the “atomic” nature of atomic swaps.

The protocol is built in such a way to only progress through the next step when very specific conditions are met. In any other cases, the swap times out and the coins, temporarily locked in atomic swap smart-contracts, are refunded back to their original owner.





Is there any way for a swap to get “stuck”?



No. That is not possible due to the “atomic” nature of atomic swaps. If a condition fails to be met, or if one of the two parties stops progressing through the steps, the coins are released back to their original owners after a certain period of time. It is not possible for coins to get “stuck” in atomic swap smart contracts.





Do you need to run a local node to perform a swap?



At this stage of the beta, yes. Your BasicSwap node needs to remain online for the duration of a swap.

BasicSwap uses the P2P SecureMessaging network (SMSG) to communicate between the two participating chains and send the required swap data to the atomic swap smart-contracts. Because the entire process is step-based and atomic in nature, an SMSG node cannot currently transmit the required data if it is offline in the first place.

We are working on resolving this requirement and enabling offline swaps, but that will come at a later time during the beta.





Can I run my node on a cloud server or VPS?



Although that is possible, we highly recommend against it. That’s because each BasicSwap instance contains the private keys of its associated wallet.

Remember, BasicSwap is entirely non-custodial, meaning that you are the one responsible for the security of your own funds. Just like you wouldn’t host a Bitcoin wallet on a cloud server, we suggest not hosting a BasicSwap node where others may have unauthorized access to your device.





Does BasicSwap collect data about me?



No. BasicSwap is entirely peer-to-peer and open-source. It does not collect nor share any data.





How can I remain anonymous when using BasicSwap?




	1- Use Tor.


	Prioritize trading in privacy coins such as Monero or Particl.


	Everything else is being taken care of by BasicSwap! 🙂





Note

We are working on ways to make tracing more difficult on non-privacy coins such as Bitcoin with the future  integration of Taproot and tapscripts to BasicSwap.





Technology



What does BasicSwap being in the beta stage mean?



While BasicSwap is available on mainnet and generally works well, it is still considered a beta product for a few reasons.

For one, certain features and functionalities may feel less polished, in need of improvement, or simply missing. This is normal and part of the lifecycle of this beta phase. Please bear with us as we incrementally improve the protocol.

Additionally, we have much more than what you currently see planned for it, but we’ve now reached a stage where we also want to start gathering feedback and stress-testing the application more aggressively.

To build a strong product, you need to ensure its foundations are resilient, efficient, and built with longevity in mind. Opening up this beta phase to the public at this stage is a sure way to reach that goal more quickly.





What are the core components of the BasicSwap DEX?



BasicSwap is made up of three core components: the atomic swap protocol, the SecureMessaging network (SMSG), and scriptless scripts. Each of these fills a critical role and, when combined, form the BasicSwap DEX.

Atomic swaps: They are what make swapping possible without third-parties. Atomic swaps follow an “atomic” and condition-based approach in which coins get temporarily locked in smart contracts until specific conditions are met. Should any step fail during the process, the swap expires and coins are refunded to their original holder after some time. Read more about atomic swaps here [https://github.com/decred/atomicswap] and more specifically about Monero atomic swaps here [https://github.com/h4sh3d/xmr-btc-atomic-swap].

SecureMessaging: The SMSG network is a peer-to-peer network that communicates between the two participating blockchains of a swap and feeds the swap data into the atomic swap smart-contracts. It is how two blockchains can communicate with each other without a central party. Additionally, the SMSG network provides other DEX-related services, such as BasicSwap’s distributed order book. Read more about the SMSG network here [https://particl.news/the-smsg-network-enabling-dapps-with-true-privacy/].

Scriptless scripts: Scriptless scripts are a typically overlooked feature of Bitcoin and blockchains in general. Originating from MimbleWimble, they are, in their basic sense, a way to execute secure, scalable, and, most importantly, private smart-contracts off-chain using Schnorr Signatures [https://en.wikipedia.org/wiki/Schnorr_signature] or ECDSA [https://en.wikipedia.org/wiki/Elliptic_Curve_Digital_Signature_Algorithm]. On BasicSwap, they are used to exchange the private key ownership of successful atomic swaps without leaving any trace on either side of a trade. Read more about scriptless scripts and their benefits here [https://tlu.tarilabs.com/cryptography/introduction-to-scriptless-scripts].





Is the order book entirely decentralized?



Yes, there is no central point of failure or centralized aspect with BasicSwap’s order book. It is powered by the SecureMessaging (SMSG) network and is entirely decentralized. Read more about the SMSG network here [https://particl.news/the-smsg-network-enabling-dapps-with-true-privacy/].





Who runs the SMSG network that powers the DEX?



The SMSG network is a peer-to-peer network of nodes scattered across the world. Whenever you run BasicSwap, you also become an SMSG node. That means that, as long as there are BasicSwap users, the SMSG network will have enough nodes to keep the DEX online.

But there’s more! SMSG is a powerful mixnet and, for this reason, powers other applications within the Particl ecosystem. Notably, it powers several functions of the Particl Marketplace dApp and is also directly integrated into Particl Core nodes.

As the Particl project fully intends on powering more and more of its privacy-first dApps with the SMSG network as time goes by, the level of decentralization of the SMSG network and its node count is expected to keep on growing. In other words, as the number of BasicSwap AND Particl users grows, so does the degree of decentralization of its dApp (i.e., BasicSwap).





Does BasicSwap connect to third-party services?



None of the core or functional aspects of BasicSwap ever connect to third-party services; the DEX is entirely decentralized and devoid of central points of failure.

However, some convenience features within the user interface, such as the display of historical price graphs for coins, may rely on data fed from external APIs. None of this data is used in any functional part of BasicSwap (such as the order book or for determining prices).





Are there pre-made builds of BasicSwap?



Not at this time. BasicSwap requires to be manually compiled, which can be done by following the easy-to-follow instructions available here.

Of course, we fully intend on providing pre-made builds moving forward, but that’s planned for later during the beta.





Is BasicSwap dependent on its team to operate?



No. The Particl team’s involvement is not required at all for BasicSwap to function. The DEX is completely open-source and peer-to-peer. The team may deliver updates and improve it but is not required for its functioning.





What makes the BasicSwap network stable?



A critical aspect of BasicSwap that makes it stable is that every trader becomes a P2P node that helps keep the DEX online. As long as there are BasicSwap users, it will remain online.

Additionally, the SMSG network — the P2P network that powers BasicSwap — also powers other applications within the Particl ecosystem. Notably, it powers several functions of the Particl Marketplace dApp and is also directly integrated into Particl Core nodes.

As the Particl project fully intends on powering more and more of its privacy-first dApps with the SMSG network as time goes by, the level of decentralization of the SMSG network and its node count is expected to keep on growing. In other words, as the number of BasicSwap AND Particl users grows, so does the degree of decentralization of its dApp (i.e., BasicSwap).





Are Monero swaps truly decentralized? What’s the catch?



We get asked this a lot, but fortunately, there is no catch. BasicSwap uses h4sh3d’s Monero atomic swap protocol [https://github.com/h4sh3d/xmr-btc-atomic-swap]. All other functions of the DEX are provided by the SMSG network and scriptless scripts. BasicSwap does not use wrapped Monero tokens, intermediate chains, or any other trickery.

And while there is no catch, there is one caveat: at this point in time, it is only possible to execute XMR swaps one way. Indeed, it is not possible to place XMR sell offers on the order book, only buy orders (in exchange for another coin).

That’s due to the current nature of the XMR atomic swap protocol. We’re happy to announce that we’re working on a solution to allow bi-directional XMR swaps. This is one of the next items in line during this beta.





How can I verify and audit BasicSwap’s code?



The entirety of the code is open-source. Simply visit our Github here [https://github.com/tecnovert/basicswap]; every line of code can be thoroughly audited to ensure that BasicSwap does what we say it does.







            

          

      

      

    

 


  

    
      
          
            
  
Common Issues


Note

The Particl Academy is up-to-date with Particl’s latest version, Particl Desktop 3.3.1.

Got any issues not mentioned here? Then let us know about it so that we can help you out and update the Particl Academy!



General Support Questions



A payment is stuck. Can I abandon the transaction?



If, for any reason, you’d like to abandon a payment transaction before it’s included in a block, follow these steps.


	Copy the transaction ID (txid) to your clipboard.


Open Wallet -> choose the corresponding wallet from the Wallet Chooser -> History -> find and unfold the TX from the Transaction Browser -> Click Copy TX ID






	Open the Console in the bottom left corner.


Enter abandontransaction TXID where TXID stands for your transaction id in your clipboard which you can paste by pressing CTRL + V or COMMAND ⌘ + V on a Mac.












My coins are not showing up when receiving an anon payment



When you hold or receive coins in either blind or anon balances, the balances aren’t displayed on your Particl Desktop until you unlock it. This is a security measure.


	Make sure the payment was sent to the blockchain.


Check the transaction on the Particl blockchain explorer [https://explorer.particl.io] .






	Make sure the receiving wallet is unlocked.


Click on the Vault Icon in the top right corner.






	Make sure the receiving wallet’s blockchain is in sync.


Open the Debug Console in the bottom left corner and enter the command getblockchaininfo then compare the chain height output to the Particl blockchain explorer status [https://explorer.particl.io/status]












My coins are not showing up when importing 24-word passphrase




	Make sure you are using Particl Desktop 3.3.1.


	Make sure you haven’t made any typo in any of the 24 words.


	Enter your seed’s password as a 25th word, if you have any.


	Try only entering your 24-word passphrase without any password.


	If all else fails, do a hard reset of Particl.








Number of coins not showing up in private balances and transaction history



When you hold or receive coins in either blind or anon balances, the balances aren’t displayed on your Particl Desktop until you unlock it. This is a security measure.





Where can I find the logfiles of my wallet to resolve an issue?




WindowsMacOSLinux
## Blockchain debug.log
%UserProfile%\AppData\Roaming\Particl\debug.log

## Marketplace market.log
%UserProfile%\AppData\Roaming\particl-market\03\market.log






## Blockchain debug.log
~/Library/Application\ Support/Particl/debug.log

## Marketplace market.log
~/Library/Application\ Support/particl-market/03/market.log






## Blockchain debug.log
~/.particl/debug.log

## Marketplace market.log
~/.particl-market/03/market.log










Marketplace Support Questions



I can’t find the marketplace on Particl Desktop




	Make sure you are using Particl Desktop 3.3.1.








No listing is showing up on the marketplace (empty marketplace)




	Make sure you are using Particl Desktop 3.3.1.


	Check if in the top right corner the peers icon is a red circle. If it’s the case, Particl Desktop is not able to connect the network. Check your firewall settings and add an exception for Particl Desktop, and make sure your internet connection is available at all.


	Leave Particl Desktop open for a few minutes so that it can sync the blockchain and load the market data. This can take several minutes and tends to take longer on slow internet connections.








I can’t publish a listing




	Make sure you are using Particl Desktop 3.3.1.


	Make sure you have enough PART in your public or private balance to cover the listing fees.








I can’t publish a listing - Notice: “Error fetching the fee estimate during publishing”



Make sure your PART balance in “Public” or “Anon” state has enough UXTO splits.


	Navigate to the Wallet app via the left handed side-navigation menu -> Select the marketplace’s wallet


	Open the SEND / CONVERT module


	Use the UXTO splitter slider to set a mid range amount and send some coins to yourself.




You should now be able to publish listings.





“Message did not send” error when trying to list multiple items at once




	Make sure you are using Particl Desktop 3.3.1.


	Scroll down to the bottom of the page and republish the listings that couldn’t be sent in a SecureMessaging (SMSG) message. You may need to repeat that step a few times until all items are published.






BasicSwap Support Questions



A swap is stuck. Can I abandon it?



If a swap seems “stuck”, simply wait until the atomic swap contract expires. Once it does, you’ll be refunded your coins. It is not possible for a swap to remain stuck indefinitely.





I do not see a deposit address nor a withdraw option in my PIVX wallet.




	Make sure that your PIVX wallet is synced at 100%.


	Go to Wallets > PIVX Manage, and click on the Reseed wallet button.








I am not able to build BasicSwap.



The instructions work for a wide variety of operating system. Make sure that you follow each step carefully and watch out for any error that the terminal returns.

Do not progress move on to the next step if the terminal gives you an error after typing a command. You need to resolve errors when/if they appear before you can continue, else the installation will not work. The terminal generally does a good job at telling you what went wrong and how to fix it.






            

          

      

      

    

 


  

    
      
          
            
  
Get Support

Do you have any questions not answered anywhere on the Particl Academy? Then let us know about it so that we can help you out and update the Particl Academy!

To seek out help, join Particl’s Help channel on


	Discord [https://discord.me/particl]


	Telegram [https://t.me/particlhelp]


	Element [https://app.element.io/#/room/#particlhelp:matrix.org]





Reporting Issues

If you want to report an issue you’ve encountered, help us understand better by following the following template.

**What is your environment?**

    - Operating System/Version: [e.g. Windows 11]
    - Particl Client/Version: [e.g. Desktop 3.3]

**What did you do and what do you expect?**

    - Tell us what happened as concisely as possible.
    - If you have multiple problems to report, open one ticket for each unless it looks like they are all originating from the same root cause.

**Add additional evidence if needed.**

    Note: Don't post the logfiles in the chats. It may contain sensitive data you would want to keep private.









            

          

      

      

    

 


  

    
      
          
            
  
Glossary

As you may have noticed, there are a few recurring terms around the Particl ecosystem, as well as the wider blockchain industry. You will find a definition for many of those terms here.




General Terms


	Blockchain
	A blockchain is a distributed database or ledger that is shared among the nodes of a computer network. As a database, a blockchain stores information electronically in digital format. Blockchain on Investopedia [https://www.investopedia.com/terms/b/blockchain.asp]



	Cryptocurrency
	Cryptocurrencies are digital units of a currency that can be transferred person-to-person without requiring a third-party (payment processor) to facilitate transactions. It enables near-free, near-instant currency transactions that cannot be held up, blocked, reversed, or delayed by any party. In Particl’s case, transactions can also be made anonymously.



	Decentralization
	Decentralization is the process by which the activities of an organization or network are distributed or delegated away from a central, authoritative location or group.

Decentralization on Wikipedia (https://en.wikipedia.org/wiki/Decentralization)



	Decentralized Network
	A decentralized network is a distributed network that runs autonomously. It doesn’t rely on a central server or database. Each participant of a decentralized network contributes to its well-being. Any communication, exchange of data, or trade is made directly between each user of the platform without any central authority facilitating the exchange.



	DEX
	A decentralized exchange, or DEX, is a peer-to-peer cryptocurrency marketplace where transactions occur directly between traders, without the involvement of a third party. DEXs can vary in terms of their levels of decentralization and overall privacy features.

ss Gateways
An access gateway is defined here as any portal that allows users to access or interact with a given protocol. In the case of the Particl Marketplace, the main access gateway is through the Particl Desktop application; however, as the Marketplace is first and foremost a decentralized and open source protocol, other gateways (web, mobile or alternative desktop versions) could be built in order to access the very same platform.



	Disintermediation
	Disintermediation is the removal of intermediaries in economics from a supply chain, or “cutting out the middleman” in connection with a transaction or a series of transactions. Instead of going through traditional distribution channels, which had some type of intermediary (such as a distributor, wholesaler, broker, or agent), companies may now deal with customers directly, for example, via the Internet.

Disintermediation on Wikipedia (https://en.wikipedia.org/wiki/Disintermediation)



	Node
	A node is an individual device connected to a decentralized network such as a computer, VPS, or mobile phone. Each node contributes in maintaining, supporting, securing, and verifying the integrity of a decentralized network. The node itself automatically does these tasks with little to no input from the people running the nodes. Most users of a decentralized network access it through a node, whether that be directly (i.e., using one’s own computer) or through a third-party node (i.e., service provider).



	Peer-to-Peer
	Peer-to-peer (P2P) communication means two users can communicate without requiring any intermediary assistance (i.e., servers, database, host, etc.).



	Privacy Coin
	A privacy coin is a regular cryptocurrency, wrapped with layers of additional security in order to anonymize the transactions and/or the identities of each wallet holder. It is a more private, more anonymous approach to traditional cryptocurrencies.



	Smart Contract
	A smart contract is a self-executing contract with the terms of the agreement between buyer and seller being directly written into lines of code. The code and the agreements contained therein exist across a distributed, decentralized blockchain network. The code controls the execution, and transactions are trackable and irreversible.



	Tor
	The Tor network is a free and open-source network that enables anonymous online communication. It protects your digital privacy by anonymizing your IP address. It does so by routing your connection through a vast and global network of volunteers. Tor’s intended use is to protect your personal privacy as well as your freedom and ability to conduct confidential communication. When enabled on Particl, it makes your node’s IP address entirely anonymous.









Particl Terms


	BasicSwap
	The BasicSwap DEX is a decentralized and trustless trading exchange platform developed by Particl developers. It uses atomic swap technology, scriptless scripts, and the SMSG network to let users exchange cryptocurrencies without fees, restrictions, or pre-requisites such as invasive identification or proof of income requirements.



	Market
	Particl markets are private by default. Only those possessing their access keys can join them. A market creator decides the attribution model of publishing rights (who’s allowed to sell) when first setting it up.

Markets may allow everyone with access to them to publish and sell items (a market), or may instead require publishing rights that must be granted by their creator (a storefront).



	Network Treasury
	Particl developers are supported by Particl’s own decentralized treasury fund,which automatically receives 50% of the staking rewards generated by the blockchain. This staking income is hard-coded directly into Particl Proof-of-Stake (PPoS) and is entirely decentralized.



	Open Market
	The Open Market is the main market on Particl Marketplace. It is found by default but needs to be manually joined by the user when first setting up the application. The Open Market is a general-purpose market where any Particl Desktop user can buy or sell anything. The Open Market contains a wide variety of default categories.



	Open Market Protocol (OMP)
	The Open Market Protocol (OMP) is the back-end protocol that powers the Particl Marketplace. It is the framework that defines how marketplace transactions, orders, listings, and other key eCommerce functionalities are processed by the SMSG network and the Particl Blockchain. It is the “glue” that sticks everything together. To learn more about the OMP Library, head over to the Open Market Protocol Wiki page [https://particl.wiki/learn/marketplace/open-market-protocol/].



	Particl
	Particl is a user-friendly and developer-friendly ecosystem of privacy-first decentralized applications building against the centralization of power and services on the web.

United under the mission of shifting the balance of power from corporate monopolies back to the people, Particl contributors built a privacy-first and modular ecosystem of decentralized applications complemented by a native privacy coin to send and receive untraceable currency payments within smart contracts. It is both protocol and currency agnostic, meaning that its modular infrastructure allows developers to use almost any protocol or cryptocurrency to build or interact with their applications.

These dApps — alternative versions of some of the online services and products we use every day — are designed to operate in complete and total privacy and without intermediaries or restrictions.



	Particl Blockchain
	The Particl Blockchain is a decentralized and immutable ledger based on bitcoin technology. It improves on Bitcoin by introducing advanced privacy as well as extensive smart contract capabilities. The Particl Blockchain processes and validates payments between users in an entirely peer-to-peer environment, without intermediaries such as banks or payment processors.



	Particl Core
	Particl Core is the software providing a direct connection to the Particl Blockchains. It also acts as a gateway for applications to interact directly with the blockchain. Because it runs silently in the background of your computer, Particl Core may often be referred to as a daemon or “particld”.

Users can easily interact with Particl Core by either using its CLI client (commands on a terminal) or its graphical counterpart Particl-Qt.



	Particl Desktop
	Particl Desktop is Particl’s most popular and user-friendly client. It is the main access gateway into the ecosystem and lets users interact with their wallets as well as a variety of privacy-first applications.



	Particl Ecosystem
	The Particl Ecosystem is the sum of any value or participant within Particl’s world. Thus, anyone or any app that uses any of Particl’s available solutions is part of it.



	Particl Marketplace
	The Particl Marketplace is a decentralized two-sided marketplace (i.e., eBay) on which people can directly buy and sell anything with each other without middlemen like banks, payment processors, or marketplace operators.

articl Marketplace provides a secure, entirely private, and unrestricted eCommerce environment available anywhere in the world.



	Particl Network
	The Particl Network consists of the sum of all the online protocols that make the platform. It mostly consists of two technologies: the Particl blockchain, and the SecureMessaging network.



	Particl Project
	The Particl Project refers to all combined efforts, people, and community contributing to the development, maintenance, promotion, and adoption of the Particl decentralized network.



	Particl SDK
	The Particl Software Development Kit (SDK) is an upcoming set of tools and documentation that enables developers to independently contribute to the Particl ecosystem. Its purpose is to speed up the onboarding process of independent developers and standardize best practices for maximum compatibility across all contributions.



	PPoS
	Particl uses the Particl Proof-of-Stake (PPoS) consensus mechanism, which pays back interest in dividend-like payments to stakers in exchange for securing the network and validating transactions. PPoS offers many secure staking options that let you easily and quickly earn rewards without any of the security or financial risks typically associated with staking.

PPoS is also the protocol used to vote on proposals in Particl’s decentralized governance model.



	SecureMessaging (SMSG)
	SecureMessaging (SMSG) is Particl’s own custom-built and unique P2P messaging network that stands at the very core of its ecosystem. Inspired by the BitMessage protocol, it is a mixnet that acts as a decentralized storage network (DSN). It stores and transfers data across nodes in a privacy-preserving manner, encrypted from end to end (E2EE), and without requiring the use of any central server. It provides Particl’s privacy-first dApps like Particl Marketplace and BasicSwap DEX with advanced capabilities.

icl Stakeholders
articl Stakeholders participate in the maintenance and functionality of the Particl Blockchain. Particl Stakeholders collect small PART rewards for staking on the network, and may participate in governance proposal votes and Particl Marketplace’s community-based moderation. The rewards and voting strength that a stakeholder enjoys are generally correlated with the amount of PART tokens being staked by that individual.











            

          

      

      

    

 


  

    
      
          
            
  
Links

This section is a collection of many useful Particl-related links. It will redirect you to a lot of external content that should help you get your way around Particl. Happy reading!

General


	Website [https://particl.io]


	News Blog [https://particl.news]


	Downloads [https://particl.io/downloads]


	Roadmap [https://particl.io/roadmap]


	Github [https://github.com/particl]


	Whitepaper [https://github.com/particl/whitepaper]


	Wiki [https://particl.io/particl]




Metrics and Numbers


	Block Explorer (Insight) [https://explorer.particl.io/]


	Block Explorer (CryptoID) [https://chainz.cryptoid.info/part/]


	Real-time Particl Statistics [https://stats.particl.page]


	Particl Marketplace Web Browser (Alpha) [https://particl.store/]




Chats, Social Media, Forums


	Discord [https://discord.me/particl]


	Telegram [https://t.me/particlOn]


	Element / Matrix [https://riot.im/app/#/room/#particlOn:matrix.org]




—


	Twitter [https://twitter.com/ParticlProject]


	Youtube [https://www.youtube.com/c/particl]


	Reddit [https://www.reddit.com/r/Particl]


	Super Dangerous Show [https://linktr.ee/superdangerous]
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Contribution Tutorial and Workflow

The best installation tutorial, best practices, and the complete workflow from A-Z for all OS’s.

If you want to contribute to the Academy as a power contributor follow this tutorial. It will save you from a lot of headaches and lost time equally. You will learn how to render a local HTML copy of the Academy and how to push your edits into the live version.

If you are an occasional contributor and you only want to add one or two lines, or fix some typos, hit the Edit on Github button in the top right corner on the Academy website, it will serve you well without bloat.


Note

General Contribution Flow


	Fork the particl-community/academy repository as your forked repository and clone the forked repository into your local repository.


	Do your changes, review them in a local live version of the Academy, commit them, and push from your local to your forked repository on Github.


	Create a pull request as your contribution’s integration request on the upstream particl-community/academy repository.


	After a manual review by the maintainers, your code gets merged.


	A new Academy version gets rendered and is instantly available.


	Congrats, you’ve created footsteps and contributed to Particl’s history.






The process of writing documentation and translations is a tedious and time-consuming task, and you will most likely get very little appreciation in doing so. I can assure you, solely the purpose is worth it, against all odds because you are Particl!

Now, let’s go dance with it!


Installation of prerequisite tools

It’s time to ensure the installation of some packages like a proper package manager, Git, Python, Sphinx, Sublime Text, and Sublime Merge.

Package Manager

It takes the hassle off you searching for installation binaries and makes it a breeze to keep them updated.


See also


	Windows: Chocolatey [https://chocolatey.org] is an installation package manager for Windows.


	Mac: Brew [https://brew.sh] is a package manager for Mac and sometimes Linux as well


	Linux: There are plenty. APT, DNF, YUM, Zypper, Pacman, SNAP … to name a few.






Git

It’s the foundation protocol to handle code versions and collaboration on Github.


See also


	Git Docs What is Git [https://git-scm.com/book/en/v2/Getting-Started-What-is-Git%3F#what_is_git_section]


	Git Website https://git-scm.com


	Github Website https://github.com


	GitDocs https://git-scm.com/docs


	Cheatsheets https://training.github.com






Python

It’s the foundational language to run Sphinx.

Sphinx

Sphinx is a program that makes it easy to create intelligent documentation in reST. reStructuredText is a file format for textual data used primarily in the Python programming language community for technical documentation. reStructuredText is comparable to Markdown but with added functionality. Technically, Sphinx takes the .rst files and renders different outputs like the HTML or PDF versions of the Academy.


See also


	Local Examples Test page on the Academy


	Sphinx Docs Sphinx Primer [https://www.sphinx-doc.org/en/master/usage/restructuredtext/basics.html]


	Sphinx Docs TOC [https://www.sphinx-doc.org/en/master/usage/index.html]






Sublime Text

It’s a leightweight and sophisticated text editor with a myriad of extensions available. Technically, you could use any text editor, but this one is described in detail in the follow-up tutorials.


See also


	Website https://www.sublimetext.com


	Docs https://www.sublimetext.com/docs/index.html


	Extensions https://packagecontrol.io






Sublime Merge

It’s a sophisticated GUI for managing Git repositories. Technically, you could use any git manager, but this one is described in detail in the follow-up tutorials.


See also


	Website https://www.sublimemerge.com


	Docs https://www.sublimemerge.com/docs/







Download & Install the Package Manager


WindowsMacOSLinux

	Open Windows Powershell (As Administrator [https://docs.microsoft.com/en-us/powershell/scripting/windows-powershell/starting-windows-powershell?view=powershell-7.2#with-administrative-privileges-run-as-administrator])


	Paste Get-ExecutionPolicy and hit Enter. If it returns “Restricted”, paste Set-ExecutionPolicy AllSigned and hit Enter. Answer with A.


	Paste the code below and hit Enter




Set-ExecutionPolicy Bypass -Scope Process -Force; [System.Net.ServicePointManager]::SecurityProtocol = [System.Net.ServicePointManager]::SecurityProtocol -bor 3072; iex ((New-Object System.Net.WebClient).DownloadString('https://chocolatey.org/install.ps1'))







	Open Terminal


	Paste the code below and hit Enter




xcode-select --install
ruby -e "$(curl -fsSL https://raw.githubusercontent.com/Homebrew/install/master/install)"
echo "export PATH=/usr/local/bin:/usr/local/sbin:$PATH" >> ~/.profile






Linux has everything on board!






Download & Install Additional Packages


WindowsMacOSLinux

	Open Windows Powershell (As Administrator [https://docs.microsoft.com/en-us/powershell/scripting/windows-powershell/starting-windows-powershell?view=powershell-7.2#with-administrative-privileges-run-as-administrator])


	Paste the code below and hit Enter




choco install git git-lfx gh sublimetext4 sublimemerge -y
choco install python -y
# close the powershell and open a new one; then proceed;
pip install sphinx sphinx-rtd-theme sphinx-copybutton sphinx-tabs rst2pdf







	Open Terminal


	Paste the code below and hit Enter




brew install git git-lfs gh sublime-text sublime-merge
brew install python
brew link python
# close the terminal and open a new one; then proceed;
pip install sphinx sphinx-rtd-theme sphinx-copybutton sphinx-tabs rst2pdf





Check Python Versions

For Python it should be 3.x and for Pip 21.x pointing to the same Python version.

python --version
pip -V





If this is not the case set an alias.

echo 'alias python=python3' >> ~/.bash_aliases
echo 'alias pip=pip3' >> ~/.bash_aliases
source ~/.bash_aliases







	Get inspiration from the MacOS documentation and adapt it to your package manager. Unless, you’re a die hard Gentoo guy.


	Python installation can be tricky if you are in the need to maintain multiple versions. Even in this case, feel free to get some inspirations from the MacOS documentation.







Congratulations! You have installed everything you need.




Get the Process Flying

Create a Github account, grab data from Github into your fork and local destinations, learn a bit about branches and strategies, and follow the first configuration steps to make your workflow as easy and fast as possible.


Create a Github Account


	Go to https://github.com/login


	Click on Create an account and follow through


	Confirm the account according to the TOS


	Store your Github Credentials locally

By leaving out to store the Github login data, you’ll get prompted to enter a password every time you push something to Github. So, you want to store them –really.


WindowsMacOSLinux
Please follow the official guides [https://github.com/GitCredentialManager/git-credential-manager#standalone-installation].
And download [https://github.com/GitCredentialManager/git-credential-manager/releases/latest] here.


Open Terminal and paste the code below and hit Enter

brew tap microsoft/git
brew install --cask git-credential-manager-core






Please follow the official guides [https://github.com/GitCredentialManager/git-credential-manager#linux] and download [https://github.com/GitCredentialManager/git-credential-manager/releases/latest] here. Please don’t miss the additional credstore configuration tutorial for linux [https://aka.ms/gcm/credstores].









see also


	Github About Authentication on Github [https://docs.github.com/en/authentication/keeping-your-account-and-data-secure/about-authentication-to-github]


	Github Configuration Options Tutorial [https://github.com/GitCredentialManager/git-credential-manager/blob/main/docs/configuration.md]


	Github Cred Store Information [https://github.com/GitCredentialManager/git-credential-manager/blob/main/docs/credstores.md]


	Github Personal Access Token [https://docs.github.com/en/authentication/keeping-your-account-and-data-secure/creating-a-personal-access-token]








Fork the Academy Repository


	Go to https://github.com/Particl-Community/academy


	Click on Fork




Now you have created a fork repository [username]/academy to work on.


Hint

It’s never wrong to know a bit about Remote repositories [https://docs.github.com/en/get-started/getting-started-with-git/about-remote-repositories].





Clone your Forked Academy Repository Locally


WindowsMacOSLinux

	Open Powershell


	Paste the code below and hit Enter (Don’t forget to change YOUR-GH-USERNAME.)




cd %USERPROFILE%
git clone https://github.com/YOUR-GH-USERNAME/academy.git







	Open Terminal


	Paste the code below and hit Enter (Don’t forget to change YOUR-GH-USERNAME.)




cd ~
git clone https://github.com/YOUR-GH-USERNAME/academy.git







	Open Terminal


	Paste the code below and hit Enter (Don’t forget to change YOUR-GH-USERNAME.)




cd ~
git clone https://github.com/YOUR-GH-USERNAME/academy.git








Now you have everything you need to start tackling the Academy. By default, you are on the master branch of the Academy’s repository. Let’s configure Git, Sublime Text, and Sublime Merge.



Configure Sublime Text


	Open Sublime-Text


	Click on File > Open Folder > Navigate to and select the previously cloned academy folder.


	Create a new build shortcut


	Click on Tools > Build System > New Build System


	Copy and paste the code below (don’t forget to check if the folder is true in your case)





WindowsMacOSLinux
{
"shell_cmd": "cd %USERPROFILE%\\academy & rmdir /s /q _build & make html"
}






{
"shell_cmd": "cd ~/academy ; [ -d \"_build\" ] && rm -Rf _build ; make html"
}






{
"shell_cmd": "cd ~/academy ; [ -d \"_build\" ] && rm -Rf _build ; make html"
}









	Save as buildAcademy.sublime-build


	Make it the default build system

Click on Tools > Build System > buildAcademy







	Render Test

If you hit CTRL + B or CMD + B on a Mac the Academy gets rendered locally as HTML within the folder _build

In order to open it in the Internet Browser use the Folders navigation in Sublime Text’s Side Bar and unfold the _build folder. Go ahead to html/index.html, press the Right Mouse Button -> Reveal in XX -> press the Right Mouse Button on the index.html file and chose Open with or just Drag and Drop the file into your preferred Browser.

Each time you make a change in your local copy of the Academy press CTRL + B or CMD + B on a Mac to get it rendered and refresh the page in the Browser to see the changes.



	Save the project

If you save your project into a project file you are able to resume your work where you left it. It’s a handy tool.


	Click Project > Save project as









see also


	Sublime Docs Build System [https://www.sublimetext.com/docs/build_systems.html]








Configure Sublime Merge


	Open Sublime Merge from Sublime Text on location

Use the Folders navigation in Sublime Text’s Side Bar and press the Right Mouse Button on the academy folder and choose Open Git Repository -> Sublime Merge opens.



	Your forked repository is your origin

Since you have cloned your forked repository from your account its considered as origin repository.



	Add the upstream repository

Click Right Mouse Button on Remotes > select Add remote > set name to upstream and paste the URL https://github.com/Particl-Community/academy.git.






Note

Adding the upstream repository helps you later on to fetch updates and merge them into your local and origin repositories.

Sublime Merge is currently not capable to perform pull requests to upstreams. That’s why you will need to push your local commits to your fork repository and create a PR from Github’s website. There are ways to do this on the CLI but they are not covered in this tutorial.



Congratulations! You you’re almost there. Now let’s talk about workflow strategies.




Merging, Branching, and Commits

Branches in Git are snapshots of your code repository at a given state. You can switch between them and/or merge code back and forth.

With your initial cloning of your Academy as origin repository you’re by default on the master branch. As soon as you checkout (switch) into a different branch all your files get modified according to its branch status. If you switch back, you’re back on the initial code base.


Attention

Creating commits has the purpose of documentation and identification of your code contributions. So, you’re well-advised to be precise with your descriptions, and you are asked to keep related changes across multiple files into one commit but not mix up different topics in one commit. Otherwise, we will not accept your pull request (PR) if we see such a mess.



Branch: Master

Purpose

The master branch is the one where the live version of the Academy gets rendered from. As soon as changes are pushed to this branch on the upstream repository a new build process is invoked.

What you can do here

You can fix typos, add content, and create pull requests to the upstream repository.

Branch: Temp

Purpose

The temp branch is the one where you can test things back and forth. As soon as you are happy with your changes you can merge them into your master branch and push it to your origin repository and finally create a pull request from there to get it integrated into the live version aka upstream repository.

What you can do here

Anything you want.

Branch: 3.x

Purpose

It is envisioned to be on par with the advancements of the Particl Desktop software. Currently, a version named repository will be a kind of archive or snapshot for that particular version. Localized versions will emerge and look like [VersionID]-[LangID] where langID stands for your international abbreviation like for French its fr and would look like this 3.x-FR, or 3.x-DE for German.

What you can do here

Currently nothing. But in the future it might become handy if we tend to write new documentations prior to a software release.


Note

As soon as you want to change the in-depth structure, add new documents, or collaborate with multiple people at the same time it’s due to work temporarily in a different branch and once its finalized it can get merged into the master branch.

Side-note: If you work with multiple people on a branch you will work with your personal fork of the repository not on the upstream repository. You can individually grant write-access to your origin repository version of the Academy.




Creating a new branch


	Open Sublime Merge


	Click Right Mouse Button on Branches (It’s automatically under your local repository)


	Give it a name depending on the usecase, e.g. Testground and hit Enter.


	Make it the activated branch by Right Mouse Button > Checkout [Branchname].


	Push the locally create branch to your origin repository


	Be sure the correct branch in selected in the menu.


	Click the small dropdown arrow ▼ next to the ↑ arrow.


	Now choose the destination origin and click on push








You  will recognize the local branch appears now under your origin branch which you can also verify on your Github page.


see also


	Library of Congress Language Code List [https://www.loc.gov/standards/iso639-2/php/code_list.php]


	Github Docs Remote Repositories [https://docs.github.com/en/get-started/getting-started-with-git/about-remote-repositories]


	Github Docs RR and PR [https://docs.github.com/en/pull-requests/collaborating-with-pull-requests/working-with-forks/configuring-a-remote-for-a-fork]


	Git SCM Branches in a Nutshell [https://git-scm.com/book/en/v2/Git-Branching-Branches-in-a-Nutshell]









A commit with PR by example


	Open Sublime Text and change your desired file

As soon as you create a preview render with e.g. CTRL/CMD + b or you save the file, Git recognizes this change.



	Open Sublime Merge

You’ll find a new unstaged file in the list of Commits.



	Click on Stage to qualify this particular file (and more, if there are more to stage) for the desired commit.


	Enter a meaningful Commit Message e.g. Changed because; Or Typo fixed; Regression fixed;.


	Click on Stage X files to confirm -> Your commit is written.


	Push this commit to your origin repository


	Be sure the correct branch in selected in the menu.


	Click the small dropdown arrow ▼ next to the ↑ arrow.


	Now choose the destination origin and click on push ->Your commit is pushed to Github.






	Create the PR


	Open your origin academy repository on the Github website https://github.com/[USERNAME]/academy


	You should see a yellow notification banner which invites you to create a PR towards the upstream repository.


	Leave an additional comment if you think it’s due or leave the commit message as is. It’s depending on the depth of your changes.


	Click on Create pull request








Congratulations! That was a wild ride. Now you have gained a lot of knowledge nobody can take away from you. May your contribution be a blessing!



FAQ



Where do I put images and videos?



Technically, they belong into the _/static/media/xxx folders. Yet, we have not started to implement supportive graphics. When the right time has come we will let you know. Then you’ll be able to add language based overlays or audio tracks.





Can I start creating new pages in my native language?



We are aiming for a cohesive file and communications structure across all languages. So, we really, really want to have the english representation as the origin of all other translated contents and not vice versa. So, if you want to create content in your language, find out if there’s already a branch named master-[LangID] where langID stands for your international abbreviation like for French its fr and would look like this master-FR, or master-DE for German. If not, create it and make a PR so that we know it has been claimed.





What do I need to consider when translating content?




	Try to find out if there’s already a language branch.





You can find the available branches on the upstream repository [https://github.com/Particl-Community/academy/branches/all]. The person who created it has a fork himself and is then a maintainer if no other person may have been denominated. Try to contact them to tackle your tasks as a team. Here you can find all the forks [https://github.com/Particl-Community/academy/network/members]. If none is there, claim it.





	Claim langID branches like described in the previous answer.


	Publish your progress frequently to your fork repository.





Otherwise people willing to contribute to your language will have a hard time what to do and may face work done twice.





	Ensure proofreading.





In any case, it’s of utmost importance you have people at hand able to proofread your writings. Ideally, a Particl unaware person understands what you have written.








Where do I find information how reStructuredText markup works?



It has been mentioned above. But here again: Open Testpage.





How can I discuss a certain topic regarding the Academy?



Open an issue on the Upstream Academy Repository [https://github.com/particl-community/academy/issues].





Can I create some PR’s for testing purposes?



You can create them, but they won’t get merged. So, behave.





Can I use a different software for editing?



Yes you can. Examples are Atom [https://atom.io] or Visual Code [https://code.visualstudio.com] or really any other text editor. But you’ll need to adapt the processes yourself. So, everything in this tutorial is done the way to take you up to light-speed.







            

          

      

      

    

 


  

    
      
          
            
  
Testpage

This page is for testing purposes. It showcases the reStructuredText markup with its rendered and raw versions for different formats and usecases.


See also


	Sphinx Docs Sphinx Primer [https://www.sphinx-doc.org/en/master/usage/restructuredtext/basics.html]


	Sphinx Docs TOC [https://www.sphinx-doc.org/en/master/usage/index.html]


	DocUtils Overview [https://docutils.sourceforge.io/rst.html]







Table of Contents


	Metadata Test


	Headings Test


	First heading


	Second heading


	Third heading


	Fourth heading














	Achievements Test


	Bigmessage


	Glossary Test


	Text Roles


	Abbriviation


	File Path


	Keystrokes


	GUI Labels


	inline code


	Menu Selection


	Subscript and Superscript






	External Links


	Internal Links


	Download Links


	Video


	Images


	Boxes


	Tables


	Simple


	Grid


	CSV






	Lists


	Big fat looking list


	Nested Normal


	Manual


	Automatic


	Normal






	Codeblocks


	No special highlighting


	Bash highlighting


	HTML highlighting






	Tabs


	Grouped tabs


	Normal tabs






	Toggles


	Including files


	Epilogs






Metadata Test

Each page should have its own metadata to have a descent intro on the searchengines and if links are shared.

.. meta::

  :description lang=en: Particl Marketplace is censorship-resistant eCommerce built on blockchain technology and respects your privacy.







Headings Test

This area shows some sample texts. Or an internal link to a certain page like the Particl Support Page n other than that we have some roles like emphasis strong literal and so on. It is even possible to reference a link: Make me laugh [https://www.youtube.com/watch?v=hY7m5jjJ9mM] or to reference to a heading on this page like Video or Images but you can also reference another page like this



First heading

Bodytext Lorem ipsum dolor sit amet, consetetur sadipscing elitr, sed diam nonumy eirmod tempor invidunt ut labore et dolore magna aliquyam erat, sed diam voluptua.


Second heading

Bodytext Lorem ipsum dolor sit amet, consetetur sadipscing elitr, sed diam nonumy eirmod tempor invidunt ut labore et dolore magna aliquyam erat, sed diam voluptua.


Third heading

Bodytext Lorem ipsum dolor sit amet, consetetur sadipscing elitr, sed diam nonumy eirmod tempor invidunt ut labore et dolore magna aliquyam erat, sed diam voluptua.


Fourth heading

Bodytext Lorem ipsum dolor sit amet, consetetur sadipscing elitr, sed diam nonumy eirmod tempor invidunt ut labore et dolore magna aliquyam erat, sed diam voluptua.

Headings
--------

This area shows some sample texts. Or an internal link to a certain page like the :ref:`Particl Support Page <../faq/get_support>` n other than that we have some roles like *emphasis* **strong** ``literal`` and so on. It is even possible to reference a link: `Make me laugh`_

==============
Document title
==============

use only once in a document

First heading
-------------

Bodytext Lorem ipsum dolor sit amet, consetetur sadipscing elitr, sed diam nonumy eirmod tempor invidunt ut labore et dolore magna aliquyam erat, sed diam voluptua.

Second heading
~~~~~~~~~~~~~~

Bodytext Lorem ipsum dolor sit amet, consetetur sadipscing elitr, sed diam nonumy eirmod tempor invidunt ut labore et dolore magna aliquyam erat, sed diam voluptua.

Third heading
^^^^^^^^^^^^^
Bodytext Lorem ipsum dolor sit amet, consetetur sadipscing elitr, sed diam nonumy eirmod tempor invidunt ut labore et dolore magna aliquyam erat, sed diam voluptua.

.. _Make me laugh: https://www.youtube.com/watch?v=hY7m5jjJ9mM





1.  ==========  for the first  level
2.  ----------  for the second level
3.  ~~~~~~~~~~  for the third  level
4.  """"""""""  for the fourth level
5.  ''''''''''
6.  ^^^^^^^^^^
7.  ##########
8.  **********










Achievements Test

An achievement can be placed below a task that has been completed.

Congratulations! You have installed Particl Marketplace.

.. rst-class:: achievement

Congratulations! You have installed Particl Marketplace.







Bigmessage

A bigmessage can be placed where it is really needed.

bigmessage! Get it while it’s hot.

.. rst-class:: bigmessage

bigmessage! Get it while it's hot.







Glossary Test

We have now a glossary file “Glossary” which should be populated with definitions. Then we can reference these definitions like this -> Sphinx or FooBarLoo as I want.

We have now a glossary file :doc:`glossary` which should be populated with definitions. Then we can reference these definitions like this -> :term:`Sphinx`.

You can link to a term in the glossary while showing different text in the topic by including the term in angle brackets. For example:

:term:`FooBarLoo as I want<Sphinx>`







Text Roles


Abbriviation

If the role content contains a parenthesized explanation, it will be treated specially: it will be shown in a tool-tip in HTML, and output only once in LaTeX.

LIFO

:abbr:`LIFO (last-in, first-out)`







File Path

Using a file path

/etc/passwd

:file:`/etc/passwd`







Keystrokes

Mark a sequence of keystrokes

cmd + s || cmd+s followed by y

:kbd:`cmd` + :kbd:`s` || :kbd:`cmd+s` followed by :kbd:`y`







GUI Labels

Using GUI Labels

Cancel, Ok, Reset, FAQ

:guilabel:`&Cancel`, :guilabel:`O&k`, :guilabel:`&Reset`, :guilabel:`FAQ`







inline code

$result = $a + 23;

:code:`$result = $a + 23;`







Menu Selection

If you want to describe a menu path

Start ‣ Programs

:menuselection:`Start --> Programs`







Subscript and Superscript

subscripted

superscripted

:subscript:`subscripted`
:superscript:`superscripted`








External Links


	External inline link [https://www.sphinx-doc.org/en/master/usage/restructuredtext/index.html]


	External referenced link The reference [https://www.sphinx-doc.org/en/master/usage/restructuredtext/index.html].




* `External inline link <https://www.sphinx-doc.org/en/master/usage/restructuredtext/index.html>`_
* `External referenced link `The reference`_.

.. _The reference: https://www.sphinx-doc.org/en/master/usage/restructuredtext/index.html







Internal Links


	Learn how to link to a different section within this document.




* Learn how to :ref:`link to a different section within this document<Tables>`.
.. Mind the non existent gap between the last word and the





To support cross-referencing to arbitrary locations in any document, the standard reST labels are used. For this to work label names must be unique throughout the entire documentation.


	I reference to a page under guides ‣ guide_general_enable_tor.rst Enable Tor on Particl Desktop




* I reference to a page under :menuselection:`guides --> guide_general_enable_tor.rst` :ref:`Enable Tor on Particl Desktop`

Additionally there is the possibility to define manual reference labels.

.. _my-reference-label:

Section to cross-reference
--------------------------

This is the text of the section.

It refers to the section itself, see :ref:`my-reference-label`.

The referencing works over the whole tree which means targeting at any page as long the reference label is unique.





Cross-referencing documents There is also a way to directly link to documents. Link to the specified document; the document name can be specified in absolute or relative fashion:


	faq ‣ common_issues.rst as relative path link text.


	faq ‣ common_issues.rst as absolute path link text.




* :menuselection:`faq --> common_issues.rst` as relative path :doc:`link text <_templates/../faq/common_issues>`.
* :menuselection:`faq --> common_issues.rst` as absolute path :doc:`link text </faq/common_issues>`.







Download Links

See this image.

See :download:`this image </_static/images/particl-logo-green.png>`.
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Embedded FAQ from a file 1



Because Particl is the best thing you will every see in your entire life. Lorem ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod
tempor incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam,
quis nostrud exercitation ullamco laboris nisi ut aliquip ex ea commodo
consequat. Duis aute irure dolor in reprehenderit in voluptate velit esse
cillum dolore eu fugiat nulla pariatur. Excepteur sint occaecat cupidatat non
proident, sunt in culpa qui officia deserunt mollit anim id est laborum.

And because of THIS





Embedded FAQ from a file 2



Because Particl is the best thing you will every see in your entire life. Lorem ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod
tempor incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam,
quis nostrud exercitation ullamco laboris nisi ut aliquip ex ea commodo
consequat. Duis aute irure dolor in reprehenderit in voluptate velit esse
cillum dolore eu fugiat nulla pariatur. Excepteur sint occaecat cupidatat non
proident, sunt in culpa qui officia deserunt mollit anim id est laborum.

And because of THIS





Embedded FAQ from a file 2



Because Particl is the best thing you will every see in your entire life. Lorem ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod
tempor incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam,
quis nostrud exercitation ullamco laboris nisi ut aliquip ex ea commodo
consequat. Duis aute irure dolor in reprehenderit in voluptate velit esse
cillum dolore eu fugiat nulla pariatur. Excepteur sint occaecat cupidatat non
proident, sunt in culpa qui officia deserunt mollit anim id est laborum.

And because of THIS
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Your next reward ~ 3 months
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aking rewar 8%pa.
Effective staki 1720 % pa.
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